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C H A P T E R  1
Cisco Unified Communications System Test

• Cisco Unified Communications System Test, page 1

• Cisco Unified Communications System Test for Japan, page 2

• Acronyms, page 3

Cisco Unified Communications System Test
Cisco Unified Communications System Test, an integral part of the Enterprise Voice Solution Management
is a program that validates and tests specified systems-level solution for the various products and platforms
in the Cisco Unified Communications System.

Cisco Unified Communications System Test, the systems integration layer, ensures that the Unified
Communications components delivered across the various engineering teams when combined, improves the
Unified Communications System software quality. This is achieved by testing the various components.

The requirements for Cisco Unified Communications System Test is derived based on the following:

• Popular customer scenarios

• Input from various Business Units, fields and Cisco Services

The test bed architecture is built based on the Solution Reference Network Design (SRND), cross-section of
product deployment models etc. The different types of testing carried out as part of Cisco Unified
Communications System Test are:

• Interoperability/Compatibility

• Functionality

• Availability/Reliability/Stability

• Performance/Scalability/Capacity

• Usability/Serviceability

• Special focus area - CAP (Customer Assurance Program) /Technical Assistance Center (TAC)

• Security
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Cisco Unified Communications System Test for Japan
Cisco Unified Communications System Test for Japan, in turn is an add-on testing at the solution level, where
the requirements gathered are specific to Japanese usage and market. The requirements are derived based on
the following:

• Customer found defects in selected UC products

• High priority cases that are covered by the Cisco Unified Communications System Test team

• Inputs from SE's and TAC team of Cisco Japan

The test execution is carried out on selected UC products, which affects the Japanese segment and that are
prioritized by SE's of the Cisco Japan team. Japanese specific equivalents such as Japanese locale, ISDN
Switch type being NTT and JPNP for Numbering Plan are implemented.

The objective of Cisco Unified Communications System Test for Japan is to run a sub-set of system testing
that is not covered by Cisco Unified Communications System Test and implement equivalents with Japanese
environment such as Japanese OS, localized application, selected Cisco Compatible Products and third party
equipment.

In this Cisco Unified Communications System Test release for Japan, the following components are tested.

• Cisco Unified Communications Manager

• Cisco IP Phones

• Cisco TelePresence Video Communication Server

• Cisco TelePresence Video Communication Server Expressway

• Cisco Jabber for iPhone and iPad

• Cisco Jabber for Android

• Cisco Jabber for Windows

• Cisco Jabber for Mac

• Cisco Unified Communications Manager IM and Presence

• Cisco Unity Connection

• Cisco TelePresence Multipoint Control Unit

• Cisco TelePresence Management Suite

• Cisco TelePresence Conductor

• Cisco TelePresence Server 7010

• Cisco TelePresence Server on VM

• Cisco Jabber Guest

• Cisco Collaboration Expressway

• Cisco Prime Collaboration

• Upgrade / Migration
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Acronyms
DescriptionAcronym

Advanced Audio Coding - Low DelayAAC-LD

Automated Alternate RoutingAAR

Automatic Call DistributionACD

Alternate Contact NumberACN

Automatic Gain ControlAGC

Audible Message Waiting IndicatorAMWI

Alternate Network Address TranslationANAT

Adaptive Security ApplianceASA

American Standard Code for Information InterchangeASCII

Analog Telephone AdapterATA

Bulk Administration ToolBAT

Binary Floor Control ProtocolBFCP

Busy Lamp FieldBLF

Certificate AuthorityCA

CDR Analysis and ReportingCAR

Channel Associated SignalingCAS

Call Control DiscoveryCCD

Cisco Desktop AdministratorCDA

Cisco Discovery ProtocolCDP

Call Detail RecordCDR

Caller Entered DigitsCED

Call Forward AllCFA

Call Forward BusyCFB

Customer Found DefectCFD

Call Forward No AnswerCFNA

Call Forward No CoverageCFNC

Call Forward UnregisteredCFUR

Cisco Unified IP CommunicatorCIPC

Cisco Jabber for AndroidCJA
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DescriptionAcronym

Cisco Jabber for iPhoneCJI

Cisco Jabber for MacCJM

Cisco Jabber for iPadCJIPad

Cisco Jabber for WindowsCJW

Cisco Jabber for Windows WebEx MeetingCJWWM

Command Line InterfaceCLI

Calling Line IdentificationCLID

Client Matter CodeCMC

Clustering over WANCoW

Cisco Prime CollaborationCPC

Client Services FrameworkCSF

Calling Search SpaceCSS

Computer Telephony InterfaceCTI

Computer Telephony IntegrationCTI

Certificate Trust ListCTL

Cisco Unified Border ElementCUBE

Cisco Unity ConnectionCUC

Cisco Unified Communications ManagerCUCM

Cisco Unified Communications Manager IM and PresenceCUCM IM and Presence

Cisco Unified PresenceCUP

Cisco Unified Personal CommunicatorCUPC

Cisco WebEx Meetings ServerCWMS

Device and Credential RepositoryDCR

Dynamic Host Configuration ProtocolDHCP

Direct In-Ward DialingDID

Directory NumberDN

Do Not DisturbDND

Delayed OfferDO

Digital Private Network Signaling SystemDPNSS

Disaster Recovery SystemDRS

Differentiated Services Code PointDSCP
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DescriptionAcronym

Device Work CenterDWC

Extended Display Identification DataEDID

Enterprise License ManagerELM

Extension MobilityEM

Extension Mobility Cross ClusterEMCC

Early OfferEO

Cisco Enhanced Survivable Remote Site TelephonyE-SRST

Forced Authorization CodeFAC

Federal Information Processing StandardsFIPS

Fully Qualified Domain NameFQDN

Foreign Exchange OfficeFXO

Foreign Exchange StationFXS

Graphical User InterfaceGUI

GatewayGW

High AvailabilityHA

High DefinitionHD

Historical ReportingHR

Hyper Text Markup LanguageHTML

Inter Cluster TrunkICT

Identity ProviderIdP

Instant MessagingIM

IP Phone MessengerIPPM

IP Service Level AgreementsIPSLA

Integrated Services Digital NetworkISDN

Indian Standard TimeIST

Initial Trust ListITL

Key Expansion ModuleKEM

Log Collection CenterLCC

Lightweight Directory Access ProtocolLDAP

Media Convergence ServerMCS

Multipoint Control UnitMCU
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DescriptionAcronym

MultiDimensional eXpressionsMDX

Managed File TransferMFT

Media Gateway Control ProtocolMGCP

Multilevel Precedence and PreemptionMLPP

Music On HoldMOH

Media Resource Group ListMRGL

Managed Service ProviderMSP

Maximum Transmission UnitMTU

Message Waiting IndicatorMWI

Network Interface and Configuration EngineNICE

Non Linear ProcessingNLP

New Technology LAN Manager version 2NTLMv2

Network Time ProtocolNTP

Operations ManagerOM

On Screen DisplayOSD

Product Authorization KeyPAK

Personal Communication AssistantPCA

Prime Collaboration DeploymentPCD

PC over IPPCoIP

Personal Identification NumberPIN

Plain Old Telephony SystemPOTS

Primary Rate InterfacePRI

Provisioning Northbound InterfaceProvisioning - NBI

Problem Reporting ToolPRT

Public Switched Telephone NetworkPSTN

Quality Report ToolQRT

Q-Signaling protocolQSIG

Really Simple SyndicationRSS

Real Time Control ProtocolRTCP

Real Time Monitoring ToolRTMT

Realtime Transport ProtocolRTP
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DescriptionAcronym

Security Assertion Markup LanguageSAML

Skinny Client Control ProtocolSCCP

Standard DefinitionSD

Service Enabling PlatformSEP

Session Initiation ProtocolSIP

Small and Midsize BusinessSMB

Cisco Unified Survivable Remote Site TelephonySRST

Secure ShellSSH

Secure Socket LayerSSL

Single Sign OnSSO

Technical Assistant CenterTAC

Transmission Control ProtocolTCP

Transport Layer SecurityTLS

TelePresence Management SuiteTMS

Trust Relay PointTRP

TelePresence ServerTS

Telephony User InterfaceTUI

Unified Computing SystemUCS

User Datagram ProtocolUDP

User Data ServiceUDS

Unified Messaging GatewayUMG

Uniform Resource IdentifierURI

Coordinated Universal TimeUTC

Cisco TelePresence Video Communication ServerVCS

Voice GatewayVGW

Voice Mail NotificationVMN

View Mail for OutlookVMO

Voice over IPVoIP

Voice Profile for Instant MessagingVPIM

Virtual Private NetworkVPN

Video SLA Assessment AgentVSAA
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DescriptionAcronym

TelePresence Server on VMVTS

Wide Area NetworkWAN

Wireless FidelityWi-Fi

Extensive Application Programming InterfacexAPI

Extensible Markup LanguageXML
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C H A P T E R  2
Test Topology and Environment Matrix

• Test Topology, page 10

• Environment Matrix, page 11

• Open Caveats, page 16

• What's New?, page 17
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Test Topology
Figure 1: Topology in Use
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Upgrade

Figure 2: Topology in Use

Environment Matrix
VersionComponentApplications

10.5.2.10000-5VersionCisco Unified
CommunicationsManager

Call Control

10.5.2.1000-1Locale

3-1-9.JPDial Plan

10.5VersionCisco Unified Survivable
Remote Site Telephony
(SRST) 15.5.1 TIOS

9.0.6VersionCisco Unified SRST
Manager

X8.5.1VersionCisco TelePresence Video
Communication Server
(VCS) X7.2_LanguagePacks_BETALocale

X8.5.1VersionCisco TelePresence Video
Communication Server
Expressway (VCS
Expressway)

X7.2_LanguagePacks_BETALocale
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VersionComponentApplications

10.5.2.10000-9VersionCisco Unified
CommunicationsManager
IM and Presence Service

Applications

10.5.2.1000-1Locale

10.5.2.10000-5VersionCisco Unity ConnectionVoice Mail and
Unified Messaging

10.5.2.1-1Locale

10.6.0.1015VersionCisco Prime Collaboration
Provisioning

Network
Management

10.6.0.58162VersionCisco Prime Collaboration
Assurance

2.1(1a)UCSC-C240-M3SCisco C-series ServerUpgrade /
Migration

ESXi 5.1ESXi host on
Blade Server

Hypervisor

MCS 7845 H2HardwareCisco Unified
CommunicationsManager

MCS 7845 I2HardwareCisco Unity Connection

MCS 7835 I2HardwareCisco Unified Presence

15.4(3)TIOSVoice Gateway 2951

Voice Gateway 2921

15.0.2-SE 5Cisco 3750Access Switch
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VersionComponentApplications

9-4-1-3SIPCisco Unified IP Phone
6921/41/61

End Point

9-4-1-3SR1SCCP

9-4-1-3Cisco Unified IP Phone
6945

10-2-1-12SR1-4Cisco IP Phone 7821/41/61

9-4-2-1Cisco Unified IP Phone
7942/62/75

1-4-6-3Cisco Unified Wireless IP
Phone 792X

10-3-1-16Cisco Unified IP
Conference Phone 8831

10-2-2-16Cisco IP Phone
8811/41/51/61

9-4-2-8Cisco Unified IP Phone
8941/8945

9-4(2)SR1-2Cisco Unified IP Phone
9951/9971

10-3-1KK0-357Cisco Desktop
Collaboration Experience
DX650

1-1-0-006Cisco ATA 190 Analog
Telephone Adaptor

TC 7.3.1EX60 - Cisco TelePresence
System EX60

TC 7.3.1EX90 - Cisco TelePresence
System EX90

TC 7.3.1SX20 - Cisco TelePresence
SX20 Quick Set

TC 7.3.1SX80-Cisco TelePresence
SX80 Codec

TC 7.3.1SX10-Cisco TelePresence
SX10 Quick Set

TC 7.3.1C90 - Cisco TelePresence
System Integrator Package
C90

TX6.1.6(32)500-32 – Cisco
TelePresence System 500
(32)
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VersionComponentApplications

TX9000 - Cisco
TelePresence System
TX9000

TX6.1.6(32)

TC 7.3.1MX200-G2- Cisco
TelePresence MX200-G2

TC 7.3.1MX300-G2- Cisco
TelePresence MX300-G2

10.2(3.33)DX70-Cisco DX70

10.2(3.33)DX80-Cisco DX80

15.5.1 TIOSISR Gateways (3945e,
3925e, 3945, 2921)

Communications
Infrastructure

3.13.0SIOSISR 4451-X

15.5.1 TCisco Unified Border
Element for ISR

15.0.2-SE 5Cisco 3750 PoE Switch

ESXi 5.1.0vCenter Server

5.2(2 a)M9500MDS Switch

14.6.1VersionCisco TelePresence
Management Suite - TMS

TelePresence

4.5 (1.55)VersionMCU4510& 5310 - Cisco
TelePresence MCU

MCU_4-3_UI_and_audio_JPN.packageLocale

4.1(1.79)VersionCisco TelePresence Server
on VM

XC3.0.2VersionCisco TelePresence
Conductor

4.1 (1.79)VersionCisco TelePresence Server
7010
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VersionComponentApplications

15.2VersionWireless Access Point
1142

Wireless and
Mobility

15.2VersionWireless Access Point
3502

10.6.0 (201496)Cisco Jabber for Mac

10.6.0.52330Cisco Jabber for Windows

10.6.0.202497VersionCisco Jabber for iPhone
and iPad

Apple iOS 8.1.2(12B440)iPhone 5

Apple iOS 8.1.2(12B440)iPad

10.6.0.204562VersionCisco Jabber for Android

Android OS 4.0.3Galaxy SII

Android OS 4.4.2Galaxy S4

Android OS 4.4.2Xperia Z1

10.5.3.25Version for
Windows and
Mac

Cisco Jabber Guest

Windows OS 7Windows

Mac OS 10.9.4Mac

10.5.3.779Version for iOS

Apple iOS 8.1.2(12B440)iPhone 5

Apple iOS 8.1.2(12B440)iPad

10.5.1.512Version for
Android

Android OS 4.0.3Galaxy SII

Android OS 4.4.2Galaxy S4

Android OS 4.4.2Xperia Z1

2.1(2a)Cisco UCS
6140

Fabric Interconnect
PRIMARY

UCS

2.1(2a)Cisco UCS
6140

Fabric Interconnect
SUBORDINATE

2.1(2a)Cisco UCS
6140

Fabric Cluster

ESXi 5.1.0Blade Server-1ESXi Host

ESXi 5.1.0C-Series Server
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VersionComponentApplications

Windows 7-SP1 (Japanese)Windows 7-SP1Operating SystemClient

Windows 8/8.1 (Japanese)Windows 8/8.1

10.9.4Mac

IE 11 (Supported Japanese language)IEBrowser

Firefox 32.0, Firefox ESR 24, 31
(Supported Japanese language)

Mozilla

Chrome 37.0 (Supported Japanese
language)

Chrome

Windows Server 2008 (R2 Enterprise -
Japanese)

MicrosoftWindows ServerServer

Windows Server 2012

2013Microsoft Exchange Server

2.5.1.28.BCisco WebEx Meetings
Server

10.5.3.115Cisco Jabber Guest Server

Note:

Jabber for iOS:

Cisco Jabber for iOS 10.6 is supported on 8.x or later versions of iOS. It is not supported in the iOS versions
lower than 8.x. Hence, iPhone 4 is not supported for Cisco Jabber for iOS 10.6

Jabber for Android OS:

For a language, Android mobile devices will follow the Android's language Settings and for date format/time,
it would follow the Android OS date format/ time Settings

Eg., In Japanese Environment, if Japanese date format is needed during a group chat then the Japanese date
format settings needs to be changed in Android OS Settings

Open Caveats
TitleDefect ID

Cisco IP Phones

CFA details is not displayed in 88xx IP PhonesCSCus84536

Update key toast is appearing twice in 88xx Phones during conferenceCSCus88792

Cisco Web Dialer pages are not localized in JPCSCut22770

Cisco TelePresence Video Communication Server
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TitleDefect ID

SX10 is not properly localized to Japanese in Set up assistant while using
remote control RC6

CSCus75009

In SX10 setup assistant is not reverted properly to English from ArabicCSCus76235

Cisco Jabber for iOS

Group chat invite is coming in English in Jabber for iPhoneCSCut11162

Cisco Jabber for Android

Secret and Angel Emoticon is not showing in Jabber for AndroidCSCut22052

Cisco Jabber for Mac

Group chat invite is displaying in English on Jabber for MacCSCut16237

Cisco Prime Collaboration Analytics

Data is not getting generated in detail view of Least Used Endpoint TypeCSCus70556

What's New?
Cisco IP Phone 8811:

The Cisco IP Phone 8811 is a cost-effective, business-class collaboration endpoint that delivers high-fidelity,
reliable, secure, and scalable voice communications for mid-size to large enterprise businesses. The Cisco IP
Phone 8811 supports five programmable line keys. You can configure keys to support either multiple directory
numbers or calling features such as speed dial. Fixed-function keys give you one-touch access to applications,
messaging, directory, as well as often-used calling features such as hold/resume, transfer, and conference. It
offers a 5-in. high-resolution (800 x 480) wide-screen backlit grayscale display. Localized language support,
including right-to-left on-screen text, meets the needs of global users. The phone supports a built-in Gigabit
Ethernet switch for your PC connection.

Managed File Transfer:

Managed file transfer (MFT) allows an IM and Presence Service client, such as Cisco Jabber, to transfer files
to other users, ad hoc group chat rooms, and persistent chat rooms. The files are stored in a repository on an
external file server and the transaction is logged to an external database. The file server is the repository for
files transferred by the managed file transfer featureMetadata associated with a managed file transfer is stored
in an external database. Files are stored on an external Linux file server, not in IM and Presence Service.

Cisco DX70:

The Cisco DX70 offers un compromised collaboration for every desk. Experience best in class HD video and
expanded collaboration capabilities such as UC features, Android applications and email all within a single
integrated device. It is dedicated, always-on 1080p High-Definition video communication system. DX70 is
Fully-featured IP Phone that registers to Cisco UCM call control. It has High-quality audio system for speaker
phone and media playback.

Cisco DX80:

The Cisco DX80 brings everything you need to be productive in one sleek integrated device. All you need is
one screen on the desk. Experience best in class HD video and expanded collaboration capabilities such as
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extensive UC features, Android applications and email in Cisco DX80. It is a 23-inch 16:9 screen provides
an engaging experience for video calls and running apps. Multi-touch capacitive touchscreen provides elegant
and powerful user interface. Security Enhanced Android operating system combined with Cisco's end-to-end
security features gives peace of mind to network administrators.
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C H A P T E R  3
Test Results Summary

• Cisco TelePresence Video Communication Server, page 19

• Cisco Jabber for iPhone and iPad, page 49

• Cisco Jabber for Android, page 54

• Cisco Jabber for Windows, page 56

• Cisco Jabber for Mac, page 63

• Cisco TelePresence Multipoint Control Unit, page 65

• Cisco TelePresence Management Suite, page 69

• Cisco TelePresence Conductor, page 73

• Cisco TelePresence Server, page 76

• Cisco Jabber Guest, page 80

• Cisco Collaboration Expressway, page 84

• Cisco IP Phone Validation, page 87

• Cisco Prime Collaboration, page 100

• Cisco Unified Communication System Upgrade / Migration Test, page 127

• Related Documentation, page 138

Cisco TelePresence Video Communication Server
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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NilPassedTX9000 ->Unified
CM -> Cisco
DX70

Verify whether video
call is established
successfully between
Cisco TelePresence
TX9000 registered
with Cisco Unified
Communications
Manager and Cisco
DX70 registered with
Cisco Unified
Communications
Manager

Making video
call from
TX9000 to
Cisco DX70

UCJ10.6SPH2.VCS.G.001

NilPassedTX9000 ->Unified
CM -> Cisco
DX80

Verify whether video
call is established
successfully between
Cisco TelePresence
TX9000 registered
with Cisco Unified
Communications
Manager and Cisco
DX80 registered with
Cisco Unified
Communications
Manager

Making video
call from
TX9000 to
Cisco DX80

UCJ10.6SPH2.VCS.G.002

NilPassedTX9000 ->Unified
CM -> Cisco
DX70
(Hold/Resume)

Verify whether
Hold/Resume of
video call between
Cisco TelePresence
TX9000 and Cisco
DX70 registered with
Cisco Unified
Communications
Manager works
successfully

Hold/Resume
video call from
TX9000 to
Cisco DX70

UCJ10.6SPH2.VCS.G.003

NilPassedTX9000 ->Unified
CM -> Cisco
DX80
(Hold/Resume)

Verify whether
Hold/Resume of
video call between
Cisco TelePresence
TX9000 and Cisco
DX80 registered with
Cisco Unified
Communications
Manager works
successfully

Hold/Resume
video call from
TX9000 to
Cisco DX80

UCJ10.6SPH2.VCS.G.004
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NilPassed500-32 -> Unified
CM -> Cisco
DX70 -> Transfer
-> TX9000

Verify whether call
transfer from Cisco
DX70 registered with
Cisco Unified
Communications
Manager to Cisco
TelePresenceTX9000
registered with Cisco
Unified
Communications
Manager works
successfully

Call transfer
from Cisco
DX70 to
TX9000

UCJ10.6SPH2.VCS.G.005

NilPassed500-32 -> Unified
CM -> Cisco
DX80 -> Transfer
-> TX9000

Verify whether call
transfer from Cisco
DX80 registered with
Cisco Unified
Communications
Manager to Cisco
TelePresenceTX9000
registered with Cisco
Unified
Communications
Manager works
successfully

Call transfer
from Cisco
DX80 to
TX9000

UCJ10.6SPH2.VCS.G.006

NilPassedEX90 -> Unified
CM -> TX9000
SX80 Codec ->
Unified CM ->
TX9000 ->
Forward Busy ->
Unified CM ->
DX70

Verify whether Call
Forward Busy is
working for Cisco
TelePresenceTX9000
registered in Cisco
Unified
Communications
Manager to Cisco
DX70 registered in
Cisco Unified
Communications
Manager

Call forward
Busy for
TX9000 to
DX70 registered
in Unified CM

UCJ10.6SPH2.VCS.G.007

NilPassedEX90 -> Unified
CM -> TX9000 ->
Call Forward No
Answer -> Unified
CM -> DX80

Verify whether Call
Forward No Answer
can be set in Cisco
TelePresenceTX9000
registered in Cisco
Unified
Communications
Manager to Cisco
DX80 registered in
Cisco Unified
Communications
Manager

Call ForwardNo
Answer in
TX9000 to
DX80 registered
in Unified CM

UCJ10.6SPH2.VCS.G.008
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NilPassedDX70 -> Unified
CM -> 500-32

Verify whether video
call fromCiscoDX70
to Cisco TelePresence
System 500-32 both
registered with Cisco
Unified
Communications
Manager can be
established

Making Video
Call from DX70
to 500-32 both
registered with
Unified CM

UCJ10.6SPH2.VCS.G.009

NilPassedEX90 -> Unified
CM -> DX70
EX60 -> Unified
CM -> DX70 ->
Call Forward Busy
-> Unified CM ->
500-32

Verify whether Call
Forward Busy in
Cisco DX70 to Cisco
TelePresence System
500-32 both
registered with Cisco
Unified
Communications
Manager works

Call Forward
Busy from
DX70 to 500-32
both registered
with Unified
CM

UCJ10.6SPH2.VCS.G.010

NilPassedEX90 -> Unified
CM -> DX70 ->
Call Forward All
-> Unified CM ->
500-32

Verify whether Call
Forward All in Cisco
DX70 to Cisco
TelePresence System
500-32 both
registered with Cisco
Unified
Communications
Manager works

Call ForwardAll
in DX70 to
500-32 both
registered with
Unified CM

UCJ10.6SPH2.VCS.G.011

NilPassedDX80 -> Unified
CM -> 500-32

Verify whether video
call fromCiscoDX80
to Cisco TelePresence
System 500-32 both
registered with Cisco
Unified
Communications
Manager can be
established

Making Video
Call from DX80
to 500-32 both
registered with
Unified CM

UCJ10.6SPH2.VCS.G.012

NilPassedEX90 -> Unified
CM -> DX80 ->
Hold/Transfer ->
Unified CM ->
500-32

Verify whether video
call from Cisco
TelePresence System
EX90 to Cisco DX80
can be transferred to
Cisco TelePresence
System 500-32 both
registered with Cisco
Unified
Communications
Manager

Consultative call
transfer from
DX80 to 500-32
both registered
with Unified
CM

UCJ10.6SPH2.VCS.G.013
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NilPassedEX90 -> Unified
CM -> DX80
EX60 -> Unified
CM -> DX80 ->
Call Forward Busy
-> Unified CM ->
500-32

Verify whether Call
Forward Busy in
Cisco DX80 to Cisco
TelePresence System
500-32 both
registered with Cisco
Unified
Communications
Manager works

Call Forward
Busy from
DX80 to 500-32
both registered
with Unified
CM

UCJ10.6SPH2.VCS.G.014

NilPassedEX90 -> Unified
CM -> DX80 ->
Call Forward No
Answer -> Unified
CM -> 500-32

Verify whether Call
Forward No Answer
in Cisco DX80 to
Cisco TelePresence
System 500-32 both
registered with Cisco
Unified
Communications
Manager works

Call ForwardNo
Answer from
DX80 to 500-32
both registered
with Unified
CM

UCJ10.6SPH2.VCS.G.015

NilPassedDX70 -> Unified
CM -> EX90

Verify whether call is
established
successfully when
Cisco DX70
registered with Cisco
Unified
Communications
Manager makes call
to Cisco TelePresence
System EX90
registered with Cisco
Unified
Communications
Manager by URI
dialing

URI dialing
from DX70 to
EX90

UCJ10.6SPH2.VCS.G.016

NilPassedDX80 -> Unified
CM -> DX70

Verify whether call is
established
successfully when
Cisco DX80
registered with Cisco
Unified
Communications
Manager makes call
to Cisco DX70
registered with Cisco
Unified
Communications
Manager by URI
dialing

URI dialing
from DX80 to
DX70

UCJ10.6SPH2.VCS.G.017
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NilPassedSX80 Codec
(Presentation
Sharing) ->
Unified CM ->
DX70

Verify whether
presentation is shared
to Cisco DX70 from
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager

Presentation
sharing from
SX80 Codec
registered with
Unified CM to
DX70

UCJ10.6SPH2.VCS.G.018

NilPassedSX80 Codec
(Presentation
Sharing) -> Cisco
VCS -> SIP Trunk
-> Unified CM ->
DX70

Verify whether
presentation is shared
to Cisco DX70
registered with Cisco
Unified
Communications
Manager from Cisco
TelePresence SX80
Codec registered with
Cisco TelePresence
Video
Communication
Server

Presentation
sharing from
SX80 Codec
registered with
Cisco VCS to
DX70

UCJ10.6SPH2.VCS.G.019

NilPassedSX10 Quick Set ->
Unified CM ->
DX70

Verify whether the
AAC-LD codec is
used for the audio call
between Cisco
TelePresence SX10
Quick Set and Cisco
DX70 registered with
Cisco Unified
Communications
Manager

AAC-LDCodec
for the audio call
between SX10
Quick Set and
DX70

UCJ10.6SPH2.VCS.G.020

NilPassedNAVerify whether the
user can login to Self
Care Portal of Cisco
DX70 registered with
Cisco Unified
Communications
Manager

Login to Self
Care Portal of
DX70 user

UCJ10.6SPH2.VCS.G.021

NilPassedNAVerify whether the
user can add speed
dial to Cisco DX70
registered with Cisco
Unified
Communications
Manager using Self
Care Portal

Adding speed
dial for DX70
using Self Care
Portal

UCJ10.6SPH2.VCS.G.022
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NilPassedNAVerify whether the
user can change ring
settings "when not on
call" for Cisco DX70
registered with Cisco
Unified
Communications
Manager using Self
Care Portal

Changing ring
settings "when
not on call" for
DX70 using Self
Care Portal

UCJ10.6SPH2.VCS.G.023

NilPassedDX70 -> Unified
CM -> DX80

Verify whether Cisco
DX70 automatically
flips the image
vertically and acts as
document camera
when camera is tilted
downwards facing a
document when in a
call with Cisco DX80
registered with Cisco
Unified
Communications
Manager

Using DX70
camera as
Document
Camera

UCJ10.6SPH2.VCS.G.024

NilPassedDX70
(Presentation
Sharing) ->
Unified CM ->
SX80 Codec

Verify whether
presentation is shared
from Cisco DX70 to
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager

Presentation
sharing from
DX70 registered
with Unified
CM to SX80
Codec

UCJ10.6SPH2.VCS.G.025

NilPassedSX10 Quick Set ->
Unified CM ->
DX70 & DX80
(Shared Line)

Verify whether both
Cisco DX70 and
Cisco DX80 which
are in Shared Line
and registered with
Cisco Unified
Communications
Manager rings when
making call from
Cisco TelePresence
SX10 Quick Set

Make call from
SX10 Quick Set
to shared line of
DX70 andDX80

UCJ10.6SPH2.VCS.G.026
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NilPassedSX10 Quick Set ->
Unified CM ->
DX70 -> Hold ->
DX80 -> Resume

Verify whether the
call which is on hold
in CiscoDX70 can be
resumed from Cisco
DX80 registered with
Cisco Unified
Communications
Manager when both
are in shared line

Hold in DX70
and resume from
DX80 when
both are in
shared line

UCJ10.6SPH2.VCS.G.027

NilPassedSX80 Codec ->
Unified CM ->
Cisco DX70

Verify whether audio
call is established
successfully between
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager and Cisco
DX70 registered with
Cisco Unified
Communications
Manager

Making audio
call from SX80
Codec to DX70

UCJ10.6SPH2.VCS.G.028

NilPassedSX80 Codec ->
Unified CM ->
Cisco DX80
(Hold/Resume)

Verify whether
Hold/Resume of
audio call between
Cisco TelePresence
SX80 Codec
registered with Cisco
Unified
Communications
Manager and Cisco
DX80 registered with
Cisco Unified
Communications
Manager works
successfully

Hold/Resume
audio call from
SX80 Codec to
DX80

UCJ10.6SPH2.VCS.G.029
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NilPassedCisco DX80 ->
Unified CM -> SIP
Trunk -> Cisco
VCS -> EX90

Verify whether video
call is established
successfully between
Cisco DX80
registered with Cisco
Unified
Communications
Manager and Cisco
TelePresence System
EX90 registered with
Cisco TelePresence
Video
Communication
Server

Making video
call from DX80
to EX90
registered with
Cisco VCS

UCJ10.6SPH2.VCS.G.030

NilPassedEX90 -> Cisco
VCS -> SIP Trunk
-> Unified CM ->
Cisco DX70

Verify whether audio
call is established
successfully between
Cisco DX70
registered with Cisco
Unified
Communications
Manager and Cisco
TelePresence System
EX90 registered with
Cisco TelePresence
Video
Communication
Server

Making audio
call from EX90
registered with
Cisco VCS to
DX70

UCJ10.6SPH2.VCS.G.031

NilPassedDX70(1) ->
Unified CM1 ->
SIP Trunk ->
Unified CM2 ->
DX70(2)

Verify whether video
call is established
successfully between
Cisco DX70(1)
registered with Cisco
Unified
Communications
Manager cluster 1 and
Cisco DX70(2)
registered with Cisco
Unified
Communications
Manager cluster 2

Making
inter-cluster
video call
between
DX70(1) and
DX70(2)

UCJ10.6SPH2.VCS.G.032

NilPassedDX80 -> Unified
CM -> DX70
(Hold) -> Hold
Reversion after 10
secs

Verify whether hold
reversion is working
successfully in Cisco
DX70 registered with
Cisco Unified
Communications
Manager

Hold reversion
in Cisco DX80

UCJ10.6SPH2.VCS.G.033
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NilPassedDX70 ( Document
Sharing ) ->
Unified CM ->
500-32

Verify whether
document is shared to
Cisco TelePresence
System 500-32 from
Cisco DX70 using
camera as document
camera when both are
registered with Cisco
Unified
Communications
Manager

Sharing
document to
500-32 from
DX70 using
document
camera

UCJ10.6SPH2.VCS.G.034

NilPassedSX10 Quick Set ->
Unified CM ->
DX70 -> Park ->
Unified CM ->
500-32 -> Retrieve

Verify whether the
call with Cisco
TelePresence SX10
Quick Set is parked in
Cisco DX70 and
retrieved from Cisco
TelePresence System
500-32, all are
registered with Cisco
Unified
Communications
Manager

Call park at
DX70 and
retrieve from
500-32

UCJ10.6SPH2.VCS.G.035

NilPassedDX80 -> Unified
CM -> 500-32

Verify whether audio
call between Cisco
DX80 registered with
Cisco Unified
Communications
Manager and Cisco
TelePresence System
500-32 registered
with Cisco Unified
Communications
Manager is working
successfully

Making audio
call from DX80
to 500-32

UCJ10.6SPH2.VCS.G.036

NilPassedDX70 -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
500-32

Verify whether video
call is established
between Cisco DX70
registered with Cisco
Unified
Communications
Manager cluster 1 and
Cisco TelePresence
System 500-32
registered with Cisco
Unified
Communications
Manager cluster 2

Inter-cluster
video call from
DX70 to 500-32

UCJ10.6SPH2.VCS.G.037
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NilPassedDX80 -> Unified
CM -> DX70 ->
Hold
EX90 -> Cisco
VCS -> SIP Trunk
-> Unified CM ->
DX80

Verify whether Cisco
DX80, registeredwith
Cisco Unified
Communications
Manager can hold the
current call with
Cisco DX70
registered with Cisco
Unified
Communications
Manager and answer
second call from
Cisco TelePresence
System EX90
registered with Cisco
TelePresence Video
Communication
Server

Making second
call to Cisco
DX80 when on
call with DX70

UCJ10.6SPH2.VCS.G.038

NilPassedNAVerify whether Cisco
TelePresence SX80
Codec can be
registered as SIP and
H.323 simultaneously
in Cisco TelePresence
Video
Communication
Server

SIP and H.323
simultaneous
registration in
SX80 Codec

UCJ10.6SPH2.VCS.G.039

NilPassedSX80 Codec
(presentation
preview locally) ->
Unified CM ->
EX90

Verify whether the
presentation is
previewed locally in
Cisco TelePresence
SX80 Codec when in
a call with Cisco
TelePresence System
EX90 both registered
in Cisco Unified
Communications
Manager

Local preview of
presentation in
SX80 Codec
registered with
Unified CM
while in a call

UCJ10.6SPH2.VCS.G.040
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NilPassedSX80 Codec
(Presentation
Preview Locally)
-> Cisco VCS ->
EX90

Verify whether the
presentation is
previewed locally in
Cisco TelePresence
SX80 Codec when in
a call with Cisco
TelePresence System
EX90 both registered
in Cisco TelePresence
Video
Communication
Server

Local preview of
presentation in
SX80 Codec
registered with
Cisco VCS
while in a call

UCJ10.6SPH2.VCS.G.041

NilPassedNAVerify whether the
presentation is not
displayed
automatically after
setting the
presentation selection
to Manual in Cisco
TelePresence SX80
Codec using
command
xConfigurationVideo
Input Connector 3
PresentationSelection:
Manual in xAPI

Setting the
presentation
selection as
Manual in SX80
Codec using
xAPI command

UCJ10.6SPH2.VCS.G.042

NilPassedNAVerify whether the
presentation is
displayed in both the
monitors of Cisco
TelePresence SX80
Codec registered in
Cisco Unified
Communications
Manager during out
of call

Local preview of
presentation in
SX80 Codec
dual display
during out of
call

UCJ10.6SPH2.VCS.G.043

NilPassedNAVerify whether the
warning is displayed
in the monitor of
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager when taking
web snapshots

Checking web
snapshot
warning in SX80
Codec display
when not in call

UCJ10.6SPH2.VCS.G.044
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NilPassedSX80 Codec ->
Unified CM ->
EX90

Verify whether the
web snapshotwarning
is displayed in the
monitor of Cisco
TelePresence SX80
Codec when in a call
with Cisco
TelePresence System
EX90 both registered
in Cisco Unified
Communications
Manager

Checking web
snapshot
warning in SX80
Codec display
during call

UCJ10.6SPH2.VCS.G.045

NilPassedNAVerify whether admin
gets warning in Web
GUI of Cisco
TelePresence SX80
Codec registered with
Cisco Unified
Communications
Manager before
taking the web
snapshots

Checking admin
warning in Web
GUI of SX80
Codec before
taking web
snapshot

UCJ10.6SPH2.VCS.G.046

NilPassedNAVerify whether the
eye icon is displayed
in Cisco TelePresence
SX80 Codec during
active monitor by
admin

Checking eye
icon in SX80
Codec display
during active
monitor by
admin

UCJ10.6SPH2.VCS.G.047

NilPassedSX10 Quick Set ->
Unified CM ->
SX80 Codec ->
Add -> EX90
(Audio)

Verify whether
additional audio call
whenmultisite option
is turned off is added
from Cisco
TelePresence SX80
Codec registered with
Cisco Unified
Communications
Manager

Additional audio
call in SX80
Codec when all
video
connections are
used

UCJ10.6SPH2.VCS.G.048
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NilPassedSX80 Codec
(Presentation
Sharing) ->
Unified CM ->
EX90

Verify whether the
presentation is
displayed in one
monitor and video in
other monitor of
Cisco TelePresence
SX80 Codec during
presentation sharing
with Cisco
TelePresence System
EX90 both registered
in Cisco Unified
Communications
Manager

Video call and
presentation
sharing in SX80
Codec (dual
display)
registered with
Unified CM

UCJ10.6SPH2.VCS.G.049

NilPassedSX80 Codec
(Presentation
Sharing) -> Cisco
VCS -> EX90

Verify whether the
presentation is
displayed in one
monitor and video in
other monitor of
Cisco TelePresence
SX80 Codec during
presentation sharing
with Cisco
TelePresence System
EX90 both registered
in Cisco TelePresence
Video
Communication
Server

Video call and
presentation
sharing in SX80
Codec (dual
display)
registered with
Cisco VCS

UCJ10.6SPH2.VCS.G.050

NilPassedEX60 (SIP) ->
Cisco VCS ->
SX80 Codec (SIP
& H.323)

Verify whether call
from Cisco
TelePresence System
EX60 registered as
SIP to Cisco
TelePresence SX80
Codec registered with
SIP and H.323 in
Cisco TelePresence
Video
Communication
Server can be
established
successfully

Making SIP call
to SX80 Codec
when it is
registered with
SIP and H323

UCJ10.6SPH2.VCS.G.051
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NilPassedEX60 (H.323) ->
Cisco VCS ->
SX80 Codec (SIP
& H.323)

Verify whether call
from Cisco
TelePresence System
EX60 registered as
H.323 to Cisco
TelePresence SX80
Codec registered with
SIP and H.323 in
Cisco TelePresence
Video
Communication
Server can be
established
successfully

Making H.323
call to SX80
Codec when it is
registered with
SIP and H.323

UCJ10.6SPH2.VCS.G.052

NilPassedSX80 Codec ->
Cisco VCS ->
SX20 Quick Set
SX80 Codec ->
Add -> Cisco VCS
-> MCU 5310 ->
EX90

Verify whether the
Multiway conference
in Cisco TelePresence
SX80 Codec with
Cisco TelePresence
SX20 Quick Set and
Cisco TelePresence
System EX90 works
successfully

Multiway
conference in
SX80 Codec
with SX20
Quick Set and
EX90

UCJ10.6SPH2.VCS.G.053

NilPassedSX80 Codec ->
Cisco VCS ->
EX90
SX80 Codec ->
Add -> Cisco VCS
-> SX10 Quick Set

Verify whether the
two monitors are
utilized for video of
the participants
during conference in
Cisco TelePresence
SX80 Codec
registered in Cisco
TelePresence Video
Communication
Server

Multisite
Conference in
SX80 Codec
with dual
display
registered in
Cisco VCS

UCJ10.6SPH2.VCS.G.054

NilPassedSX80 Codec ->
Unified CM ->
EX90
SX80 Codec ->
Add -> Unified
CM -> SX10
Quick Set

Verify whether the
two monitors are
utilized for video of
the participants
during conference in
Cisco TelePresence
SX80 Codec
registered in Cisco
Unified
Communications
Manager

Multisite
Conference in
SX80 Codec
with dual
display
registered in
Unified CM

UCJ10.6SPH2.VCS.G.055
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NilPassedNAVerify whether admin
gets warning in 10
seconds interval after
taking web snapshot
in Cisco TelePresence
SX80 Codec Web
GUI

Checking
warning for
admin in 10
seconds interval
after taking web
snapshot in
SX80 Codec
Web GUI

UCJ10.6SPH2.VCS.G.056

NilPassedNAVerify whether CDP
mode can be set to
ON/OFF using xAPI
of Cisco TelePresence
System EX90 using
command
xConfiguration
NetworkServices
CDP Mode: <Off,
On>

On/OFF CDP
mode in xAPI of
EX90

UCJ10.6SPH2.VCS.G.057

NilPassedNAVerify whether the
certificate checker
message is displayed
when discovering
Cisco Unified
Communications
Manager with TLS
verify mode is ON in
Cisco TelePresence
Video
Communication
Server Control

Certificate
checkermessage
in Cisco VCS-C
when
discovering
Unified CM
with TLS verify
mode is ON

UCJ10.6SPH2.VCS.G.058

NilPassedNAVerify whether the
traversal certificate is
checked by giving
FQDN and TLS
verify name in Cisco
TelePresence Video
Communication
Server Control

Secure traversal
test for Cisco
VCS-C by
specifying TLS
verify name

UCJ10.6SPH2.VCS.G.059

NilPassedNAVerify whether new
Phoenix OSD is
displayed in Cisco
TelePresence SX20
Quick Set monitor
when paired with
Touch 10"

Checking new
Phoenix OSD in
SX20 Quick Set
paired with
Touch 10"

UCJ10.6SPH2.VCS.G.060
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NilPassedNAVerify whether new
Phoenix OSD is
displayed in Cisco
TelePresence SX20
Quick Set monitor
when paired with
Touch 8"

Checking new
Phoenix OSD in
SX20 Quick Set
paired with
Touch 8"

UCJ10.6SPH2.VCS.G.061

NilPassedNAVerify whether the
remote support user
can add the build in
upgrade folder of
SX20 Quick Set

Checking write
access for
remote support
user to Upgrade
folder of SX20
Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.062

NilPassedNAVerify whether the
Manual option set to
Presentation Selection
menu of Cisco
TelePresence SX20
Quick Set works
successfully

Checking
Manual option
for Presentation
Selection Setting

UCJ10.6SPH2.VCS.G.063

NilPassedNAVerify whether the
monitoring icon
timeout in Cisco
TelePresence SX20
Quick Set display
when monitoring is
inactive by the admin
works successfully

Checking for
time out of
monitoring icon
in SX20 Quick
Set display after
30 seconds of
active
monitoring

UCJ10.6SPH2.VCS.G.064

NilPassedSX20 Quick Set ->
Unified CM ->
Integrator Package
C90 -> Local
Presentation
Preview in SX20
Quick Set

Verify whether the
Local Presentation
Preview in Cisco
TelePresence SX20
Quick Set when in a
call with Cisco
TelePresence System
Integrator Package
C90 both registered in
Cisco Unified
Communications
Manager works
successfully

Local
Presentation
Preview in SX20
Quick Set
registered with
Unified CM
while in a call

UCJ10.6SPH2.VCS.G.065
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NilPassedSX20 Quick Set ->
Cisco VCS ->
Integrator Package
C90 -> Local
Presentation
Preview in SX20
Quick Set

Verify whether the
Local Presentation
Preview in Cisco
TelePresence SX20
Quick Set when in a
call with Cisco
TelePresence System
Integrator Package
C90 both registered
with Cisco
TelePresence Video
Communication
server works
successfully

Local
Presentation
Preview in SX20
Quick Set
registered with
Cisco VCS
while in a call

UCJ10.6SPH2.VCS.G.066

NilPassedSX20 Quick Set ->
Unified CM ->
EX90
SX20 Quick Set ->
Add -> Unified
CM -> Integrator
Package C90 ->
Local Presentation
Preview in SX20
Quick Set

Verify whether the
Local Presentation
Preview in Cisco
TelePresence SX20
Quick Set when in a
conferencewith Cisco
TelePresence System
EX90 and Cisco
TelePresence System
Integrator Package
C90 all are registered
in Cisco Unified
Communications
Manager

Local
Presentation
Preview in SX20
Quick Set
registered with
Unified CM
during
conference

UCJ10.6SPH2.VCS.G.067

NilPassedNAVerify whether CDP
mode can be set to
ON/OFF using xAPI
of Cisco TelePresence
SX20Quick Set using
xConfiguration
NetworkServices
CDP Mode: <Off,
On> command

Setting CDP
mode to On /
Off in SX20
Quick Set

UCJ10.6SPH2.VCS.G.068

NilPassedNAVerify whether the
remote support user
can add the build in
upgrade folder of
Cisco TelePresence
MX300-G2

Checking write
access for
remote support
user to Upgrade
folder of
MX300-G2

UCJ10.6SPH2.VCS.G.069
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NilPassedSX10Quick Set ->
Unified CM ->
SX20 Quick Set
SX10 Quick Set ->
Add -> Unified
CM -> SIP Trunk
-> MCU 4510 ->
EX90

Verify whether
Adhoc conference
from Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set and Cisco
TelePresence System
EX90 both registered
with Cisco Unified
Communications
Manager can be
established

Adhoc
conferencing
from SX10
Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.070

NilPassedNAVerify whether iPad
can be paired with
Cisco TelePresence
SX10 Quick Set
registered with Cisco
Unified
Communications
Manager through
Cisco Proximity

Cisco Proximity
pairing of iPad
with SX10
Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.071

NilPassediPad (Paired with
SX10 Quick Set)
-> Unified CM ->
SX20 Quick Set

Verify whether video
call from iPad paired
with Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager can be
established through
Cisco Proximity

Making video
call from iPad
paired with
SX10 Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.072

NilPassedNAVerify whether
iPhone can be paired
with Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager through
Cisco Proximity

Cisco Proximity
pairing of
iPhone with
SX10 Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.073
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NilPassediPhone (Paired
with SX10 Quick
Set) -> Unified
CM -> SX20
Quick Set

Verify whether video
call from iPhone
paired with Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager can be
established through
Cisco Proximity

Making video
call from iPhone
paired with
SX10 Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.074

NilPassedSX10 Quick Set ->
Unified CM ->
SX20 Quick Set

Verify whether the
call can be
disconnected in Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager when the
call is ended in iPad
through Cisco
proximity

Making call
from SX10
Quick Set
registered with
Unified CM and
ending the call
from iPad
through Cisco
Proximity

UCJ10.6SPH2.VCS.G.075

NilPassedSX10 Quick Set ->
Unified CM ->
SX20 Quick Set

Verify whether the
call can be
disconnected in Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager when the
call is ended in
iPhone through Cisco
proximity

Making call
from SX10
Quick Set
registered with
Unified CM and
ending the call
from iPhone
through Cisco
Proximity

UCJ10.6SPH2.VCS.G.076

NilPassedNAVerify whether Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager can be
logged in as EM user

Logging in
SX10 Quick Set
as EM user

UCJ10.6SPH2.VCS.G.077
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NilPassedSX10 Quick Set
(EM User ) ->
Unified CM ->
SX20 Quick Set

Verify whether video
call from Cisco
TelePresence SX10
Quick Set logged in
as EM user to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager can be
established

Making video
call from SX10
Quick Set
logged in as EM
user

UCJ10.6SPH2.VCS.G.078

NilPassedSX10 Quick Set
(EM User ) ->
Unified CM ->
SX20 Quick Set -
> Presentation
Sharing

Verify whether
presentation sharing
from Cisco
TelePresence SX10
Quick Set logged in
as EM user to Cisco
TelePresence SX20
Quick Set registered
with Cisco Unified
Communications
Manager works
successfully

Presentation
sharing from
SX10 Quick Set
logged in as EM
user

UCJ10.6SPH2.VCS.G.079

NilPassedSX20 Quick Set ->
Unified CM ->
SX10 Quick Set

Verify whether the
Overscan level set to
High in Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager works
successfully

Setting
Overscan level
to High in SX10
Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.080

NilPassedSX20 Quick Set ->
Unified CM ->
SX10 Quick Set

Verify whether the
Overscan level set to
Medium in Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager works
successfully

Setting
Overscan level
to Medium in
SX10 Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.081
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NilPassedSX20 Quick Set ->
Unified CM ->
SX10 Quick Set

Verify whether the
Overscan level set to
None in Cisco
TelePresence SX10
Quick Set registered
with Cisco Unified
Communications
Manager works
successfully

Setting
Overscan level
to None in SX10
Quick Set
registered with
Unified CM

UCJ10.6SPH2.VCS.G.082

NilPassedNAVerify whether
warning message is
displayed in the
monitor of Cisco
TelePresence SX10
Quick Set registered
in Cisco Unified
Communications
Manager when taking
web snapshots

Checking web
snapshot
warning in SX10
Quick Set
displaywhen not
in call

UCJ10.6SPH2.VCS.G.083

NilPassedNAVerify whether the
admin gets warning
message in Web GUI
of Cisco TelePresence
SX10 Quick Set
registered with Cisco
Unified
Communications
Manager before
taking the web
snapshots

Ensuring the
warning
message in Web
GUI of SX10
Quick Set prior
to taking web
snapshot

UCJ10.6SPH2.VCS.G.084

NilPassedNAVerify whether the
eye icon is displayed
in Cisco TelePresence
SX10 Quick Set
during active
monitoring by admin

Checking eye
icon in SX10
Quick Set
display during
active
monitoring by
admin

UCJ10.6SPH2.VCS.G.085
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NilPassedSX10 Quick Set ->
Unified CM ->
Integrator Package
C90 -> Local
Presentation
Preview in SX10
Quick Set

Verify whether the
Local Presentation
Preview in Cisco
TelePresence SX10
Quick Set when in a
call with Cisco
TelePresence System
Integrator Package
C90 both registered in
Cisco Unified
Communications
Manager works
successfully

Local
Presentation
Preview in SX10
Quick Set
registered with
Unified CM
while in a call

UCJ10.6SPH2.VCS.G.086

NilPassedSX10 Quick Set ->
Unified CM ->
EX90
SX10 Quick Set ->
Add -> Unified
CM -> Integrator
Package C90 ->
Local Presentation
Preview in SX10
Quick Set

Verify whether the
Local Presentation
Preview in Cisco
TelePresence SX10
Quick Set when in a
conferencewith Cisco
TelePresence System
EX90 and Cisco
TelePresence System
Integrator Package
C90 all are registered
in Cisco Unified
Communications
Manager

Local
Presentation
Preview in SX10
Quick Set
registered with
Unified CM
during
conference

UCJ10.6SPH2.VCS.G.087

NilPassedNAVerify whether CDP
mode can be set to
ON/OFF using xAPI
of Cisco TelePresence
SX10Quick Set using
xConfiguration
NetworkServices
CDP Mode: <Off,
On> command

Setting CDP
mode to On /
Off in SX10
Quick Set

UCJ10.6SPH2.VCS.G.088

NilPassedNAVerify whether the
remote support user
can add the build in
upgrade folder of
Cisco TelePresence
SX10 Quick Set

Checking write
access for
remote support
user to Upgrade
folder of SX10
Quick Set

UCJ10.6SPH2.VCS.G.089
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NilPassedIntegrator Package
C90 (Local
Presentation
Preview) ->
Unified CM ->
EX90

Verify whether the
Local Presentation
Preview in Cisco
TelePresence
Integrator Package
C90 when in a call
with Cisco
TelePresence System
EX90 both registered
in Cisco Unified
Communications
Manager works
successfully

Local
Presentation
Preview in
Integrator
Package C90
registered with
Unified CM
while in a call

UCJ10.6SPH2.VCS.G.090

NilPassedIntegrator Package
C90 (Local
Presentation
Preview) -> Cisco
VCS -> EX90

Verify whether the
Local Presentation
Preview in Cisco
TelePresence
Integrator Package
C90 when in a call
with Cisco
TelePresence System
EX90 both registered
with Cisco
TelePresence Video
Communication
server works
successfully

Local
Presentation
Preview in
Integrator
Package C90
registered with
Cisco VCS
while in a call

UCJ10.6SPH2.VCS.G.091

NilPassedIntegrator Package
C90 (Presentation
Preview) ->
Unified CM ->
EX90 -> Add ->
Unified CM ->
EX60

Verify whether the
Local Presentation
Preview in Cisco
TelePresence
Integrator Package
C90 when in a
conferencewith Cisco
TelePresence System
EX90 and Cisco
TelePresence System
EX60 all are
registered in Cisco
Unified
Communications
Manager

Local
Presentation
Preview in
Integrator
Package C90
registered with
Unified CM
during
conference

UCJ10.6SPH2.VCS.G.092
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NilPassedNAVerify whether CDP
mode can be set to
ON/OFF using xAPI
of Cisco TelePresence
Integrator Package
C90 using
xConfiguration
NetworkServices
CDP Mode: <Off,
On> command

Setting CDP
mode to On /
Off in Integrator
Package C90

UCJ10.6SPH2.VCS.G.093

NilPassedNAVerify whether the
user can add the build
in upgrade folder

Checking write
access for
remote support
user to Upgrade
folder of
Integrator
Package C90

UCJ10.6SPH2.VCS.G.094

NilPassedNAVerify whether the
Manual option set to
Presentation Selection
menu of Cisco
TelePresence
Integrator Package
C90 works
successfully

Checking
Manual option
for Presentation
Selection Setting
of Integrator
Package C90

UCJ10.6SPH2.VCS.G.095

NilPassedEX90 -> Cisco
VCS (Cluster) ->
SX80 Codec ->
Add -> Cisco VCS
-> MCU ->
Integrator Package
C90 (Multiway)

Verify whether the
Multiway conference
is working
successfully when
Cisco Video
TelePresence
Communication
Server proxy 1 is
down for Cisco
TelePresence System
EX90, Cisco
TelePresence SX80
Codec and Cisco
TelePresence
Integrator Package
C90 and those are
registered to Cisco
TelePresence Video
Communication
Server proxy 2

Multiway
conferencewhen
codec registers
to Cisco VCS
proxy 2

UCJ10.6PH2S.Video.SR.G.001
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NilPassedEX90 -> Cisco
VCS (Cluster) ->
SX80 Codec ->
Add -> Cisco VCS
-> MCU -> EX60
(Multiway)

Verify whether the
Multiway conference
is working
successfully when
Cisco TelePresence
Video
Communication
Server proxy 1 is
down for Cisco
TelePresence System
EX90, Cisco
TelePresence SX80
Codec and Cisco
TelePresence System
EX60 and those are
registered to Cisco
TelePresence Video
Communication
Server proxy 2

Multiway
conference
among EX60,
EX90 and SX80
Codec when
registers to
Cisco VCS
proxy 2

UCJ10.6PH2S.Video.SR.G.002

NilPassedIntegrator Package
C90 -> Cisco VCS
(Cluster) -> SX80
Codec -> Add ->
Cisco VCS ->
MCU -> SX20
Quick Set
(Multiway)

Verify whether the
Multiway conference
is working
successfully when
Cisco TelePresence
Video
Communication
Server proxy 1 is
down for Cisco
TelePresence
Integrator Package
C90, Cisco
TelePresence SX80
Codec and Cisco
TelePresence SX20
Quick Set and those
are registered to
Cisco TelePresence
Video
Communication
Server proxy 2

Multiway
conference
among SX80
Codec,
Integrator
Package C90
and SX20Quick
Set when Cisco
VCS proxy 1 is
down

UCJ10.6PH2S.Video.SR.G.003
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NilPassedSX20 Quick Set
(Presentation
Sharing) ->
Unified CM ->
SX10 Quick Set

Verify whether video
and presentation is
sent from Cisco
TelePresence SX20
Quick Set to Cisco
TelePresence SX10
Quick Set after
changing the layout to
‘Single’ in Cisco
TelePresence SX20
Quick Set, both are
registered with Cisco
Unified
Communications
Manager

‘Single’
presentation
layout in SX20
Quick Set
registered with
Unified CM
during
presentation
sharing

UCJ10.6PH2S.Video.SR.G.004

NilPassedSX20 Quick Set ->
Unified CM ->
SX10 Quick Set
(Presentation
Sharing)

Verify whether video
and presentation is
sent from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence SX20
Quick Set after
changing the layout to
‘Single’ in Cisco
TelePresence SX20
Quick Set, both are
registered with Cisco
Unified
Communications
Manager

‘Single’
presentation
layout for far
end presentation
in SX20 Quick
Set registered
with Unified
CM

UCJ10.6PH2S.Video.SR.G.005

NilPassedSX20 Quick Set
(Presentation
Sharing) -> Cisco
VCS -> SX10
Quick Set

Verify whether video
and presentation is
sent from Cisco
TelePresence SX20
Quick Set to Cisco
TelePresence SX10
Quick Set after
changing the layout to
‘Single’ in Cisco
TelePresence SX20
Quick Set, both are
registered with Cisco
Video
Communication
Server

‘Single’
presentation
layout in SX20
Quick Set
registered with
Cisco VCS
during
presentation
sharing

UCJ10.6PH2S.Video.SR.G.006
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NilPassedSX20 Quick Set ->
Cisco VCS ->
SX10 Quick Set
(Presentation
Sharing)

Verify whether video
and presentation is
sent from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence SX20
Quick Set after
changing the layout to
‘Single’ in Cisco
TelePresence SX20
Quick Set, both are
registered with Cisco
Video
Communication
Server

‘Single’
presentation
layout for far
end presentation
in SX20 Quick
Set registered
with Cisco VCS

UCJ10.6PH2S.Video.SR.G.007

NilPassedNATo Verify that user is
able to assign the
static IP address for
Touch Panel 10”

Assign the static
IP address for
Touch Panel 10”

UCJ10.6PH2S.Video.SR.G.008

NilPassedNAVerify whether the
name displays
correctly when
change the
configuration name in
change configuration
setting by using
remote controller in
SX series endpoints

Save the
Configuration
Changes using
Remote control
and Touch Panel
in SX series
endpoints

UCJ10.6PH2S.Video.SR.G.009

NilPassedSX80 Codec ->
Unified CM ->
EX90

Verify whether the
call is established
from Cisco
TelePresence SX80
Codec to Cisco
TelePresence System
EX90 by changing
the default MTU size
value in the SX80

Make a call
from SX80
Codec to EX90
by changing the
Default MTU
size Value

UCJ10.6PH2S.Video.SR.G.010

NilPassedSX80 Codec ->
Unified CM ->
MX300G2

Verify whether the
call is established
from Cisco
TelePresence SX80
Codec to Cisco
TelePresence
MX300G2 by
changing the default
MTU size value in
Cisco TelePresence
SX80 Codec

Make a call
from SX80
Codec to
MX300G2 by
changing the
Default MTU
size Value

UCJ10.6PH2S.Video.SR.G.011
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NilPassedSX10 Quick Set ->
Unified CM ->
MX300G2

Verify whether the
call is established
from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence
MX300-G2 by
changing the default
MTU size value in the
SX10 Quick Set

Make a call
from SX10
Quick Set to
MX300-G2 by
changing the
Default MTU
size value

UCJ10.6PH2S.Video.SR.G.012

NilPassedSX10 Quick Set ->
Unified CM ->
MX200G2

Verify whether the
call is established
from Cisco
TelePresence SX10
Quick Set to Cisco
TelePresence
MX200-G2 by
changing the default
MTU size value in
SX10 Quick Set

Make a call
from SX10
Quick Set to
MX200-G2 by
changing the
Default MTU
size value

UCJ10.6PH2S.Video.SR.G.013

NilPassedNAVerify whether the
conference name can
be given with less
than 5 Japanese
characters in MCU
4510

Giving
conference name
with less than
five Japanese
characters in
MCU 4510

UCJ10.6PH2S.Video.SR.G.014

NilPassedNAVerify whether the
conference name can
be given with more
than 5 Japanese
characters in MCU
4510

Giving
conference name
with more than
five Japanese
characters in
MCU 4510

UCJ10.6PH2S.Video.SR.G.015

NilPassedNAVerify whether the
conferences can be
sorted in ascending
order in MCU 4510

Sorting the
conferences in
ascending order
in MCU 4510

UCJ10.6PH2S.Video.SR.G.016

NilPassedNAVerify whether the
conferences can be
sorted in descending
order in MCU 4510

Sorting the
conferences in
descending
order in MCU
4510

UCJ10.6PH2S.Video.SR.G.017
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NilPassedNAVerify whether the
list conference
displays the correct
list for the actual date
and conference from
the previous date
doesn’t show under
list conference when
a conference is
scheduled with time
zone UTC+10
(Brisbane)

List Conference
for selected day
displays the
correct list

UCJ10.6PH2S.Video.SR.G.018

NilPassedNAVerify whether the
list conference
displays the correct
list for the actual date
and conference from
the previous date
doesn’t show under
list conference when
a conference is
scheduled with time
zone UTC+12
(Auckland,
Wellington)

List Conference
for selected day
displays the
correct list after
a conference is
scheduled with
time zone
UTC+12
(Auckland,
Wellington)

UCJ10.6PH2S.Video.SR.G.019

NilPassedNAVerify whether serial
number of Cisco
TelePresenceTX9000
can be obtained by
web GUI

Getting serial
number of
TX9000 through
Web GUI

UCJ10.6PH2S.Video.SR.G.020

NilPassedNAVerify whether serial
number of Cisco
TelePresence System
500-32 can be
obtained by CLI

Getting serial
number of
500-32 through
CLI

UCJ10.6PH2S.Video.SR.G.021

CSCus75009FailedNAVerify whether the
language of SX10
Quick Set can be
changed to Japanese
through Setup
Assistant using
Remote Control RC6

Changing the
language of
SX10 Quick Set
to Japanese
through setup
assistant using
remote control
RC6

UCJ10.6PH2S.VCS.G.096
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CSCus76235FailedNAVerify whether the
language of SX10
Quick Set can be
changed to Arabic
through Setup
Assistant using
Remote Control RC6

Changing the
language of
SX10 Quick Set
to Arabic
through setup
assistant using
remote control
RC6

UCJ10.6PH2S.VCS.G.097

Cisco Jabber for iPhone and iPad
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedCJW -> Unified CM1
-> SIP Trunk ->
Unified CM2 -> CJI

Verify whether
desktop share is
receiving in
Jabber for iPhone
during inter site
call from CJW to
CJI via SIP Trunk
using BFCP
successfully

Check desktop
share is
receiving in
Jabber for
iPhone while
using BFCP

UCJ10.6Ph2S.CJI.G.001

NilPassedNAVerify contact
search are done
successfully by
searching URI of
the Jabber
contacts in Cisco
Jabber for iPhone

Search Jabber
contacts in
Jabber for
iPhone using
contact URI

UCJ10.6Ph2S.CJI.G.020

NilPassedNAVerify chat
messages are sent
successfully
between Cisco
Jabber for iPhone
and Cisco Jabber
for Windows

Send chats from
Cisco Jabber for
iPhone to Jabber
for Windows

UCJ10.6Ph2S.CJI.G.021

NilPassedNAVerify group chat
is happened
between Cisco
Jabber for
Windows, Cisco
Jabber for iPhone,
and Cisco Jabber
for Android

Make a group
chat with Cisco
Jabber for
Windows, Cisco
Jabber for
Android and
Cisco Jabber for
iPhone

UCJ10.6Ph2S.CJI.G.022
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NilPassedNAVerify files are
sent successfully
between Cisco
Jabber for iPhone
and Cisco Jabber
forWindows user
while chatting

Send files while
chatting from
Cisco Jabber for
iPhone to Cisco
Jabber for
Windows

UCJ10.6Ph2S.CJI.G.023

NilPassedNAVerify profile edit
in Jabber for
iPhone by adding
new profile photo
of the user when
sign-in using
WebEx
Messenger

Check profile
edit in Jabber
for iPhone by
adding new
profile photo
when login in
WebEx
Messenger

UCJ10.6Ph2S.CJI.G.018

NilPassedNAVerify captures
are sent
successfully
between Cisco
Jabber for iPhone
and Cisco Jabber
forWindows user
while chatting

Send captures
while chatting
from Cisco
Jabber for
iPhone to Cisco
Jabber for
Windows

UCJ10.6Ph2S.CJI.G.024

NilPassedNAVerify profile
image is updated
successfully in
Jabber for iPhone
by changing the
existing image of
the user when
sign-in using
WebEx account

Check profile
edit in Jabber
for iPhone by
editing the
existing profile
photo when
login using
WebEx
Messenger

UCJ10.6Ph2S.CJI.G.017

NilPassedCJW -> Unified CM1
-> SIP Trunk ->
Unified CM2 ->
CJIPad

Verify whether
desktop share is
receiving in
Jabber for iPad
during inter site
call from CJW to
CJIPad via SIP
Trunk using
BFCP
successfully

Check desktop
share is
receiving in
Jabber for iPad
while using
BFCP

UCJ10.6Ph2S.CJIPad.G.001
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NilPassedNAVerify contact
search are done
successfully by
searching URI of
the Jabber
contacts in Cisco
Jabber for iPad

Search Jabber
contacts in
Jabber for iPad
using contact
URI

UCJ10.6Ph2S.CJIPad.G.020

NilPassedNAVerify chat
messages are sent
successfully
between Cisco
Jabber for iPad
and Cisco Jabber
for Windows

Send chats from
Cisco Jabber for
iPad to Jabber
for Windows

UCJ10.6Ph2S.CJIPad.G.021

NilPassedNAVerify group chat
is happened
between Cisco
Jabber for
Windows, Cisco
Jabber for iPad,
and Cisco Jabber
for Android

Make a group
chat with Cisco
Jabber for
Windows, Cisco
Jabber for iPad
and Cisco
Jabber for
Android

UCJ10.6Ph2S.CJIPad.G.022

NilPassedNAVerify files are
sent successfully
between Cisco
Jabber for iPad
and Cisco Jabber
forWindows user
while chatting

Send files while
chatting from
Cisco Jabber for
iPad to Cisco
Jabber for
Windows

UCJ10.6Ph2S.CJIPad.G.023

NilPassedNAVerify profile edit
in Jabber for iPad
by adding new
profile photo of
the user when
sign-in using
WebEx
Messenger

Check profile
edit in Jabber
for iPad by
adding new
profile photo
when login in
WebEx
Messenger

UCJ10.6Ph2S.CJIPad.G.018

NilPassedNAVerify captures
are sent
successfully
between Cisco
Jabber for iPad
and Cisco Jabber
forWindows user
while chatting

Send captures
while chatting
from Cisco
Jabber for iPad
to Cisco Jabber
for Windows

UCJ10.6Ph2S.CJIPad.G.024
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NilPassedNAVerify profile
image is updated
successfully in
Jabber for iPad by
changing the
existing image of
the user when
sign-in using
WebEx account

Check profile
edit in Jabber
for iPad by
editing the
existing profile
photo when
login using
WebEx
Messenger

UCJ10.6Ph2S.CJIPad.G.017

NilPassedNAVerify whether
Jabber for iPhone
is displaying the
active directory
user when it is
offline in the
contacts list after
it is added to the
contacts of Jabber
successfully

Contact list of
Jabber should
display the
active directory
user after it is
added to the
contacts of
Jabber

UCJ10.6Ph2S.CJI.SR.002

NilPassedNAVerify whether all
the options which
is available under
the settings page
of the Jabber for
iPhone has been
shown
successfully

Check the
options under
the settings will
be display
properly

UCJ10.6Ph2S.CJI.SR.005

NilPassedNAVerify whether
Jabber for iPad
has to display the
message/notification
"you added a
contact to your
favorites list"
after the contacts
has been added to
the favorites list
of Jabber
successfully

Check the
message/notification
after contact has
been added in
the favorites list
of Jabber

UCJ10.6Ph2S.CJIPad.SR.006
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NilPassedNAVerify whether
Jabber for iPad is
displaying the
active directory
user when it is
online in the
contacts list after
it is added to the
contacts of Jabber
successfully

Contact list of
Jabber should
display the
active directory
user after it is
added to the
contacts of
Jabber

UCJ10.6Ph2S.CJIPad.SR.001

NilPassedNAVerify whether
User Name
already exists
notification has to
be shown when
again add the
already added
username in the
contacts list of
Jabber for iPad
successfully

User Name
already exists
notification has
to be shown
when username
added twice in
the contacts list
of Jabber for
iPad

UCJ10.6Ph2S.CJIPad.SR.008

NilPassedNAVerify whether
Jabber for iPad
status is showing
"on a call" when
Jabber for iPad 1
made an active
call with Jabber
for iPad 2
successfully

Jabber for iPad
status should be
"on a call" when
it is in an active
call

UCJ10.6Ph2S.CJIPad.SR.011

CSCut11162FailedNAVerify whether
group chat invite
is coming in
Japanese in
Jabber for iPhone
once started a
group chat from
Jabber for
Windows to
Jabber for iPhone
and Jabber for
Android
Successfully

Check Group
chat invite is
coming in
Japanese in
Jabber for
iPhone

UCJ10.6Ph2S.CJI.G.100
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Cisco Jabber for Android
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedCJW -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
CJA

Verify whether
desktop share is
receiving in
Jabber for
Android during
inter site call
fromCJW toCJA
via SIP Trunk
using BFCP
successfully

Check desktop
share is
receiving in
Jabber for
Android while
using BFCP

UCJ10.6Ph2S.CJA.G.001

NilPassedNAVerify contact
number is
updated
successfully in
Jabber for
Android by
editing the
address of the
user when sign-in
using WebEx
account

Check profile
edit in Jabber for
Android by
editing the
contact number
details when
login using
WebEx
Messenger

UCJ10.6Ph2S.CJA.G.016

NilPassedNAVerify contact
search are done
successfully by
searching URI of
the jabber
contacts in Cisco
Jabber for
Android

Search Jabber
contacts in
Jabber for
Android using
contact URI

UCJ10.6Ph2S.CJA.G.020

NilPassedNAVerify profile
address is
updated
successfully in
Jabber for
Android by
editing the
address of the
user when sign-in
using WebEx
account

Check profile
edit in Jabber for
Android by
editing the
address details
when login with
WebEx
Messenger

UCJ10.6Ph2S.CJA.G.015

   Test Results for Cisco Unified Communications System Release 10.6 Phase II for Japan
54

Test Results Summary
Cisco Jabber for Android



NilPassedNAVerify chat
messages are sent
successfully
between cisco
jabber for android
and Cisco Jabber
for Windows

Send chats from
Cisco Jabber for
Android to
Jabber for
Windows

UCJ10.6Ph2S.CJA.G.021

NilPassedNAVerify group chat
is happened
between Cisco
jabber for
Windows, Cisco
Jabber for
iPhone, andCisco
Jabber for
Android

Make a group
chat with Cisco
Jabber for
Windows , Cisco
Jabber for
iPhone and
Cisco Jabber for
Android

UCJ10.6Ph2S.CJA.G.022

NilPassedNAVerify files are
sent successfully
between cisco
jabber for android
and Cisco Jabber
forWindows user
while chatting

Send files while
chatting from
Cisco Jabber for
Android to Cisco
Jabber for
Windows

UCJ10.6Ph2S.CJA.G.023

NilPassedNAVerify profile
edit in Jabber for
Android by
adding new
profile photo of
the user when
sign-in using
WebEx
Messenger

Check profile
edit in Jabber for
Android by
adding new
profile photo
when login in
WebEx
Messenger

UCJ10.6Ph2S.CJA.G.018

NilPassedNAVerify captures
are sent
successfully
between cisco
jabber for android
and Cisco Jabber
forWindows user
while chatting

Send captures
while chatting
from Cisco
Jabber for
Android to Cisco
Jabber for
Windows

UCJ10.6Ph2S.CJA.G.024
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NilPassedNAVerify profile
image is updated
successfully in
Jabber for
Android by
changing the
existing image of
the user when
sign-in using
WebEx account

Check profile
edit in Jabber for
Android by
editing the
existing profile
photo when
login with
WebEx
Messenger

UCJ10.6Ph2S.CJA.G.017

CSCut22052FailedNAVerify whether
Secret and Angel
Emoticon is
showing in jabber
for Androidwhile
sending from
jabber for
windows to
jabber for iPhone
and Jabber for
Android during
group chat
Successfully

Check Secret
and Angel
Emoticon is
showing in
Jabber for
Android

UCJ10.6Ph2S.CJA.G.100

Cisco Jabber for Windows
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedNAVerify location is
displayed
successfully for the
user of Cisco
Jabber for
Windows

Check location
display in
Jabber for
Windows

UCJ10.6Ph2S.CJW.G.020

NilPassedNAVerify FIPS
security pop up is
displayed in Jabber
for Windows

Check FIPS
security pop up
in Jabber for
Windows

UCJ10.6Ph2S.CJW.G.033
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NilPassedNAVerify location
details are
published
successfully for the
user of Cisco
Jabber for
Windows while
moving from
Cluster A to
Cluster B

Check location
publication in
Jabber for
Windowswhile
moving from
Cluster A to
Cluster B

UCJ10.6Ph2S.CJW.G.023

NilPassedNAVerify security
labels are
displayed in chat
window of Jabber
forWindowswhile
sending chats

Check IM
security labels
in Jabber for
Windows

UCJ10.6Ph2S.CJW.G.026

NilPassedNAVerify files are
sent successfully
from CJW1 to
CJW2 and CJW3
when CJW1,
CJW2, CJW3 are
in group chat

Send files from
Cisco Jabber
for Windows
when CJW1,
CJW2 and
CJW3 are in
group chat

UCJ10.6Ph2S.CJW.G.038

NilPassedCJA -> Unified
CM -> CJW

Verify calls are not
allowed from CJA
to Cisco Jabber for
Windowswhen the
status of Jabber for
Windows is in "Do
Not Disturb"

Make call from
CJA to CJW
when Cisco
Jabber for
Windows is in
"Do Not
Disturb" state

UCJ10.6Ph2S.CJW.G.057

NilPassedNAVerify chats are
saved in Microsoft
outlook by saving
the chat messages
in Jabber for
Windows

Chat from
Cisco Jabber
for Windows
and save the
chat in
Microsoft
Outlook

UCJ10.6Ph2S.CJW.G.049

NilPassedNAVerify alerts are
displayed in Jabber
forWindowswhen
contact has
become
"Available" from
the status "Offline
/ Away / Do Not
Disturb"

Alert when
user status has
become
available in
Jabber for
Windows

UCJ10.6Ph2S.CJW.G.065
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NilPassedNAVerify edited
location details are
published
successfully for the
user of Cisco
Jabber for
Windows

Edit location
publication in
Jabber for
Windows

UCJ10.6Ph2S.CJW.G.022

NilPassedNAVerify location
details are not
published after
deleting the
location details
from the "location"
page in Jabber for
Windows

Delete location
publication in
Jabber for
Windows

UCJ10.6Ph2S.CJW.G.024

NilPassedNAVerify chats with
emoticons are sent
via security labels
while sending
chats from Jabber
for Windows

Send chats with
emoticons
through
security labels
from Jabber for
Windows

UCJ10.6Ph2S.CJW.G.030

NilPassedNAVerify FIPS
connection issue
error is displayed
when Jabber for
Windows is
launched with un
secure connection

Check FIPS
connection
issue while
launching
Cisco Jabber
forWindows in
FIPS mode

UCJ10.6Ph2S.CJW.G.035

NilPassedNAVerify files are
sent successfully
from CJW to CJA
and CJM when
CJW, CJA and
CJM are in group
chat

Send files from
Cisco Jabber
for Windows
when CJW,
CJA and CJM
are in group
chat

UCJ10.6Ph2S.CJW.G.042

NilPassedNAVerify files are
sent successfully
from CJW1 to
CJW2 and CJM
when CJW1,
CJW2 and CJM
are in persistent
chat room

Send files from
Cisco Jabber
for Windows
when CJW1,
CJW2 and
CJM are in
persistent chat

UCJ10.6Ph2S.CJW.G.046
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NilPassedNAVerify participants
are removed
successfully while
doing group chat
in Jabber for
Windows

Remove
participants
from group
chat in Jabber
for Windows

UCJ10.6Ph2S.CJW.G.054

NilPassedNAVerify Cisco
Jabber with the
pop upmessage "A
software update is
available" are
displayedwhile we
signing into the
Jabber

Check
Mandatory
upgrade while
signing in the
Jabber for
Windows

UCJ10.6Ph2S.CJW.G.061

NilPassedNAVerify instant
WebEx meeting
from Cisco Jabber
for Windows A to
Cisco Jabber for
Windows B is
initiated
successfully

Instant WebEx
meeting from
Cisco Jabber
for Windows

UCJ10.6Ph2S.CJWWM.SR.201

NilPassedNAVerify Cisco
Jabber for
Windows A
initiate WebEx
meetingwith Cisco
Jabber for Mac A
and check Cisco
Jabber for Mac
able to decline the
meeting
successfully

Decline the
meeting from
Cisco Jabber
for Mac

UCJ10.6Ph2S.CJWWM.SR.217

NilPassedNAVerify that
meeting details are
viewed correctly in
Cisco Jabber for
Windows B

Meeting details
inMeetings tab
in CJW

UCJ10.6Ph2S.CJMWM.SR.033
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NilPassedNAVerify Cisco
Jabber for
Windows A
initiate WebEx
meetingwith Cisco
Jabber for
Windows B and
check Cisco Jabber
for Windows A
able to share the
screen during
meeting

Validate
desktop share
works during
WebEx
meeting in
CJW

UCJ10.6Ph2S.CJWWM.SR.219

NilPassedNAVerify that Cisco
Jabber for
Windows shares
files to Cisco
Jabber for Mac
during WebEx
meeting
successfully

Sharing files
from CJW to
Cisco Jabber
for Mac during
WebEx
meeting

UCJ10.6Ph2S.CJWWM.SR.319

NilPassedNAVerify that Cisco
Jabber for
Windows A are in
WebEx meeting
with Cisco Jabber
for Windows B
and Cisco Jabber
for Windows A
ends the meeting
successfully

End theWebEx
meeting from
Cisco Jabber
for Windows

UCJ10.6Ph2S.CJWWM.SR.316

NilPassedNAVerify the message
in Cisco Jabber for
Mac WebEx
screen when the
host (Cisco Jabber
for Windows
A)leaves the
meeting

Validate the
message in
Cisco Jabber
for Mac
WebEx screen
when the host
leaves the
meeting

UCJ10.6Ph2S.CJWWM.SR.315
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NilPassedNAVerify that Cisco
Jabber for
Windows A (host)
initiate WebEx
meetingwith Cisco
Jabber for
Windows B and
Cisco Jabber for
Windows A pass
the ball to Cisco
Jabber for
Windows B and
shares the file

Host passing
the ball to
Cisco Jabber
for Windows

UCJ10.6Ph2S.CJWWM.SR.312

NilPassedNAVerify that Cisco
Jabber for
Windows A
initiate instant
WebEx meeting to
Cisco Jabber for
Windows B and
users able to send
chat messages
during WebEx
meeting

Chat between
two users when
CJW A initiate
instant WebEx
meeting to
CJW B

UCJ10.6Ph2S.CJWWM.SR.310

NilPassedNAVerify that
Japanese name are
displayed in
CWMS user page
successfully

Display of
Japanese
username in
CWMS

UCJ10.6Ph2S.CJWWM.SR.007

NilPassedNAVerify Cisco
Jabber for
Windows A
successfully
initiate WebEx
meetingwith Cisco
Jabber for
Windows B and
validate the status
of the users

Start a WebEx
meeting from
CJWA to CJW
B and check
the presence
status

UCJ10.6Ph2S.CUP.SR.014

NilPassedNAVerify Cisco
Jabber for
Windows initiate
chat with Cisco
Jabber for Mac
successfully and
verify the presence
status of both the
users

IM chat
between CJW
and CJM users

UCJ10.6Ph2S.CUP.SR.010
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NilPassedNAVerify Cisco
Jabber for
Windows initiate
chat with Cisco
Jabber for iPad
successfully and
verify the presence
status of both the
users

Initiate IM chat
between CJW
and CJiPad
users and
validate
presence status

UCJ10.6Ph2S.CUP.SR.011

NilPassedJabber for
Windows ->
Unified CM ->
Cisco Unity
Connection ->
Jabber for iPhone

Verify whether
voice messages
can be sent from
Jabber for
Windows to Jabber
for iPhone
successfully

Send Voice
mail from
Jabber for
Windows to
Jabber for
iPhone

UCJ10.6Ph2S.CJW.SR.006

NilPassedJabber for
Windows ->
Unified CM ->
Cisco Unity
Connection ->
Jabber for iPhone

Verify whether
Mark as read/Mark
as unread can able
to do after
retrieved the voice
messages from
Jabber for
Windows to Jabber
for iPhone
successfully

Mark as
read/Mark as
unread can able
to do after
retrieved the
voicemessages
from Jabber for
Windows to
Jabber for
iPhone

UCJ10.6Ph2S.CJW.SR.010

NilPassedNAVerify whether
contacts which has
been added in the
created contact
group 1 can be
move to the
contact group 2 in
the Jabber for
Windows
successfully

Move the
contacts from
one contact
group to
another contact
group in Jabber
for Windows

UCJ10.6Ph2S.CJW.SR.015

NilPassedNAVerify whether
Alert notification
will be appear
when the contact
which has been
added in the
created contact
group becomes
available status in
the Jabber for
Windows
successfully

Alert notify
when the
contact which
has been added
in the created

UCJ10.6Ph2S.CJW.SR.017
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NilPassedNAVerify whether
newly created
contact group can
be rename in the
Jabber for
Windows
successfully

Rename the
new contact
group name
which is
created in
Jabber for
Windows

UCJ10.6Ph2S.CJW.SR.013

NilPassedNAVerify whether
new contact group
name can be added
in the Jabber for
Windows and then
add the users under
the group name
successfully

Create new
contact group
name and add
the users under
the group name

UCJ10.6Ph2S.CJW.SR.012

Cisco Jabber for Mac
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedNAVerify user's
presence status is
not displayed in
my profile page
after the user has
been logged in to
Cisco Jabber for
Mac with
phone-only Mode

Check presence
status should
not display in
phone only
mode while
clicking view
my profile

UCJ10.6Ph2S.CJM.G.002

NilPassedNAVerify presence
status is not
displayed in
contacts page of
Cisco Jabber for
Mac while adding
new Cisco Jabber
for Android user

Add contacts
(which is in IM
& Presence
state in CJA) to
Jabber for Mac
in Phone-only
mode

UCJ10.6Ph2S.CJM.G.014

NilPassedCJM -> Unified CM
-> Phone B

Verify call
processing is
established
between Jabber
for Mac and IP
Phone in
Phone-only mode

Make an intra
cluster call from
Jabber for Mac
to DX650 in
phone-only
mode

UCJ10.6Ph2S.CJM.G.009
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NilPassedNAVerify new
contacts are added
successfully in the
contact list while
adding contacts
using custom
contacts

Add new
contacts using
custom contacts

UCJ10.6Ph2S.CJM.G.051

NilPassedNAVerify display
name is displayed
in Japanese while
changing the
custom contact
display name in
Japanese

Edit custom
contact display
name in
Japanese

UCJ10.6Ph2S.CJM.G.063

NilPassedNAVerify user which
is created by
Microsoft Lync is
able to login into
Jabber for Mac

Check
Microsoft Lync
users login for
CJM

UCJ10.6Ph2S.CJM.G.092

NilPassedNAVerify chats are
sent between Lync
user of Cisco
Jabber for Mac
and Cisco Jabber
for windows user

Send chats from
CJMLync users
to CJW

UCJ10.6Ph2S.CJM.G.099

NilPassedNAVerify user
presence status is
not displayed after
the user has been
logged in to
Jabber for Mac
with phone-only
Mode

Check the
presence status
of the user in
Jabber for Mac
with phone only
mode

UCJ10.6Ph2S.CJM.G.001

NilPassedCJM -> Unified CM
-> CJI/CJIP

Verify presence
status is not
displayed in Cisco
Jabber for Mac
(Phone only
mode) while
making call from
CJM to IOS
devices

Make call from
CJM (which is
in Phone only
mode) to IOS
devices (which
are in IM and
Presencemode)

UCJ10.6Ph2S.CJM.G.016
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NilPassedNAVerify custom
contacts are
moved from one
contact group
(G1) to another
contact group
(G2)

Move custom
contacts from
one group to
another group

UCJ10.6Ph2S.CJM.G.052

NilPassedNAVerify selected
custom contacts
are removed
successfully from
the contacts list

Remove
contacts which
are created
using custom
contacts

UCJ10.6Ph2S.CJM.G.053

NilPassedCJM -> Unified CM
-> CJW

Verify desktop
sharing is worked
while establishing
call from Cisco
Jabber for Mac to
Cisco Jabber for
windows

Desktop sharing
in CJM during
call in progress
with CJW

UCJ10.6Ph2S.CJM.G.102

NilPassedCJM -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
Phone B

Verify inter
cluster call is
established from
Cisco Jabber for
Mac to IP phone
via SIP trunk

Make an inter
cluster call from
Cisco Jabber for
Mac to IP
Phone

UCJ10.6Ph2S.CJM.G.010

NilPassedNAVerify custom
status is changed
while adding new
custom status for
Lync user in
Jabber for Mac

Check custom
status for Lync
users in CJM

UCJ10.6Ph2S.CJM.G.095

CSCut16237FailedNAVerify group chat
invite
notifications are
displaying
correctly in Cisco
Jabber for Mac

Title Check
group chat
invite
notification in
Cisco Jabber for
Mac

UCJ10.6Ph2S.CJM.G.121

Cisco TelePresence Multipoint Control Unit
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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NilPassedNAVerify whether
the conference
name can be
given with less
than 5 Japanese
characters in
MCU5310which
uses Cisco
TelePresence
Video
Communication
Server as SIP
Registrar

Giving
conference
name with less
than five
Japanese
characters in
MCU 5310

UCJ10.6PH2S.MCU.G.001

NilPassedNAVerify whether
the conference
name can be
given with more
than 5 Japanese
characters in
MCU5310which
uses Cisco
TelePresence
Video
Communication
Server as SIP
Registrar

Giving
conference
name with
more than five
Japanese
characters in
MCU 5310

UCJ10.6PH2S.MCU.G.002

NilPassedNAVerify whether
the conferences
can be sorted in
ascending order
in MCU 5310

Sorting the
conferences in
ascending
order in MCU
5310

UCJ10.6PH2S.MCU.G.003

NilPassedNAVerify whether
the conferences
can be sorted in
descending order
in MCU 5310

Sorting the
conferences in
descending
order in MCU
5310

UCJ10.6PH2S.MCU.G.004
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NilPassedSX10 Quick Set ->
Unified CM -> SIP
Trunk ->MCU4510

Verify whether
Cisco
TelePresence
SX10 Quick Set
registered with
Cisco Unified
Communications
Manager can join
in a Meet me
conference in
Cisco
TelePresence
MCU 4510
successfully

Meet me
conference
from SX10
Quick Set
registered with
Unified CM to
MCU 4510

UCJ10.6PH2S.MCU.G.005

NilPassedSX80 Codec ->
Unified CM -> SIP
Trunk ->MCU4510

Verify whether
Cisco
TelePresence
SX80 Codec
registered with
Cisco Unified
Communications
Manager can join
in a Meet me
conference in
Cisco
TelePresence
MCU 4510

Meet me
conference
from SX80
Codec
registered with
Unified CM to
MCU 4510

UCJ10.6PH2S.MCU.G.006

NilPassedDX70 -> Unified
CM -> SIP Trunk ->
MCU 4510

Verify whether
Cisco DX70
registered with
Cisco Unified
Communications
Manager can
participate in
Meet me
conference in
Cisco
TelePresence
MCU 4510
successfully

Meet me
conference
from DX70
registered with
Unified CM to
MCU 4510

UCJ10.6PH2S.MCU.G.007
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NilPassedDX80 -> Unified
CM -> SIP Trunk ->
MCU 4510

Verify whether
Cisco DX80
registered with
Cisco Unified
Communications
Manager can
participate in
Meet me
conference in
Cisco
TelePresence
MCU 4510
successfully

Meet me
conference
from DX80
registered with
Unified CM to
MCU 4510

UCJ10.6PH2S.MCU.G.008

NilPassedDX70 -> Unified
CM -> SIP Trunk ->
Cisco VCS ->MCU
4510

Verify whether
Cisco DX70
registered with
Cisco Unified
Communications
Manager can
participate in
Meet me
conference in
Cisco
TelePresence
MCU 4510
registered with
Cisco
TelePresence
Video
Communications
Server using SIP
Registrar

Meet me
conference
from DX70
registered with
Unified CM to
MCU 4510
registered with
Cisco VCS
using SIP
Registrar

UCJ10.6PH2S.MCU.G.009
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NilPassedDX80 -> Unified
CM -> SIP Trunk ->
Cisco VCS ->MCU
4510

Verify whether
Cisco DX80
registered with
Cisco Unified
Communications
Manager can
participate in
Meet me
conference in
Cisco
TelePresence
MCU 4510
registered with
Cisco
TelePresence
Video
Communications
Server using SIP
Registrar
successfully

Meet me
conference
from DX80
registered with
Unified CM to
MCU 4510
registered with
Cisco VCS
using SIP
Registrar

UCJ10.6PH2S.MCU.G.010

Cisco TelePresence Management Suite
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedCisco TMS ->
MCU 4510 ->
Cisco VCS ->
EX90 -> SX80
Codec -> SX10
Quickset

Verify whether the
Externally Hosted
Conference using
Cisco TelePresence
MCU 4510 works
successfully in Cisco
TelePresence
Management Suite
for endpoints
registered in Cisco
TelePresence Video
Communication
Server

Externally
Hosted
Conference
using MCU
4510

UCJ10.6Ph2S.TMS.G.001
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NilPassedCisco TMS ->
MCU 4510 -> SIP
Trunk -> Unified
CM -> EX90 ->
SX80 Codec ->
SX10 Quickset

Verify whether the
Externally Hosted
Conference using
Cisco TelePresence
MCU 4510 works
successfully in Cisco
TelePresence
Management Suite
for endpoints
registered in Cisco
Unified
Communications
Manager

Externally
Hosted
Conference
using MCU
4510 for
endpoints
registered to
Unified CM

UCJ10.6Ph2S.TMS.G.002

NilPassedCisco TMS ->
Cisco TS 7010 ->
Cisco VCS ->
EX90 -> SX80
Codec -> SX10
Quickset

Verify whether the
Externally Hosted
Conference using
Cisco TelePresence
Server 7010 works
successfully in Cisco
TelePresence
Management Suite
for endpoints
registered in Cisco
TelePresence Video
Communication
Server

Externally
Hosted
Conference
using Cisco TS
7010

UCJ10.6Ph2S.TMS.G.003

NilPassedNAVerify whether
booking confirmation
email is sent to all
users involved in the
conference in Cisco
TelePresence
Management Suite

Booking
confirmation
email message
in Cisco TMS

UCJ10.6Ph2S.TMS.G.004

NilPassedCisco TMS ->
Cisco VCS ->
Conductor -> Cisco
TS 7010 -> EX90
(Main Participant)
-> SX80 Codec ->
SX10 QuickSet
Cisco TMS ->
Cisco VCS ->
Conductor -> Cisco
TS 7010 -> EX90
(Main Participant)
-> SX10 QuickSet

Verify whether the
main participant
remains unchanged
in a conference
initiated by Smart
Scheduler after a
participant is
removed from the
conference in Cisco
TelePresence
Management Suite

No change in
Main
Participant
after removing
a participant
during
conference in
Cisco TMS

UCJ10.6Ph2S.TMS.G.005
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NilPassedCisco TMS ->
Conductor -> Cisco
TS 7010 -> Cisco
VCS -> EX90
(Main Participant)
-> SX80 Codec ->
SX10 QuickSet
Cisco TMS ->
Conductor -> Cisco
TS 7010 -> Cisco
VCS -> EX90
(Main Participant)
-> SX80 Codec ->
SX10 QuickSet ->
SX20 QuickSet

Verify whether the
main participant
remains unchanged
in a conference
initiated by Smart
Scheduler after a
participant is added
to the conference in
Cisco TelePresence
Management Suite

No change in
Main
Participant
after adding a
participant
during
conference in
Cisco TMS

UCJ10.6Ph2S.TMS.G.006

NilPassedNAVerify whether
warning message is
displayed after
adding a system
license of more than
5000 systems in
Cisco TelePresence
Management Suite

System
licenses limited
to 5000
systems

UCJ10.6Ph2S.TMS.G.007

NilPassedCisco TMS ->
Conductor -> Cisco
TS onVM ->Cisco
VCS -> EX90 ->
SX80 Codec ->
SX10Quickset (4th
participant should
be restricted)

Verify whether the
number of
participants is
restricted to 3 for a
scheduled conference
hosted by Cisco
TelePresence Server
on VM and managed
by Cisco
TelePresence
Conductor in Cisco
TelePresence
Management Suite

Restrict
number of
participants to
3 in a
scheduled
conference
hosted by
Cisco TS on
VM managed
by Conductor

UCJ10.6Ph2S.TMS.G.008
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NilPassedCisco TMS ->
Conductor ->MCU
4510 -> Cisco VCS
-> EX90 -> SX80
Codec -> SX10
Quickset (4th
participant should
be restricted)

Verify whether the
number of
participants is
restricted to 3 for a
scheduled conference
hosted by Cisco
TelePresence MCU
4510 and managed
by Cisco
TelePresence
Conductor in Cisco
TelePresence
Management Suite

Restrict
number of
participants to
3 in a
scheduled
conference
hosted by
MCU 4510
managed by
Conductor

UCJ10.6Ph2S.TMS.G.009

NilPassedNAVerify whether the
picture layout mode
can be set during
booking a conference
managed by Cisco
TelePresence
Conductor in Cisco
TelePresence
Management Suite

Picture Layout
Mode for a
conference
managed by
Conductor

UCJ10.6Ph2S.TMS.G.010

NilPassedCisco TMS ->
Conductor ->MCU
4510 -> Cisco VCS
-> EX90 -> SX80
Codec -> SX10
Quickset

Verify whether the
lock/unlock for a
conference hosted by
Cisco TelePresence
MCU 4510 and
managed by Cisco
TelePresence
Conductor is
available in
Conference Control
Center of Cisco
TelePresence
Management Suite

Lock/Unlock a
conference for
a conference
hosted by
MCU4510 and
managed by
Conductor in
Conference
Control Center

UCJ10.6Ph2S.TMS.G.011

NilPassedCisco TMS ->
Conductor ->MCU
4510 -> Cisco VCS
-> EX90

Verify whether the
meeting end
notification for
conferences hosted
by Cisco
TelePresence MCU
4510 and managed
by Cisco
TelePresence
Conductor are placed
on the top center of
the screen

Meeting end
notifications
for conferences
managed by
Conductor in
Cisco TMS

UCJ10.6Ph2S.TMS.G.012
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NilPassedNAVerify whether the
encryption option
key installed in Cisco
TelePresence
MX200-G2 is visible
in Cisco
TelePresence
Management Suite

Encryption
option key of
MX200-G2
visible in Cisco
TMS

UCJ10.6Ph2S.TMS.G.013

NilPassedNAVerify whether the
Premium Resolution
option key installed
in Cisco
TelePresence
MX200-G2 is visible
in Cisco
TelePresence
Management Suite

Premium
Resolution
option key of
MX200-G2
visible in Cisco
TMS

UCJ10.6Ph2S.TMS.G.014

NilPassedNAVerify whether guest
participant with a
guest pin can be
added to the
Collaboration
Meeting Room under
Cisco TelePresence
Management Suite
User Portal

Guest
Participant in
Collaboration
Meeting Room

UCJ10.6Ph2S.TMS.G.015

NilPassedNAVerify whether
chairperson
participant with a
chairperson pin can
be added to the
Collaboration
Meeting Room under
Cisco TelePresence
Management Suite
User Portal

Chairperson
Participant in
Collaboration
Meeting Room

UCJ10.6Ph2S.TMS.G.016

Cisco TelePresence Conductor
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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NilPassedNAVerify whether the
current user
password is
authorized before
changing the
administrator
password in Cisco
TelePresence
Management Suite

Authentication
when changing
administrator
password

UCJ10.6Ph2S.TC.G.001

NilPassedNAVerify whether the
current user
password is
authorized before
creating a new user
in Cisco
TelePresence
Management Suite

Authentication
when creating
new user

UCJ10.6Ph2S.TC.G.002

NilPassedNAVerify whether
TelePresence MCU
pool in a service
preference can be
marked for
scheduling in Cisco
TelePresence
Conductor

Mark
scheduling for
TelePresence
MCU pool in a
Service
Preference

UCJ10.6Ph2S.TC.G.003

NilPassedNAVerify whether
TelePresence Server
pool in a service
preference can be
marked for
scheduling in Cisco
TelePresence
Conductor

Mark
scheduling for
TelePresence
Server pool in a
Service
Preference

UCJ10.6Ph2S.TC.G.004

NilPassedNAVerify whether
MCU 4510 marked
for scheduling in the
TelePresence MCU
Service preference in
Cisco TelePresence
Conductor is used
for when scheduling
a conference in
Cisco TelePresence
Management Suite

Marked
scheduling
MCU 4510
Pool used for
scheduling in
Conductor

UCJ10.6Ph2S.TC.G.005
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NilPassedNAVerify whether
Cisco TelePresence
Server 7010 marked
for scheduling in the
TelePresence Server
Service preference in
Cisco TelePresence
Conductor is used
for when scheduling
a conference in
Cisco TelePresence
Management Suite

Marked
scheduling
Cisco TS 7010
Pool used for
scheduling in
Conductor

UCJ10.6Ph2S.TC.G.006

NilPassedNAVerify whether guest
participant details
added under Cisco
TelePresence
Management Suite
Provisioning
Extension is visible
under Status ->
Collaboration
Meeting Rooms in
Cisco TelePresence
Conductor

Guest
Participant
from
Collaboration
Meeting Room
displayed in
Conductor

UCJ10.6Ph2S.TC.G.007

NilPassedNAVerify whether
chairperson
participant details
added under Cisco
TelePresence
Management Suite
Provisioning
Extension is visible
under Status ->
Collaboration
Meeting Rooms in
Cisco TelePresence
Conductor

Chairperson
Participant
from
Collaboration
Meeting Room
displayed in
Conductor

UCJ10.6Ph2S.TC.G.008

NilPassedCisco TMSPE ->
Collaboration
Meeting Room ->
Conductor -> Cisco
TS 7010 -> EX90
(Host) -> SX10
QuickSet (guest)

Verify whether guest
can be specified to
wait till the host
joins the conference
in the Cisco
TelePresence
Conductor
Provisioning API
using Cisco
TelePresence Server
7010 as the
conference bridge

Guest to wait
for a host to
join the
conference

UCJ10.6Ph2S.TC.G.009
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NilPassedCisco TMSPE ->
Collaboration
Meeting Room ->
Conductor -> Cisco
TS 7010 -> SX10
QuickSet (guest) ->
EX90 (Host)

Verify whether guest
can be specified to
joins the conference
before the host does
in the Cisco
TelePresence
Conductor
Provisioning API
using Cisco
TelePresence Server
7010 as the
conference bridge

Guest to join
the conference
before the host
joins

UCJ10.6Ph2S.TC.G.010

NilPassedNAVerify whether the
menu path for IP
settings has been
changed to System
-> Network
Interfaces -> IP in
Cisco TelePresence
Conductor

Menu path for
IP settings in
Conductor

UCJ10.6Ph2S.TC.G.011

NilPassedNAVerify whether
multiple SIP trunk
destinations can be
added for
rendezvous
conference in Cisco
TelePresence
Conductor

Support for
multiple SIP
trunk
destinations

UCJ10.6Ph2S.TC.G.012

Cisco TelePresence Server
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID
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NilPassedMX200-G2,
MX300-G2
(Presentation
Sharing) & EX90 ->
Unified CM -> SIP
Trunk -> Cisco VCS
-> Cisco TS 7010

To verify that user
is able to do meet
me video
conference
between video
endpoints
registered with
Unified CM and
Share the
Presentationwhile
in Video
Conference using
Cisco
TelePresence
Server 7010
registered with
Cisco VCS as a
SIP Registrar

Meet me video
conference
between video
endpoints
registered with
Unified CM
and Share the
Presentation
while in Video
Conference

UCJ10.6PH2S.TS.G.001

NilPassedMX300-G2,
MX200-G2
(Presentation
Sharing) & SX80
Codec -> Cisco VCS
-> Cisco TS 7010

To verify that user
is able to do meet
me video
conference
between video
endpoints
registered with
Cisco VCS and
Share the
Presentationwhile
in Video
Conference using
Cisco
TelePresence
Server 7010
registered with
Cisco VCS as a
SIP Registrar

Meet me video
conference
between video
endpoints
registered with
CiscoVCS and
share the
presentation
while in video
conference

UCJ10.6PH2S.TS.G.002
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NilPassedSX10Quick Set (EM
user, Presentation
Sharing) -> Unified
CM -> SIP Trunk ->
Cisco TS 7010

To verify that user
is able to initiate
the meet me
conference from
SX10 Quick Set
registered with
Unified CMusing
EM enabled user
via Cisco
TelePresence
Server 7010 and
share the
presentationwhile
in video
conference

Initiate the
meet me
conference
from SX10
Quick Set
registered with
Unified CM
using EM
enabled user
via Cisco TS
7010 and share
the
presentation
while in video
conference

UCJ10.6PH2S.TS.G.003

NilPassedMX300-G2,
MX200-G2
(Presentation
Sharing) & SX80
Codec (H.323) ->
Cisco VCS -> Cisco
TS 7010

To verify that user
is able to initiate
themeetme video
conference
between
MX200-G2,
MX300-G2 &
SX80 Codec
registered with
Cisco VCS as a
H.323 endpoints
and sharing the
presentation

Initiate the
meet me video
conference
between video
endpoints
registered with
Cisco VCS as
a H.323
endpoint and
Share the
Presentation

UCJ10.6PH2S.TS.G.004

NilPassed8945 & SX80 Codec
(Presentation
Sharing) -> Unified
CM -> SIP Trunk ->
Cisco TS 7010
8945 -> Unified CM
-> DX80 ->
Park/Retrieve

To verify that user
is able to park the
meet me video
conference from
Cisco Unified IP
Phone 8945 and
retrieve the
conference in
DX80 Codec
while sharing the
presentation using
Cisco TS 7010

Park the meet
me video
conference
from 8945
registered with
Unified CM
and Retrieve
the conference
from DX80
Codec while
sharing the
presentation

UCJ10.6PH2S.TS.G.005
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NilPassed8945 & EX90
(Presentation
Sharing) -> Unified
CM -> SIP Trunk ->
Cisco TS 7010
8945 -> Unified CM
-> SX10 Quick Set
(EM user) ->
Park/Retrieve

To verify that user
is able to park the
meet me video
conference from
Cisco Unified IP
Phone 8945 and
retrieve it on EM
enabled SX10
Quick Set while
sharing the
presentation via
Cisco
TelePresence
Server 7010

Park the meet
me video
conference
from 8945
registered with
Unified CM
and Retrieve it
on EM enabled
SX10 Quick
Set while
sharing the
presentation

UCJ10.6PH2S.TS.G.006

NilPassedMX200-G2, SX10&
SX80 ->Unified CM
-> Conductor ->
Cisco TelePresence
Server on VM

To verify that user
is able to do meet
me conference
between
MX200-G2, SX10
Quick Set &
SX80 Codec and
check the exit
lobby screen
message after
disconnecting
conference

Make a meet
me conference
between
MX200-G2,
SX10 & SX80
Codec and
check the exit
lobby screen

UCJ10.6PH2S.TS.G.007

NilPassedMX200-G2, EX90&
SX20 Quick Set ->
Unified CM ->
Conductor -> Cisco
TelePresence Server
on VM

Verify that exit
lobby screen
message for
disconnect
participants via
web interface

Exit lobby
screen for
Disconnect via
Web Interface

UCJ10.6PH2S.TS.G.008

NilPassedCisco TMS ->
Conductor -> Cisco
TelePresence Server
on VM -> Unified
CM -> MX200-G2,
EX90&SX20Quick
Set

Verify that exit
lobby screen
message for
disconnect
scheduled
conference

Exit lobby
screen for
disconnect
scheduled
conference

UCJ10.6PH2S.TS.G.009

NilPassedNAVerify whether
nettap controls via
web interface of
Cisco
TelePresence
Server 7010
works fine

Nettap controls
via Web
interface of
Cisco TS 7010

UCJ10.6PH2S.TS.G.010
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NilPassedMX200-G2 ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

Verify the
enhanced on
screen message
background with
Cisco
TelePresence
Server 7010
during a meet me
conference call

Check the
on-screen
message
background

UCJ10.6PH2S.TS.G.011

NilPassedSX10 Quick Set,
8831 & 7961 ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

Verify that
displaying icon
for number of
off-screen
participants using
Cisco
TelePresence
Server 7010

Displaying
icon for
number of
off-screen
participants
using Cisco
TelePresence
Server 7010

UCJ10.6PH2S.TS.G.012

NilPassedSX10 Quick Set ->
Unified CM -> SIP
Trunk -> Cisco TS
7010

Verify that
displaying audio
avatar symbol for
audio conference
from SX10 Quick
Set using Cisco
TS 7010

Make an audio
conference
from SX10
Quick Set
using Cisco TS
7010

UCJ10.6PH2S.TS.G.013

Cisco Jabber Guest
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
MX300-G2

To Verify that
user is able to
make a video call
from Jabber guest
client on Android
to Cisco
TelePresence
MX300-G2 via
Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Android to
MX300-G2 via
Cisco
Expressway-E

UCJ10.6PH2S.JG.G.001
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NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX80

To Verify that
user is able to
make a video call
from Jabber guest
client on Android
to Cisco DX80
via Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Android toDX80
via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.002

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX70

To Verify that
user is able to
make a video call
from Jabber guest
client on Android
to Cisco DX70
via Cisco
Expressway-E

Make a video
call from Jabber
guest client on
Android toDX70
via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.003

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX80 (Presentation
Sharing)

To Verify that
user is able to
share Presentation
in video call
between Jabber
guest client on
Android and
Cisco DX80 via
Cisco
Expressway-E

Presentation
sharing in video
call between
Jabber guest
client onAndroid
and DX80 via
Cisco
Expressway-E

UCJ10.6PH2S.JG.G.004

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX70 (Presentation
Sharing)

To Verify that
user is able to
share Presentation
in video call
between Jabber
guest client on
Android and
Cisco DX70 via
Cisco
Expressway-E

Presentation
Sharing in video
call between
Jabber guest
client onAndroid
and DX70 via
Cisco
Expressway-E

UCJ10.6PH2S.JG.G.005

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX80

To Verify that
user is able to do
adhoc call from
Jabber guest
client on Android
to Cisco DX80
via Cisco
Expressway-E

Adhoc video call
link to DX80
from Cisco
Jabber Guest
Client on
Android

UCJ10.6PH2S.JG.G.006
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NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX70

To Verify that
user is able to do
adhoc call from
Jabber guest
client on Android
to Cisco DX70
via Cisco
Expressway-E

Adhoc video call
link to DX70
from Cisco
jabber Guest
Client on
Android

UCJ10.6PH2S.JG.G.007

NilPassedJabber guest client
(Android) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
DX80 -> Transfer ->
Unified CM ->DX70

To Verify that
user is able to
make a call from
Jabber guest
client on Android
to Cisco DX80
and transfer a call
to Cisco DX70
via Cisco
Expressway-E

Make a video
call from Jabber
Guest Client on
Android toDX80
and transfer
video call to
DX70

UCJ10.6PH2S.JG.G.008

NilPassedJabber guest client
(Android), DX70 &
DX80 -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
MCU 4510 -> Meet
Me conference

To Verify that
user is able to
make a meet me
conference call
from Jabber guest
client on Android,
DX70 & DX80
using Cisco
TelePresence
MCU 4510 via
Cisco
Expressway-E

Make a meet me
conference call
between Jabber
guest client on
Android, DX70
& DX80 using
MCU 4510 via
Cisco
Expressway-E

UCJ10.6PH2S.JG.G.009

NilPassedJabber guest client
(Android), DX80 &
SX10 Quick Set ->
Cisco Expressway-E
-> Cisco
Expressway-C ->
Unified CM ->MCU
5310 -> Meet Me
conference

To Verify that
user is able to
make a meet me
conference call
between Jabber
guest client on
Android, DX80&
SX10 Quick Set
using Cisco
TelePresence
MCU 5310 via
Cisco
Expressway-E

Make a meet me
conference call
between Jabber
guest client on
Android, DX80
& SX10 Quick
Set using MCU
5310 via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.010
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NilPassedJabber guest client
(Android), DX80 &
MX300-G2 -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
Cisco TS 7010 ->
Meet Me conference

To Verify that
user is able to
make a meet me
conference call
between Jabber
guest client on
Android, DX80&
MX300-G2 using
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Make a meet me
conference call
between Jabber
guest client on
Android, DX80
& MX300-G2
using Cisco TS
7010 via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.011

NilPassedJabber guest client
(Android),
DX70(Presentation
Sharing) & DX80 ->
Cisco Expressway-E
-> Cisco
Expressway-C ->
Unified CM ->MCU
4510 -> Meet Me
conference

To Verify that
user is able to
make a meet me
conference call
from Jabber guest
client on Android,
DX70 & DX80
using Cisco
TelePresence
MCU 4510 via
Cisco
Expressway-E

Presentation
Sharing while in
meet me
conference call
between Jabber
guest client on
Android, DX70
& DX80 using
MCU 4510 via
Cisco
Expressway-E

UCJ10.6PH2S.JG.G.012

NilPassedJabber guest client
(Android),
DX80(Presentation
Sharing) & SX10
Quick Set -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
MCU 5310

To Verify that
user is able to do
Presentation
Sharing while in
meet me
conference call
between Jabber
guest client on
Android, DX80&
SX10 Quick Set
using Cisco
TelePresence
MCU 5310 via
Cisco
Expressway-E

Presentation
Sharing while in
meet me
conference call
between Jabber
guest client on
Android, DX80
& SX10 Quick
Set using MCU
5310 via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.013
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NilPassedJabber guest client
(Android), DX80 &
MX300-G2
(Presentation
Sharing) -> Cisco
Expressway-E ->
Cisco Expressway-C
-> Unified CM ->
Cisco TS 7010

To Verify that
user is able to do
Presentation
Sharing while in
meet me
conference call
between Jabber
guest client on
Android, DX80&
MX300-G2 using
Cisco
TelePresence
Server 7010 via
Cisco
Expressway-E

Presentation
Sharing while in
meet me
conference call
between Jabber
guest client on
Android, DX80
& MX300-G2
using Cisco TS
7010 via Cisco
Expressway-E

UCJ10.6PH2S.JG.G.014

Cisco Collaboration Expressway
DefectsStatusCall Component

Flow
DescriptionTitleLogical ID

NilPassedEX60 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> Cisco
TelePresence
MX300-G2

Verify whether
video call from
Cisco TelePresence
System EX60
registered in
Unified CM via
Collaboration
EDGE to Cisco
TelePresence
MX300-G2 is
established
successfully and
checking SDP 183
message through
call trace

Making video
call from EX60
registered in
Unified CM via
Collaboration
EDGE to Cisco
TelePresence
MX300-G2 and
checking the
SDP 183
message
through call
trace

UCJ10.6PH2S.Edge.G.001
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NilPassedCisco TelePresence
EX60 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> Cisco
TelePresence
MX300-G2

Verify whether
video call from
Cisco TelePresence
System EX90
registered in
Unified CM via
Collaboration
EDGE to Cisco
TelePresence
MX300-G2 is
established
successfully and
checking SDP 183
message through
call trace

Making video
call from EX90
registered in
Unified CM via
Collaboration
EDGE to Cisco
TelePresence
MX300-G2 and
checking the
SDP 183
message
through call
trace

UCJ10.6PH2S.Edge.G.002

NilPassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified CM
-> EX60 ->
Presentation Sharing

Verify whether the
presentation
sharing from Cisco
TelePresence
SystemEX90 login
as Extension
Mobility user and
registered with
Cisco Unified
Communications
Manager via
collaboration
EDGE to Cisco
TelePresence
System EX60
works successfully

Presentation
sharing from
EX90 login as
EM user via
EDGE

UCJ10.6PH2S.Edge.G.003
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NilPassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
SX80 Codec ->
Presentation Sharing

Verify whether the
presentation
sharing from Cisco
TelePresence
System EX90
logged in as
ExtensionMobility
user and registered
with Cisco Unified
Communications
Manager cluster1
via Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster2
through SIP trunk
works successfully

Making
inter-cluster
video call and
sharing
presentation
from EX90
logged in as
EM user

UCJ10.6PH2S.Edge.G.004

NilPassedEX90 (EM user) ->
Cisco VCS
Expressway -> Cisco
VCS1 -> Unified
CM -> SIP Trunk ->
Cisco VCS2 ->
SX80 Codec

Verify whether the
video call from
Cisco TelePresence
System EX90
logged in as
ExtensionMobility
user via
Collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco
TelePresence
Video
Communication
Server works
successfully

Making video
call from EX90
login as EM
user via EDGE
to SX80 Codec
registered with
Cisco VCS

UCJ10.6PH2S.Edge.G.005
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NilPassedEX90 -> Cisco VCS
Expressway -> Cisco
VCS -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
SX80 Codec

Verify whether the
video call from
Cisco TelePresence
System EX90
registered with
Cisco Unified
Communications
Manager cluster1
via collaboration
EDGE to Cisco
TelePresence SX80
Codec registered
with Cisco Unified
Communications
Manager cluster2
through SIP trunk
works successfully

Making
inter-cluster
video call from
EX90 via
EDGE

UCJ10.6PH2S.Edge.G.006

Cisco IP Phone Validation

Cisco IP Phones
DefectsStatusCall Component

flow
DescriptionTitleLogical ID

NilPassedIP Phone A ->
Unified CM1 -> IP
Phone B

Verify that call
on 88XX series
IP Phone gets
attended
automatically
using Auto
Answer with
headset option
when headset is
connected to
88XX series IP
Phone

Answer the
call on 88XX
series IP
Phone using
Auto Answer
with Headset

UCJ10.6Ph2S.CUCM.G.001
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NilPassedIP Phone A ->
Unified CM1 -> IP
Phone B

Verify that call
on 88XX series
IP Phone gets
attend
automatically
using Auto
Answer with
Speaker phone
option when
Speaker phone
is ON in 88XX
series IP Phone

Answer the
call on 88XX
series IP
Phone using
Auto Answer
with Speaker
phone

UCJ10.6Ph2S.CUCM.G.002

NilPassedIP Phone A ->
Unified CM2 -> SIP
Trunk -> CUBE ->
SIP Trunk -> Unified
CM1 -> IP Phone B

Verify that call
on 88XX series
IP Phone
coming through
CUBE having
SIP Trunk with
Unified CM1
and SIP Trunk
with Unified
CM2 gets
attend
automatically
using Auto
Answer with
headset option
when headset is
connected to
88XX series IP
Phone

Answer the
inter-cluster
call on 88XX
series IP
Phone coming
through
CUBEhaving
SIP Trunk
with Unified
CM1 and SIP
Trunk with
Unified CM2
using Auto
Answer with
Headset
option

UCJ10.6Ph2S.CUCM.G.003
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NilPassedIP Phone A ->
Unified CM2 -> ICT
Trunk-> CUBE ->
ICT Trunk ->
Unified CM1 -> IP
Phone B

Verify that call
on 88XX series
IP Phone
coming through
CUBE having
ICT Trunk with
Unified CM1
and ICT Trunk
with Unified
CM2 gets
attend
automatically
using Auto
Answer with
headset option
when headset is
connected to
88XX series IP
Phone

Answer the
inter-cluster
call on 88XX
series IP
Phone coming
through
CUBEhaving
ICT Trunk
with Unified
CM1 and ICT
Trunk with
Unified CM2
using Auto
Answer with
Headset
option

UCJ10.6Ph2S.CUCM.G.006

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that calls
coming to
88XX series IP
Phone
forwarding
successfully to
destination
while using Call
Forward All
Feature

Forward the
calls coming
to 88XX
series IP
Phone using
Call Forward
All Feature

UCJ10.6Ph2S.CUCM.G.012

NilPassedIP Phone A -> IP
Phone B (9951) ->
Unified CM1 -> SIP
Trunk -> CUBE ->
SIP Trunk -> Unified
CM2 -> IP Phone C

Verify that calls
coming through
CUBE having
SIP Trunk with
Unified CM1
and SIP Trunk
with Unified
CM2 to 88XX
series IP Phone
forwarding
successfully to
destination
while using Call
Forward All
Feature

Forward the
inter-cluster
calls coming
through
CUBEhaving
SIP Trunk
with Unified
CM1 and SIP
Trunk with
Unified CM2
to 88XX
series IP
Phone using
Call Forward
All Feature

UCJ10.6Ph2S.CUCM.G.014
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NilPassedIP Phone A -> IP
Phone B (9951) ->
Unified CM1 -> ICT
Trunk -> CUBE ->
ICT Trunk ->
Unified CM2 -> IP
Phone C

Verify that calls
coming through
CUBE having
ICT Trunk with
Unified CM1
and ICT Trunk
with Unified
CM2 to 88XX
series IP Phone
forwarding
successfully to
destination
while using
Conditional
Call Forwarding
Feature

Forward the
calls coming
through
CUBEhaving
ICT Trunk
with Unified
CM1 and ICT
Trunk with
Unified CM2
to 88XX
series IP
Phone using
Conditional
Call
Forwarding
Feature

UCJ10.6Ph2S.CUCM.G.018

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that user
able to park an
active call on
88XX series IP
Phone and
retrieve the
parked call on
another IP
Phone
successfully

Park an active
call on 88XX
series IP
Phone

UCJ10.6Ph2S.CUCM.G.022

NilPassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> CUBE ->
SIP Trunk -> Unified
CM2 -> IP Phone B
-> Unified CM2 ->
IP Phone C

Verify that user
able to park an
inter cluster
active call
coming through
CUBE having
SIP Trunk with
Unified CM1
and SIP Trunk
with Unified
CM2 on 88XX
series IP Phone
and retrieve the
parked call on
another IP
Phone
successfully

Park an inter
cluster active
call coming
through
CUBEhaving
SIP Trunk
with Unified
CM1 and SIP
Trunk with
Unified CM2
on 88XX
series IP
Phone

UCJ10.6Ph2S.CUCM.G.023
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NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that user
able to Dpark
an active call on
88XX series IP
Phone and
retrieve the
parked call
using Feature
button
successfully on
another IP
Phone

Park an active
call on 88XX
series IP
Phone using
assisted
directed call
park

UCJ10.6Ph2S.CUCM.G.027

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that user
able to redial
the most
recently dialed
phone number
from 88XX
series IP Phone
and connection
established
successfully

Call the most
recently
dialed Phone
number from
88XX series
IP Phone
using Redial
button

UCJ10.6Ph2S.CUCM.G.054

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that user
able to attend
shared line call
in 88XX series
IP Phone
successfully

Attend shared
line call in
88XX series
IP Phone

UCJ10.6Ph2S.CUCM.G.059

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that user
can able to
make call from
88XX series IP
Phone to any
other IP Phone
using Speed
Dial Button

Place call
from 88XX
series IP
Phone using
Speed Dial
Button

UCJ10.6Ph2S.CUCM.G.060
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NilPassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> CUBE ->
SIP Trunk -> Unified
CM2 -> IP Phone B

Verify that user
able to make
call from 88XX
series IP Phone
to 9951 IP
Phone through
CUBE having
SIP Trunk with
Unified CM 1
and having SIP
Trunk with
Unified CM 2
using Speed
Dial Button

Place call
from 88XX
series IP
Phone using
Speed Dial
Button to
9951 IP
Phone
through
CUBEhaving
SIP Trunk
with Unified
CM 1 and
having SIP
Trunk with
Unified CM 2

UCJ10.6Ph2S.CUCM.G.061

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that user
able to transfer
the call from
88XX series IP
Phone to
another number
successfully

Transfer the
call from
88XX series
IP Phone to
another
number

UCJ10.6Ph2S.CUCM.G.070

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that user
able to swap the
calls available
in 88XX series
IP Phone

Swap the calls
coming to
88XX series
IP Phone

UCJ10.6Ph2S.CUCM.G.076

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that user
able to make
calls from
88XX series IP
Phone using
Web Dialer

Make call
from 88XX
series IP
Phone using
Web Dialer

UCJ10.6Ph2S.CUCM.G.077

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Allow a user to
add to a
remotely active
call on a shared
line, using the
built-in bridge
at the target
device

Single Button
cBarge from
an IP Phone
(88xx) to a
call originated
by the shared
line

UCJ10.6Ph2S.CUCM.G.083
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NilPassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> IP Phone B
-> Unified CM2 ->
Unity Connection

Verify that a
call is
redirected by
Immediate
Divert to a
voice-messaging
mail box that is
specified in the
voice-messaging
profile
associated with
the calling party

Inter-Unified
CM Call with
Immediate
Divert by
Calling Party

UCJ10.6Ph2S.CUCM.G.097

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that the
88xx IP Phone
handles the
DND feature in
a Cisco Unified
IP Phone
successfully.

Activate Do
Not Disturb
feature on an
IP
Phone(88xx)

UCJ10.6Ph2S.CUCM.G.099

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that the
88xx IP Phone
handles the
DND feature in
a Cisco Unified
IP Phone with
shared line IP
phones
successfully

Activate Do
Not Disturb
feature on a
shared line

UCJ10.6Ph2S.CUCM.G.101

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify the
ability to make
a basic IP-to-IP
call after
logging into the
Cisco Unified
Call Manager
Extension
Mobility

Basic IP-to-IP
Call
Functionality
after Logging
into Unified
Call Manager
Extension
Mobility

UCJ10.6Ph2S.CUCM.G.102

NilPassedNAVerifying the
user ID of a
logged in EM
user in call
manager
displaying
correct

Display of
EM user ID
correctly in
CUCM page

UCJ10.6Ph2S.CUCM.G.104
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NilPassedIP Phone C ->
Unified CM -> IP
Phone A -> Unified
CM -> IP Phone B

Verifying that
the IP Phone
(88xx) handles
the hold/resume
when in shared
line
successfully

Put a call on
hold when in
shared line
and resume
the call

UCJ10.6Ph2S.CUCM.G.110

NilPassedIP Phone A ->
Unified CM1 -> SIP
Trunk -> Unified
CM2 -> IP Phone B

To verify that
the IP Phones
handles the hold
reversion
inter-cluster
successfully in
set duration

Hold
reversion -
Inter cluster
calls using IP
Phones (88xx)
via SIP Trunk

UCJ10.6Ph2S.CUCM.G.112

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify that the
Cisco Unified
IP Phones
(88xx) handles
the line
indications
status
successfully
when in shared
line

Verify line
indication
status using
IP Phones
(88xx) when
in shared line

UCJ10.6Ph2S.CUCM.G.120

NilPassedIP Phone A ->
Unified CM ->
Meet-me number ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C ->
Unified CM -> IP
Phone D

Verify that the
Phone D (88xx
Phone) joins a
meet me
conference call
where PhoneA,
Phone B and
Phone C is
already in a
conference call

Call made
from 88xx
Phone to a
meet me
conference
number to
join a
conference

UCJ10.6Ph2S.CUCM.G.122

NilPassedNAVerify that the
Phone B (88xx
Phone) try to
joins a meet me
conference call
where the
conference host
has not yet
initiated the
conference call
and Phone B
hears a busy
tone

Call made
from 88xx
Phone to join
meet me
conference
and busy tone
heard

UCJ10.6Ph2S.CUCM.G.126
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NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that IP
Phone (88xx)
handles the
mute
successfully
when in shared
line

Call to shared
IP Phones
(88xx) and
Mute the call

UCJ10.6Ph2S.CUCM.G.135

NilPassedIP Phone A ->
Unified CM ->
Wireless IP Phone A
(792x)

To verify
whether both
88xx IP Phone
and 792x
Phones are
registered and
attempting a
call from 88xx
IP Phone to
792xG.

Make call
between IP
Phone A
(88xx) to
792xG Phone

UCJ10.6Ph2S.CUCM.G.141

NilPassediPhone Client (CJI)
-> Unified CM1 ->
SIP Trunk -> Unified
CM2 -> IP Phone A

Verify that
88xx IP Phone
handles call
with iPhone
Client

Make an
inter-cluster
call via SIP
Trunk from
an iPad Client
to 88xx IP
Phone

UCJ10.6Ph2S.CUCM.G.151

NilPassedAndroid Client
(CJA) -> Unified
CM1 -> SIP Trunk
-> Unified CM2 ->
IP Phone A

Verify that
88xx IP Phones
handles
inter-cluster call
via SIP Trunk
with Android
Client

Make an
inter-cluster
call via SIP
Trunk from
an Android
Client to 88xx
IP Phones

UCJ10.6Ph2S.CUCM.G.152

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify that the
park toast is
successful on
Cisco IP Phones
88xx while in
on-hook

Park toast on
Cisco IP
Phone 88xx
during
on-hook

UCJ10.6Ph2S.CUCM.G.153

NilPassedIP Phone A ->
Unified CM -> IP
Phone B (Line2) ->
Unified CM -> IP
Phone C (Line2)

Verify whether
the user can
able to park and
retrieve the call
from line2 of
Cisco IP Phone
88xx

Call Park and
Retrieval at
line2 of Cisco
IP Phone
88xx

UCJ10.6Ph2S.IPPhone.SR.001
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NilPassedIP Phone A ->
Unified CM -> IP
Phone B (Shared
Line) -> Unified CM
-> IP Phone C

Verify whether
the user can
able to park and
retrieve the call
from Cisco IP
Phone 88xx
when it is in
shared line with
the other IP
Phone

Call Park at
Cisco IP
Phone 88xx
when it is in
Shared Line

UCJ10.6Ph2S.IPPhone.SR.002

NilPassedIP Phone A ->
Unified CM -> IP
Phone B (Shared
Line) -> Unified CM
-> IP Phone C

Verify whether
the user can
able to view the
call history in
Cisco IP Phone
88xx after call
park at Cisco IP
Phone 88xx
when it is in
shared line

Check for call
history in
Cisco IP
Phone 88xx
after call park
when in
shared line

UCJ10.6Ph2S.IPPhone.SR.003

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify whether
the Directed
Call Park BLF
is configured
and monitored
in Cisco IP
Phone 88xx

Directed Call
Park BLF at
Cisco IP
Phone 88xx

UCJ10.6Ph2S.IPPhone.SR.011

NilPassedIP Phone A ->
Unified CM -> IP
Phone B -> Unified
CM -> IP Phone C

Verify whether
the label created
for Directed
Call Park BLF
is successfully
displayed in
Cisco IP Phone
88xx

New Label
for Directed
Call Park
BLF at Cisco
IP Phone
88xx

UCJ10.6Ph2S.IPPhone.SR.012

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify whether
the call history
shown on Cisco
IP Phone is
valid when call
is held at Cisco
IP Phone 88xx
when in shared
line

Check call
history in
Cisco IP
Phone 88xx
during hold
when in
shared line

UCJ10.6Ph2S.IPPhone.SR.016
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NilPassedIP Phone A ->
Unified CM -> IP
Phone B (Line1) ->
Unified CM -> IP
Phone B (Line2) ->
Unified CM -> IP
Phone D

Verify whether
the call history
shown on line1
of Cisco IP
Phone 88xx is
valid when call
on both the
lines are in held
state

Check call
history at
line1 of Cisco
IP Phone
88xx when
calls on both
the lines are
held

UCJ10.6Ph2S.IPPhone.SR.021

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify whether
the held call is
resumed in
Cisco IP Phone
88xx when in
shared line

Resume the
held call
using line
button when
Cisco IP
Phone 88xx is
in shared line

UCJ10.6Ph2S.IPPhone.SR.024

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify whether
the held call is
resumed in
Cisco IP Phone
88xx when in
shared line with
multiple phones

Resume the
held call
using line
button when
Cisco IP
Phone 88xx is
in shared line
with multiple
IP Phones

UCJ10.6Ph2S.IPPhone.SR.031

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify whether
the hold and
resume on line1
of Cisco IP
Phone 88xx is
successful when
in shared line

Hold and
resume the
shared line
call on Line1
of Cisco IP
Phone 88xx
via softkey

UCJ10.6Ph2S.IPPhone.SR.040

NilPassedIP Phone A ->
Unified CM -> IP
Phone B

Verify whether
the hold and
resume on
Cisco IP Phone
88xx is
successful when
it is configured
with multiple
lines

Hold and
resume the
call via soft
key when
Cisco IP
Phone 88xx is
configured
with multiple
lines

UCJ10.6Ph2S.IPPhone.SR.042
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NilPassedIP Phone C ->
Unified CM -> IP
Phone A (Shared
Line) -> IP Phone D

Verify that Call
Transfer is
successful from
one of the IP
Phone 88xx in
Shared Line to
other IP Phone
in non-shared
line

Verify Call
Transfer in
88xx when in
Shared Line

UCJ10.6Ph2S.IPPHONE.SR.103

NilPassedIP Phone C ->
Unified CM -> IP
Phone A (Shared
Line)
IP Phone D ->
Unified CM -> IP
Phone A -> Unified
CM -> IP Phone E

Verify that Call
Forward as
Busy enabled in
Shared Line
phones 88xx
and forwarding
the call to
specified
destination

Set Call
Forward as
Busy in 88xx
when in
Shared Line

UCJ10.6Ph2S.IPPHONE.SR.105

NilPassedIP Phone E ->
Unified CM -> IP
Phone A (Shared
Line)
IP Phone F ->
Unified CM -> IP
Phone A -> Unified
CM -> IP Phone C
(Shared Line)

Verify whether
the user is able
to set call
forward in 88xx
to other shared
line phones
when one of the
shared line
phones are busy

Set Call
Forward in
88xx to other
Shared Line
Phone when
Shared Line
Phones are
Busy

UCJ10.6Ph2S.IPPHONE.SR.106

NilPassedIP Phone C ->
Unified CM -> IP
Phone A (Shared
Line) -> Unity
Connection -> IP
Phone C

Verify whether
the user is able
to leave a
voicemail to
Phone3 (88xx)
when three
phones in a
shared line set
all call
forwarded to
voicemail

Leave a
voicemail to
Shared Line
phones when
Call Forward
All to
Voicemail set
in one of the
shared line
phones (88xx)

UCJ10.6Ph2S.IPPHONE.SR.108

NilPassedIP Phone C ->
Unified CM -> IP
Phone D -> IP Phone
A

Verify the
behavior when
two Shared
Line Phones
(88xx) are in
same Pick
Group and pick
up the call from
Shared Line
phone

Shared Line
Phones (88xx)
are in Pick
Group

UCJ10.6Ph2S.IPPHONE.SR.110
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NilPassedIP Phone C ->
Unified CM -> IP
Phone A (Shared
Line )
IP Phone D ->
Unified CM -> IP
Phone A (Shared
Line)

Verify the call
back
notification and
calls when
Shared Line
phones (88xx)
are busy and
call back when
available.

Call Back
when Shared
Line Phones
(88xx) are
busy

UCJ10.6Ph2S.IPPHONE.SR.113

NilPassedIP Phone C ->
Unified CM -> IP
Phone E -> Unified
CM -> IP Phone D
(Line 2)

Verify Transfer
the Call to
second line in
one of Shared
Line Phones
(88xx)

Transfer the
Call to second
line in one of
Shared Line
Phones (88xx)

UCJ10.6Ph2S.IPPHONE.SR.115

NilPassedIP Phone C ->
Unified CM -> IP
Phone A (Shared
Line)

Make call to
Shared Line
phone (88xx)
by using speed
dial

Initiate call to
Shared Line
phone (88xx)
by using
speed dial

UCJ10.6Ph2S.IPPHONE.SR.118

NilPassedReal IP Phone A ->
Unified CM ->
Shared Line DN (49
Virtual Phones +
Real IP Phone B)

Verify that the
Line Status on
Real IP Phone
is successful
when call made
to the Shared
LineDN, where
DN shared with
Virtual IP
Phones

Line Status on
Real IP Phone
when call
made to the
Shared Line
DN, where
DN shared
with Virtual
IP Phones

UCJ10.6Ph2S.Automation.G.001

NilPassedReal IP Phone A ->
Unified CM ->
Shared Line DN (49
Virtual Phones +
Real IP Phone B)

Verify that the
Line Status on
Real IP Phone
is successful
when call made
to the Shared
Line DN is
held, where DN
shared with
Virtual IP
Phones

Line Status on
Real IP Phone
when call is
held

UCJ10.6Ph2S.Automation.G.002
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CSCus84536Failed78xx IP Phone ->
Unified CM -> 88xx
IP Phone

Verify whether
the call forward
details are
displayed in
88xx phones
when a
forwarded call
is answered in
88x phones

Call Forward
details in
88xx phones

UCJ10.6Ph2S.CUCM.G.203

CSCus88792Failed78xx IP Phone ->
Unified CM -> 88xx
IP Phone -> Unified
CM -> 9951 IP
Phone

Verify whether
the call
conference toast
is displayed
correctly in
88xx IP Phones
when 88xx IP
Phone is in
conference

Conference
toast
messages in
88xx IP
Phones

UCJ10.6Ph2S.CUCM.G.204

CSCut22770FailedNAVerify the
Cisco Web
Dialer page
display in
Japanese
Environment
when making
call to IP
Phones using
Web Dialer

Cisco Web
Dialer strings
when making
call from IP
Phone using
Web Dialer

UCJ10.6Ph2S.CUCM.G.205

Cisco Prime Collaboration

Cisco Prime Collaboration Provisioning
DefectsStatusDescriptionTitleLogical ID

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to get the order
notification after enabling
the Extension Mobility
service in Service
Provisioning page

Order notification for
Extension Mobility
service in Service
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.001
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NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to add the User ID in
Japanese language in
User Provisioning page

Adding new User ID in
Japanese language in
User Provisioning page

UCJ10.6Ph2S.CPC-PR.G.002

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to see the correct number
of remaining User ID
after deleting existing
User ID in User
Provisioning page

Check the total number
of User ID after User ID
deletion in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.003

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to enter message in
Japanese language in user
note

Input the notes in
Japanese language and
check whether it is
retrieved

UCJ10.6Ph2S.CPC-PR.G.004

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to see the modified user
name after saving in
Self-Care

User name after
modifying and saving in
Self-Care

UCJ10.6Ph2S.CPC-PR.G.005

NilPassedGo to Deploy -> User
Provisioning and verify
whether user is able to
launch Self-Care option
by using quick view
anchor in User
Provisioning page

Launch Self-Care option
by using quick view
anchor in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.006

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to view the User ID is in
ascending order in User
Provisioning page

Check for the User ID is
in ascending order

UCJ10.6Ph2S.CPC-PR.G.007

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
see user role after
updating user role in
mange authorization role
option in Manage User
page

Check user role after
updating in Manage
User page

UCJ10.6Ph2S.CPC-PR.G.008
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NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to close the User ID by
using close icon in User
ID search box after
getting the search result

Searching User ID and
close User ID by using
close icon at User ID
box in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.009

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to select country by using
toggle picker button in
Additional Settings under
Add User page

Select country using
toggle picker button in
Additional Settings
under Add User page

UCJ10.6Ph2S.CPC-PR.G.010

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to Reset and Close
column option in User
Provisioning page

Reset and Close column
option in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.011

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to swap the User ID
menu to last name menu
and vice versa in User
Provisioning page

Swap the User ID menu
to last name menu in
User Provisioning page

UCJ10.6Ph2S.CPC-PR.G.012

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to get error notification
when alphabetic
characters are entered in
Pin Management under
User Settings

Error notification when
alphabetic characters are
entered in Pin
Management underUser
Settings

UCJ10.6Ph2S.CPC-PR.G.013

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to select service area by
using toggle picker
option

Select service area by
using toggle picker
option in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.014

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to select only one User
ID for new service in
User Provisioning page

Restriction of multiple
User ID in User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.015
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NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to swap the User ID
menu to startedmenu and
vice versa in User
Provisioning page

Swap the menu option
in bulk move status

UCJ10.6Ph2S.CPC-PR.G.016

NilPassedGo to Design > User
Provisioning Setup and
verify whether the user is
able to copy the existing
service area template in
User Provisioning page

Copying existing
Service Area templates

UCJ10.6Ph2S.CPC-PR.G.017

NilPassedGo to Deploy -> User
Provisioning and verify
whether the user is able
to get error notification
while entering non
numeric values in Index
box at Speed Dials option
under Phone Settings

Error notification while
entering non numeric
characters in Index box
at Phone Settings

UCJ10.6Ph2S.CPC-PR.G.018

NilPassedGo to Deploy -> Batch
Provisioning and verify
whether the user is able
to search an existing
Batch Project name in
Batch Provisioning page

Search an existing Batch
Project name in search
box

UCJ10.6Ph2S.CPC-PR.G.019

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
7911 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 7911
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.020
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NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
Analog Phone Endpoint
Type in Phone Button
Template Configuration
page and see the updated
Default Template in
Phone Button Template
Configuration page

Update Default
Template for Analog
Phone Endpoint Type in
Phone Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.021

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
Cisco Jabber for Android
Phone Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for Cisco
Jabber for Android
Phone Endpoint Type in
Phone Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.022

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
Cisco Jabber for iPhone
Phone Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for Cisco
Jabber for iPhone Phone
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.023
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NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
Cisco Jabber for Desktop
Endpoint Type in Phone
Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for Cisco
Jabber for Desktop
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.024

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
8841 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 8841
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.025

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
8831 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 8831
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.026
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NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
9951 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 9951
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.027

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
8861 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 8861
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.028

NilPassedGo to Administration ->
System Configuration ->
Phone Button Templates
and verify whether the
user is able to update the
Default Template for
6941 Endpoint Type in
Phone Button Template
Configuration page and
see the updated Default
Template in Phone
Button Template
Configuration page

Update Default
Template for 6941
Endpoint Type in Phone
Button Template
Configuration page

UCJ10.6Ph2S.CPC-PR.G.029
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NilPassedGo to Administration ->
Users and Device Access
Management ->
Infrastructure
Configuration
Permissions and verify
whether the user is able
to update Permission
Profile Configuration and
see the updated
Permission Profile in
Infrastructure
Configuration
Permissions page

Update Permission
Profile Configuration
after adding in
Infrastructure
Configuration
Permissions page

UCJ10.6Ph2S.CPC-PR.G.030

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set
Application logging level
as high for Unified CM
and browse the logs to
view the required
information

Set Unified CM
Application Logging
level as high and browse
the logs

UCJ10.6Ph2S.CPC-PR.G.031

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set
Application logging level
as Normal for Unified
CM and browse the logs
to view the required
information

Set Unified CM
Application Logging
level as Normal and
browse the logs

UCJ10.6Ph2S.CPC-PR.G.032

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set
Application logging level
as Detail for Unified CM
and browse the logs to
view the required
information

Set Unified CM
Application Logging
level as Detail and
browse the logs

UCJ10.6Ph2S.CPC-PR.G.033
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NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set
Application logging level
as high for Unity
Connection and browse
the logs to view the
required information

Set Unity Connection
Application Logging
level as high and browse
the logs

UCJ10.6Ph2S.CPC-PR.G.034

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set
Application logging level
as Normal for Unified
CM IM & Presence and
browse the logs to view
the required information

Set Unified CM IM and
Presence Application
Logging level as
Normal and browse the
logs

UCJ10.6Ph2S.CPC-PR.G.035

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set NICE
logging level as high for
Unified CM and browse
the logs to view the
required information

Set Unified CM NICE
Logging level as high
and browse the logs

UCJ10.6Ph2S.CPC-PR.G.036

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set NICE
logging level as Normal
for Unified CM and
browse the logs to view
the required information

Set Unified CM NICE
Logging level as
Normal and browse the
logs

UCJ10.6Ph2S.CPC-PR.G.037

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set NICE
logging level as Detail for
Unified CM and browse
the logs to view the
required information

Set Unified CM NICE
Logging level as Detail
and browse the logs

UCJ10.6Ph2S.CPC-PR.G.038

   Test Results for Cisco Unified Communications System Release 10.6 Phase II for Japan
108

Test Results Summary
Cisco Prime Collaboration Provisioning



NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set NICE
logging level as Normal
for Unity Connection and
browse the logs to view
the required information

Set Unity Connection
NICE Logging level as
Normal and browse the
logs

UCJ10.6Ph2S.CPC-PR.G.039

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to set NICE
logging level as High for
Unified CM IM &
Presence and browse the
logs to view the required
information

Set Unified CM IM and
PresenceNICELogging
level as High and
browse the logs

UCJ10.6Ph2S.CPC-PR.G.040

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Apache
Logs for Unified CM
application successfully

Browse and check
Apache Logs for
Unified CM

UCJ10.6Ph2S.CPC-PR.G.041

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Postgres
Logs for Unified CM
application successfully

Browse and check
Postgres Logs for
Unified CM

UCJ10.6Ph2S.CPC-PR.G.042

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Apache
Logs for Unity
Connection application
successfully

Browse and check
Apache Logs for Unity
Connection

UCJ10.6Ph2S.CPC-PR.G.043
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NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Postgres
Logs for Unity
Connection application
successfully

Browse and check
Postgres Logs for Unity
Connection

UCJ10.6Ph2S.CPC-PR.G.044

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Apache
Logs for Unified CM IM
and Presence application
successfully

Browse and check
Apache Logs for
Unified CM IM and
Presence

UCJ10.6Ph2S.CPC-PR.G.045

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to browse and
check the associated
information in Postgres
Logs for Unified CM IM
and Presence application
successfully

Browse and check
Postgres Logs for
Unified CM IM and
Presence

UCJ10.6Ph2S.CPC-PR.G.046

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Deployment Information
through Logging and
ShowTech page by
selecting the Range

Generate and download
logs for Deployment
Information by selecting
Duration

UCJ10.6Ph2S.CPC-PR.G.047
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NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Order through Logging
and ShowTech page by
selecting the Range

Generate and download
logs for Order by
selecting Duration

UCJ10.6Ph2S.CPC-PR.G.048

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Service Action through
Logging and ShowTech
page by selecting the
Range

Generate and download
logs for Service Action
by selecting Duration

UCJ10.6Ph2S.CPC-PR.G.049

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
System through Logging
and ShowTech page by
selecting the Range

Generate and download
logs for System by
selecting Duration

UCJ10.6Ph2S.CPC-PR.G.050

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Deployment Information
through Logging and
ShowTech page by
selecting the Range as
number of days

Generate and download
logs for Deployment
Information by selecting
Duration as number of
days

UCJ10.6Ph2S.CPC-PR.G.051
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NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Order through Logging
and ShowTech page by
selecting the Range as
number of days

Generate and download
logs for Order by
selecting Duration as
number of days

UCJ10.6Ph2S.CPC-PR.G.052

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
Service Action through
Logging and ShowTech
page by selecting the
Range as number of days

Generate and download
logs for Service Action
by selecting Duration as
number of days

UCJ10.6Ph2S.CPC-PR.G.053

NilPassedGo to Administration ->
System Maintenance ->
Logging and ShowTech
and verify whether the
user is able to generate
and download logs for
System through Logging
and ShowTech page by
selecting the Range as
number of days

Generate and download
logs for System by
selecting Duration as
number of days

UCJ10.6Ph2S.CPC-PR.G.054

NilPassedGo to Administration ->
System Maintenance ->
Updates and verify
whether the user is able
to add updated SSL
Certificate for Cisco
Prime Collaboration
Provisioning through
Application Software
Updates page

Add updated SSL
Certificate for CPC
Provisioning

UCJ10.6Ph2S.CPC-PR.G.055
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NilPassedGo to Design -> Getting
StartedWizard and verify
whether the user is able
to add and sync all the
users created in LDAP
using Getting Started
Wizard through Cisco
Prime Collaboration
Provisioning

Add and sync users
from LDAP using
Getting Started Wizard
through CPC
Provisioning

UCJ10.6Ph2S.CPC-PR.G.056

NilPassedGo to Design -> Getting
StartedWizard and verify
whether the user enables
auto provisioning
services to particular Role
using Getting Started
Wizard and users created
using the specified role
are getting the Auto
Provisioned Services as
default

Enable Auto
Provisioning Services to
particular Role using
Getting Started Wizard

UCJ10.6Ph2S.CPC-PR.G.057

NilPassedGo to Design ->
Infrastructure Setup and
verify whether the user is
able to add Cisco
TelePresence
Management Suite(TMS)
using Infrastructure Setup
through Cisco Prime
Collaboration
Provisioning

Add TelePresence
Management
Suite(TMS) using
Infrastructure Setup
through CPC
Provisioning

UCJ10.6Ph2S.CPC-PR.G.058

NilPassedGo to Design ->
Infrastructure Setup and
verify whether the user is
able to cross launch and
view the information
about Cisco TelePresence
Management Suite(TMS)
using Infrastructure
Configuration through
Cisco Prime
Collaboration
Provisioning

Cross launch
TelePresence
Management
Suite(TMS) using
Infrastructure
Configuration through
CPC Provisioning

UCJ10.6Ph2S.CPC-PR.G.059
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NilPassedGo to Design ->
Infrastructure Setup and
verify whether the user is
able to add Generic IOS
Router using
Infrastructure Setup
successfully through
Cisco Prime
Collaboration
Provisioning

Add Generic IOS
Router using
Infrastructure Setup
through CPC
Provisioning

UCJ10.6Ph2S.CPC-PR.G.060

NilPassedGo to Design ->
Infrastructure Setup and
verify whether the user is
able to add Directory
Server(LDAP) using
Infrastructure Setup and
check users are imported
from LDAP to Cisco
Prime Collaboration
Provisioning after added
successfully

Add Directory
Server(LDAP) using
Infrastructure Setup
through CPC
Provisioning

UCJ10.6Ph2S.CPC-PR.G.061

NilPassedOn the Home page verify
that user is able to click
view Advanced Features
link and view the details
through Getting Started
Wizard

View Advanced
Features list from
Getting Started Wizard

UCJ10.6Ph2S.CPC-PR.G.062

NilPassedOn the Home verify that
user is able to click view
Advanced Features link
and view the details
through Getting Started
Wizard using Japanese
Environment

View Advanced
Features list from
Getting Started Wizard
using Japanese
Environment

UCJ10.6Ph2S.CPC-PR.G.063

NilPassedOn the Home page verify
that user is able to add
License to Cisco Prime
Collaboration
Provisioning through
Getting Started Wizard
successfully

Add License to CPC
Provisioning through
Getting Started Wizard

UCJ10.6Ph2S.CPC-PR.G.064
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NilPassedGo to Deploy -> User
Provisioning and verify
that user is able to view
appropriate errormessage
indication while selecting
invalid file format for
import users option under
User Provisioning page

Error Message
indication while
selecting invalid file
format for import users
through User
Provisioning page

UCJ10.6Ph2S.CPC-PR.G.065

NilPassedGo to Deploy -> User
Provisioning and verify
that end user is able to
view the appropriate error
message indication while
creating English User ID
with special characters
through User
Provisioning page

Error message
indication while create
English User ID with
special characters

UCJ10.6Ph2S.CPC-PR.G.066

NilPassedGo to Deploy -> User
Provisioning and verify
that end user is able to
view the appropriate error
message indication while
creating JapaneseUser ID
with special characters
through User
Provisioning page

Error message
indication while create
Japanese User ID with
special characters

UCJ10.6Ph2S.CPC-PR.G.067

Cisco Prime Collaboration Assurance
DefectsStatusDescriptionTitleLogical ID

NilPassedGo to Operate -> Device
Work Center and verify
whether user is able to view
all the associated VMs of
ESX Server using the
Maximized 360 view of ESX
Server

Checking all the
available VMs under
ESX Server using
Maximized 360 view

UCJ10.6Ph2S.CPC-AS.G.001

NilPassedGo to Operate -> Device
Work Center and verify
whether user is able to view
the remaining VMs after
deleting a VM and
rediscovering the ESXServer
using the Maximized 360
view of ESX Server

Remaining VMs
under ESX Server
after deleting a VM

UCJ10.6Ph2S.CPC-AS.G.002
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NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
launch the 360 view from the
OpsView page under Service
Availability for different
device groups

Launching 360 view
from the OpsView
page under Service
Availability for
different device
groups

UCJ10.6Ph2S.CPC-AS.G.003

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
cross launch Associated
Phones of CME group
members from 360 view

Cross launching
Associated Phones of
CME group members
from 360 view under
OpsView

UCJ10.6Ph2S.CPC-AS.G.004

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
cross launch Connectivity
Details page of CUC group
members from 360 view

Cross launching
Connectivity Details
page of CUC group
members from 360
view under OpsView

UCJ10.6Ph2S.CPC-AS.G.005

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
view
InsufficientFreeHardDisk
Alarm on 360 view of ESX
Server

InsufficientFreeHardDisk
Alarm on 360 view of
ESX Server under
OpsView page

UCJ10.6Ph2S.CPC-AS.G.006

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
launch the Maximized 360
view from OpsView page
under Service Availability for
different device groups

LaunchingMaximized
360 view from the
OpsView page under
Service Availability
for different device
groups

UCJ10.6Ph2S.CPC-AS.G.007

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
launch Alarms from the
OpsView page under Service
Availability for different
device groups

Launching Alarms
from the OpsView
page under Service
Availability for
different device
groups

UCJ10.6Ph2S.CPC-AS.G.008

NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
ping different devices using
Maximized 360 view
launched from Service
Availability

Pinging devices using
Maximized 360 view
launched from
Availability Summary

UCJ10.6Ph2S.CPC-AS.G.009
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NilPassedGo to Home -> OpsView ->
Availability Summary and
verify whether user is able to
get the Trace Route for
different devices from their
Maximized 360 view page
launched from Service
Availability

Trace Route for
different devices from
Maximized 360 view
from Service
Availability

UCJ10.6Ph2S.CPC-AS.G.010

NilPassedGo to Home -> OpsView and
verify whether user is able to
cross launch the cluster view
of the cluster under the
OpsView on Home Page

Cross launch to the
cluster view of the
cluster on Home Page

UCJ10.6Ph2S.CPC-AS.G.011

NilPassedGo to Home -> OpsView and
verify whether user is able to
see the Topology of that
cluster after cross launching
the cluster view by clicking
the Topology tab

Checking Topology of
a cluster after cross
launching cluster view

UCJ10.6Ph2S.CPC-AS.G.012

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the view as Fit to Screen
after selecting the Fit to
Screen option in Circular
Layout

Fit to Screen option
on the Topology View
page in Circular
Layout

UCJ10.6Ph2S.CPC-AS.G.013

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the actual size of the
Topology View after
selecting the Actual Size
option in Circular Layout

Actual size of the
Topology View page
in Circular Layout

UCJ10.6Ph2S.CPC-AS.G.014

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom in the Topology View
after selecting the Zoom In
option in Circular Layout

Checking the Zoom In
option on the
Topology View page
in Circular Layout

UCJ10.6Ph2S.CPC-AS.G.015

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom out the Topology View
after selecting the Zoom Out
option in Circular Layout

Checking the Zoom
Out option on the
Topology View page
in Circular Layout

UCJ10.6Ph2S.CPC-AS.G.016
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NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the view as Fit to Screen
after selecting the Fit to
Screen option in Hierarchic
Layout

Fit to Screen option
on the Topology View
page in Hierarchic
Layout

UCJ10.6Ph2S.CPC-AS.G.017

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the actual size of the
Topology View after
selecting the Actual Size
option in Hierarchic Layout

Actual size of the
Topology View page
in Hierarchic Layout

UCJ10.6Ph2S.CPC-AS.G.018

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom in the Topology View
after selecting the Zoom In
option in Hierarchic Layout

Checking the Zoom In
option on the
Topology View page
in Hierarchic Layout

UCJ10.6Ph2S.CPC-AS.G.019

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom out the Topology View
after selecting the Zoom Out
option in Hierarchic Layout

Checking the Zoom
Out option on the
Topology View page
in Hierarchic Layout

UCJ10.6Ph2S.CPC-AS.G.020

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the view as Fit to Screen
after selecting the Fit to
Screen option in Distributed
Layout

Fit to Screen option
on the Topology View
page in Distributed
Layout

UCJ10.6Ph2S.CPC-AS.G.021

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
get the actual size of the
Topology View after
selecting the Actual Size
option in Distributed Layout

Actual size of the
Topology View page
in Distributed Layout

UCJ10.6Ph2S.CPC-AS.G.022

NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom in the Topology View
after selecting the Zoom In
option in Distributed Layout

Checking the Zoom In
option on the
Topology View page
in Distributed Layout

UCJ10.6Ph2S.CPC-AS.G.023
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NilPassedGo to Home -> OpsView ->
Cluster -> Topology and
verify whether user is able to
zoom out the Topology View
after selecting the Zoom Out
option in Distributed Layout

Checking the Zoom
Out option on the
Topology View page
in Distributed Layout

UCJ10.6Ph2S.CPC-AS.G.024

NilPassedGo to Home -> OpsView and
verify whether user is able to
see the Cisco Unified
Communications Manager's
cluster available on the Home
Page under the OpsView

Unified CM cluster's
availability on the
Home Page

UCJ10.6Ph2S.CPC-AS.G.025

NilPassedGo to Home -> OpsView and
verify whether user is able to
see the Cisco TelePresence
Video Communication
Server's cluster available on
the Home Page under the
OpsView

Cisco TelePresence
Video
Communication
Server cluster's
availability on the
Home Page

UCJ10.6Ph2S.CPC-AS.G.026

NilPassedGo to Home -> OpsView ->
Cluster and verify whether
user is able to see the
topology of Cisco Unified
Communications Manager
from the Topology tab

View the topology of
Unified CM's cluster

UCJ10.6Ph2S.CPC-AS.G.027

NilPassedGo to Home -> OpsView ->
Cluster and verify whether
user is able to see the
topology of Cisco
TelePresence Video
Communication Server from
the Topology tab

View the topology of
Cisco TelePresence
Video
Communication
Server's cluster

UCJ10.6Ph2S.CPC-AS.G.028

NilPassedGo to Home -> OpsView ->
Cluster -> Endpoint by
Device Pool and verify
whether user is able to view
the summary of phones in the
cluster at the device pool
level

View the summary of
phones in the cluster
at the device pool
level from the
Endpoint by Device
Pool tab

UCJ10.6Ph2S.CPC-AS.G.029

NilPassedGo to Home -> OpsView ->
Cluster -> Device Search and
verify whether user is able to
search registered phones
using Search Criteria

Searching registered
phones under Device
Search tab

UCJ10.6Ph2S.CPC-AS.G.030
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NilPassedGo to Home -> OpsView ->
Cluster -> Device Search and
verify whether user is able to
search unregistered phones
using Search Criteria

Searching
unregistered phones
under Device Search
tab

UCJ10.6Ph2S.CPC-AS.G.031

NilPassedGo to Home -> OpsView ->
Cluster -> Device Search and
verify whether user is able to
search Rejected phones using
Search Criteria

Searching Rejected
phones under Device
Search tab

UCJ10.6Ph2S.CPC-AS.G.032

NilPassedGo to Home -> OpsView ->
Cluster -> Device Search and
verify whether user is able to
search Any Status(Except
Unknown) phones using
Search Criteria

Searching Any
Status(Except
Unknown) phones
under Device Search
tab

UCJ10.6Ph2S.CPC-AS.G.033

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the Trunk
Group dashlet is available

Trunk Group dashlet's
availability under
Utilization Monitor

UCJ10.6Ph2S.CPC-AS.G.034

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the Route
Group Utilization dashlet is
available

Route Group
Utilization dashlet's
availability under
Utilization Monitor

UCJ10.6Ph2S.CPC-AS.G.035

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the Trunk
Group Utilization dashlet is
available

Trunk Group
Utilization dashlet's
availability under
Utilization Monitor

UCJ10.6Ph2S.CPC-AS.G.036

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the
Location CAC Bandwidth
Utilization dashlet is
available

Location CAC
BandwidthUtilization
dashlet's availability
under Utilization
Monitor

UCJ10.6Ph2S.CPC-AS.G.037

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the
TelePresence Endpoint
dashlet is available

TelePresence
Endpoint dashlet's
availability under
Utilization Monitor

UCJ10.6Ph2S.CPC-AS.G.038

NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the
ConferencingDevices dashlet
is available

ConferencingDevices
dashlet's availability
under Utilization
Monitor

UCJ10.6Ph2S.CPC-AS.G.039
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NilPassedGo to Operate -> Utilization
Monitor and verify whether
user is able to see the License
Usage dashlet is available

License Usages
dashlet's availability
under Utilization
Monitor

UCJ10.6Ph2S.CPC-AS.G.040

Cisco Prime Collaboration Analytics
DefectsStatusDescriptionTitleLogical ID

NilPassedGo to Analyze -> Capacity
Analysis -> Location CAC
Bandwidth Utilization and verify
whether user can see the 100%
Utilization under Location CAC
Bandwidth Utilization dashlet

Checking Location
CAC Bandwidth
Utilization dashlet
for 100% Utilization

UCJ10.6Ph2S.CPC-AN.G.001

NilPassedGo to Analyze -> Capacity
Analysis -> Location CAC
Bandwidth Utilization and verify
whether user can see Last 28
Days data under Location CAC
Bandwidth Utilization dashlet

Filtering Location
CAC Bandwidth
Utilization dashlet
for Last 28 Days

UCJ10.6Ph2S.CPC-AN.G.002

NilPassedGo to Analyze -> Service
Experience -> Top NCallers and
verify whether user can see Last
24 Weeks data under Top N
Callers dashlet

Checking Top N
Callers dashlet for
Last 24 Weeks

UCJ10.6Ph2S.CPC-AN.G.003

NilPassedGo to Analyze -> Service
Experience -> Top NCallers and
verify whether user is able to
check the incoming calls details
in Top N Callers

Incoming calls
details in Top N
Callers

UCJ10.6Ph2S.CPC-AN.G.004

NilPassedGo to Analyze -> Service
Experience -> Top NCallers and
verify whether user is able to
check the outgoing calls details
in Top N Callers

Outgoing call details
in Top N Callers

UCJ10.6Ph2S.CPC-AN.G.005

NilPassedGo to Analyze -> Service
Experience -> Top NCallers and
verify whether user is able to get
the Audio only calls details in
Top N Callers

Audio only calls
details in Top N
Callers

UCJ10.6Ph2S.CPC-AN.G.006
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NilPassedGo to Analyze -> Service
Experience -> Top NCallers and
verify whether user is able to get
the Video calls details in Top N
Callers

Video calls details in
Top N Callers

UCJ10.6Ph2S.CPC-AN.G.007

NilPassedGo to Analyze -> Capacity
Analysis -> Location CAC
Bandwidth Utilization and verify
whether user can see green color
indicator in Location CAC
Bandwidth Utilization dashlet if
the Utilization is between 1-50%

Checking for green
color indicator in
Location CAC
Bandwidth
Utilization dashlet
for the utilization
between 1-50%

UCJ10.6Ph2S.CPC-AN.G.008

NilPassedGo to Analyze -> Capacity
Analysis -> Location CAC
Bandwidth Utilization and verify
whether user can see orange
color indicator in Location CAC
Bandwidth Utilization dashlet if
the Utilization is between
51-80%

Checking for orange
color indicator in
Location CAC
Bandwidth
Utilization dashlet
for the utilization
between 51-80%

UCJ10.6Ph2S.CPC-AN.G.009

NilPassedGo to Analyze -> Capacity
Analysis -> Location CAC
Bandwidth Utilization and verify
whether user can see red color
indicator in Location CAC
Bandwidth Utilization dashlet if
the Utilization is between
81-100%

Checking for red
color indicator in
Location CAC
Bandwidth
Utilization dashlet
for the utilization
between 81-100%

UCJ10.6Ph2S.CPC-AN.G.010

NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations and verify whether
user is able to check the
incoming call details in Top N
Call Failure Locations

Incoming calls
details in Top N Call
Failure Locations

UCJ10.6Ph2S.CPC-AN.G.011

NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations and verify whether
user is able to check the outgoing
call details in Top N Call Failure
Locations

Outgoing call details
in Top N Call
Failure Locations

UCJ10.6Ph2S.CPC-AN.G.012

NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations and verify whether
user is able to get the Audio only
calls details in Top N Call
Failure Locations

Audio only calls
details in Top N Call
Failure Locations

UCJ10.6Ph2S.CPC-AN.G.013
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NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations and verify whether
user is able to get the video calls
details in Top N Call Failure
Locations

Video calls details in
Top N Call Failure
Locations

UCJ10.6Ph2S.CPC-AN.G.014

NilPassedGo to Analyze -> Capacity
Analysis and verify whether user
is able to verify Global filter by
Cluster and Duration

Verification of
Global filter by
Cluster and Duration

UCJ10.6Ph2S.CPC-AN.G.015

NilPassedGo to Analyze -> Capacity
Analysis -> Conferencing
Devices Video Utilization and
verify whether user can see green
color indicator in Location CAC
Bandwidth Utilization dashlet if
the Utilization is between 1-50%

Checking for green
color indicator in
Conferencing
Devices Video
Utilization dashlet
for the utilization
between 1-50%

UCJ10.6Ph2S.CPC-AN.G.016

NilPassedGo to Analyze -> Capacity
Analysis -> Conferencing
Devices Video Utilization and
verify whether user can see
orange color indicator in
Conferencing Devices Video
Utilization dashlet if the
Utilization is between 51-80%

Checking for orange
color indicator in
Conferencing
Devices Video
Utilization dashlet
for the utilization
between 51-80%

UCJ10.6Ph2S.CPC-AN.G.017

NilPassedGo to Analyze -> Capacity
Analysis -> Conferencing
Devices Video Utilization and
verify whether user can see red
color indicator in Location CAC
Bandwidth Utilization dashlet if
the Utilization is between
81-100%

Checking for red
color indicator in
Conferencing
Devices Video
Utilization dashlet
for the utilization
between 81-100%

UCJ10.6Ph2S.CPC-AN.G.018

NilPassedGo to Analyze -> Traffic
Analysis -> Top N Callers and
verify whether user is able to
check the endpoint details in Top
N Callers dashlet

Endpoint details in
Top N callers dashlet

UCJ10.6Ph2S.CPC-AN.G.019

NilPassedGo to Analyze -> Technology
Adoption ->Deployment
Distribution and verify whether
user is able to check the
Deployment Distribution dashlet
Graph mode data and Chart
mode data is equal

Comparison of
Deployment
Distribution UI Pie
and Grid value

UCJ10.6Ph2S.CPC-AN.G.020
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NilPassedGo to Analyze -> Traffic
Analysis -> Top N Callers and
verify whether user is able to
check the user details in Top N
Callers dashlet

User details in Top
N callers dashlet

UCJ10.6Ph2S.CPC-AN.G.021

NilPassedGo to Analyze -> Technology
Adoption -> Call distribution by
Endpoint Model and verify
whether user is able to check the
Completed Call details in Call
distribution by Endpoint model

Completed call
details in Call
distribution by
Endpoint Model

UCJ10.6Ph2S.CPC-AN.G.022

NilPassedGo to Analyze -> Technology
Adoption -> Deployment
distribution by Endpoint model
and verify whether user is able
to check the data labels to be
displayed in the chart

Display of Data
Labels in the chart in
Deployment
distribution by
Endpoint model

UCJ10.6Ph2S.CPC-AN.G.023

NilPassedGo to Analyze -> Technology
Adoption -> Deployment
distribution by Endpoint model
-> Detail view and verify
whether user is able to check the
Deployment distribution by
Endpoint model

Detail view of
Deployment
distribution by
Endpoint Model
dashlet

UCJ10.6Ph2S.CPC-AN.G.024

NilPassedGo to Analyze -> Technology
Adoption -> Call distribution
endpoint type and verify whether
user is able to click all pie chart
slices and finally click see details
link to validate buttons

Pie chart slices in
Call Distribution
Endpoint Type

UCJ10.6Ph2S.CPC-AN.G.025

NilPassedGo to Analyze -> Asset Usage
-> Least Used Endpoint Types
and verify whether user is able
to filter the data based on No
Calls

Least Used
Endpoints based on
No Calls

UCJ10.6Ph2S.CPC-AN.G.026

NilPassedGo to Analyze -> Asset Usage
-> Least Used Endpoint Types
-> Select Last 56 Weeks, No
More than 3 Calls per week and
verify whether user is able to
filter the data based on No More
than 3 Calls per week

Least Used
Endpoints based on
No More than 3
Calls per week

UCJ10.6Ph2S.CPC-AN.G.027
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NilPassedGo to Analyze -> Asset Usage
-> Least Used Endpoint Types
-> Select Last 1 week and No
Calls and verify whether user is
able to filter the data based on
Last 1 week

Least Used
Endpoints based on
Last 1 Week

UCJ10.6Ph2S.CPC-AN.G.028

NilPassedGo to Analyze -> Service
Experience -> Service
ExperienceDistribution -> Select
Last 13 Months, Video, Graded
calls and verify whether user is
able to filter the graded video
calls

Graded video calls in
Last 13 Months

UCJ10.6Ph2S.CPC-AN.G.029

NilPassedGo to Analyze -> Service
Experience -> Service
ExperienceDistribution -> Select
Last 12 Weeks, audio only,
Graded calls and verify whether
user is able to filter the graded
audio only calls

Graded Audio only
calls in Last 12
Weeks

UCJ10.6Ph2S.CPC-AN.G.030

NilPassedGo to Analyze -> Service
Experience -> Users with service
quality issue -> Select Last 4
Weeks, video, percentage and
verify whether user is able to
filter the percentage of Users
with service quality issues in
video

Percentage of Users
with service quality
issues in video

UCJ10.6Ph2S.CPC-AN.G.031

NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations -> Select Last 14
Weeks, All Call Types,
Outgoing, Absolute and verify
whether user is able to filter the
Outgoing call failures in Top N
Call failure locations

Filtering Outgoing
call failures in Top N
Call failure locations

UCJ10.6Ph2S.CPC-AN.G.032

NilPassedGo to Analyze -> Service
Experience -> TopNCall Failure
Locations -> Select Last 14
Weeks, All Call Types,
Incoming, Absolute and verify
whether user is able to filter the
Incoming call failures in Top N
Call failure locations

Filtering Incoming
call failures in Top N
Call failure locations

UCJ10.6Ph2S.CPC-AN.G.033
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NilPassedGo to Analyze -> Service
Experience -> Users with service
quality issues -> Select Last 2
Weeks, Video, Absolutes and
verify whether user is able to
filter the Users with service
quality issues on Video calls

Users with service
quality issues on
Video calls

UCJ10.6Ph2S.CPC-AN.G.034

NilPassedGo to Analyze -> CustomReport
Generator -> Open an existing
report & edit and verify whether
user is able to check the
functionality of editing Custom
Reports

Functionality of Edit
Custom Report in
Custom Report
Generator

UCJ10.6Ph2S.CPC-AN.G.035

NilPassedGo to Analyze -> Technology
Adoption and verifywhether user
is able to get the pie chart after
selecting Chart Mode

Chart icon
verification in
Deployment
Distribution by
Endpoint Model

UCJ10.6Ph2S.CPC-AN.G.036

NilPassedGo to Analyze -> Capacity
Analysis -> Trunk Utilization ->
Edit option and verify whether
user is able to edit the title of
Trunk Utilization Dashlet

Validation of Edit
option in Trunk
Utilization

UCJ10.6Ph2S.CPC-AN.G.037

NilPassedGo to Analyze -> Service
Experience -> Users with service
quality issues -> Select Last 2
Weeks, Audio only, Absolutes
and verify whether user is able
to filter the Users with service
quality issues on Audio only
calls

Users with service
quality issues on
Audio only calls

UCJ10.6Ph2S.CPC-AN.G.038

NilPassedGo to Analyze -> Traffic
Analysis -> Call Traffic Analysis
-> Select Last 24 Weeks, Video,
Call duration, Absolute and
whether user is able to filter the
Call Traffic Analysis

Filtering the Call
duration of video
calls for Last 24
Weeks in Call
Traffic Analysis

UCJ10.6Ph2S.CPC-AN.G.039

CSCus70556FailedGo to Analyze -> Asset Usage
-> Least Used Endpoint Types
-> SeeDetails and verify whether
user is able to filter the data in
detail view in Least Used
Endpoint Type

Generating data in
detail view of Least
Used Endpoint Type

UCJ10.6Ph2S.CPC-AN.G.040
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Cisco Unified Communication System Upgrade / Migration Test

Upgrade Paths
CUP(Upgrade)CUC(Upgrade)CUCM(Upgrade)8.5(1)

8.5.1.10000-35(MCS)8.5.1.12900-7 (MCS)8.5.1.10000-26(MCS)Base Release

JP-8.5.1.1000-1JP-8.5.1.1-65JP-8.5.1.1000-1Locale

8.5.4.10000-16(MCS)--Interim Release

JP-8.5.2.1000-1--Locale

8.5.4.10000-16(UCS)8.5.1.12900-7(UCS)8.5.1.10000-26(UCS)Interim Release

JP-8.5.2.1000-1JP-8.5.1.1-65JP-8.5.1.1000-1Locale

10.5.2.10000-9 (UCS)10.5.2.10000-5 (UCS)10.5.2.10000-5 (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(Upgrade)8.6(1)

8.6.1.10000-34(MCS)8.6.1.10000-43(MCS)8.6.1.10000-43(MCS)Base Release

JP-8.6.1.1000-1JP-8.5.1.1-92JP-8.6.1.1000-1Locale

8.6.3.10000-20(MCS)--Interim Release

JP-8.6.3.1000-1--Locale

8.6.3.10000-20(UCS)8.6.1.10000-43(UCS)8.6.1.10000-43(UCS)Interim Release

JP-8.6.3.1000-1JP-8.5.1.1-92JP-8.6.1.1000-1Locale

10.5.2.10000-9 (UCS)10.5.2.10000-5 (UCS)10.5.2.10000-5 (UCS)Target Release

CUP(Upgrade)CUC(Upgrade)CUCM(Upgrade)8.6(2)

8.6.2.10000-44(MCS)8.6.2.10000-30(MCS)8.6.2.10000-30(MCS)Base Release

JP-8.6.1.1000-1JP-8.6.2.4-113JP-8.6.2.1000-1Locale

8.6.3.10000-20(MCS)--Interim Release

JP-8.6.3.1000-1--Locale

8.6.3.10000-20(MCS)8.6.2.10000-30(MCS)8.6.2.10000-30(MCS)Interim Release

JP-8.6.3.1000-1JP-8.6.2.4-113JP-8.6.2.1000-1Locale

10.5.2.10000-9 (UCS)10.5.2.10000-5 (UCS)10.5.2.10000-5 (UCS)Target Release
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Download Links for COP File:

CUCM/CUC COP File :

https://software.cisco.com/download/
release.html?mdfid=282822890&flowid=45937&softwareid=282204704&release=COP-Files&relind=AVAILABLE&rellifecycle=&reltype=latest

CUP COP File :

https://software.cisco.com/download/
release.html?mdfid=286269517&flowid=50462&softwareid=282074312&release=RECOVERY&relind=AVAILABLE&rellifecycle=&reltype=latest

COP-File installation Procedure:

The COP-File installation steps as follows.

• Put the COP file on an FTP or SFTP server that the server that you are upgrading can access.

• Log in to Cisco Unified Communications Operating System Administration.

• Navigate to Software Upgrades > Install/Upgrade. The Software Installation/Upgrade window displays.

• From the Source list, choose Remote File system.

• In the Directory field, enter the path to the directory that contains the patch file on the remote system.
If the upgrade file is located on a Linux or Unix server, you must enter a forward slash (/) at the beginning
of the directory path. For example, if the upgrade file is in the patches directory, you must enter /patches
. If the upgrade file is located on a Windows server, remember that you are connecting to an FTP or
SFTP server, so use the appropriate syntax. Begin the path with a forward slash and use forward slashes
throughout the path. The path must start from the FTP or SFTP root directory on the server, so you
cannot enter a Windows absolute path, which starts with a drive letter (for example, C:).

• In the Server field, enter the server name or IP address.

• In the User Name field, enter the user name on the remote server.

• In the User Password field, enter the password on the remote server.

• Select the transfer protocol from the Transfer Protocol field.

• To use the Email Notification feature, enter your Email Destination and SMTP Server in the fields
provided.

• To continue the upgrade process, click Next.

• Choose the upgrade version that you want to install and click Next.

• In the next window, monitor the progress of the download.

• If you want to install the upgrade and automatically reboot to the upgraded software, choose Switch to
new version after upgrade. The system restarts and runs the upgraded software.

• If you want to install the upgrade and then manually switch to the upgraded software at a later time,
choose Do not switch to new version after upgrade. Click Next.

• When the installation completes, click Finish (not applicable for Refresh Upgrades).

• To restart the system and activate the upgrade, choose Settings > Version then click Switch Version.
The system restarts running the upgraded software (not applicable for Refresh Upgrades).
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Upgrade 8.5.1 to 10.5.2
L2 Upgrade 8.5.1 to 10.5.2

Target Release setMigration Release
Set

Intermediate
Release Set 1

Base ReleaseProduct/Component

10.5.2.10000-58.5.1.10000-26(UCS)NIL8.5.1.10000-26(MCS)CUCM

JP-10.5.2.1000-1JP-8.5.1.1000-1NILJP-8.5.1.1000-1CUCM Locale

10.5.2.10000-58.5.1.12900-7
(UCS)

NIL8.5.1.12900-7
(MCS)

CUC

JP-10.5.2.1-1JP-8.5.1.1-65NILJP-8.5.1.1-65CUC Locale

10.5.2.10000-98.5.4.10000-16(UCS)8.5.4.10000-16(MCS)8.5.1.10000-35(MCS)CUP

JP-10.5.2.1000-1JP-8.5.2.1000-1JP-8.5.2.1000-1JP-8.5.1.1000-1CUP locale

10.5.18.58.54.0(2)SRST

15.4(3)M115.1.3T15.1.3T12.4(15)T4Voice Gateway IOS

NIL7.0(6)7.0(6)2.1(4)IP Communicator

NIL8.5(6)8.5(6)1.2(4)Unified Personal
Communicator

10.6NILNILNILJabber for Mac

10.6NILNILNILJabber for iPhone

10.6NILNILNILJabber for iPad

10.6NILNILNILJabber for Android

10.6NILNILNILJabber forWindows

Note: Before Upgrading CUCM/CUC from 8.5.1 to 10.5.2, we need to install the COP files
(ciscocm.refresh_upgrade_v1.5.cop.sgn, ciscocm.version3-keys.cop.sgn ).

Before upgrading CUP from 8.5.4 to 10.5.2, We need to install the COP files
(cisco.com.cup.refresh_upgrade_v1.01.cop, ciscocm.version3-keys.cop.sgn)

*Cop File Download links and Procedure for Installation is given below the Upgrade Paths Table

DefectsStatusDescripitonTitleLogical ID

PassedVerify whether Installation of
Unified CM 8.5(1) Publisher on
MCS successfully

Installation of Unified
CM 8.5(1) Publisher on
MCS

UC1052S.UPGRADE.L2.001

PassedVerify whether Installation of
Unified CM 8.5(1) Subscriber on
MCS successfully

Installation of Unified
CM 8.5(1) Subscriber
on MCS.

UC1052S.UPGRADE.L2.002
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PassedVerify whether Installation of
Cisco Unity connection 8.5(1)
Publisher on MCS successfully

Installation of Cisco
Unity connection 8.5(1)
Publisher on MCS

UC1052S.UPGRADE.L2.003

PassedVerify whether Installation of
Cisco Unity connection 8.5(1)
Subscriber on MCS successfully

Installation of Cisco
Unity connection 8.5(1)
Subscriber on MCS

UC1052S.UPGRADE.L2.004

PassedVerify whether Installation of
Cisco Unified presence 8.5(1)
Publisher on MCS successfully

Installation of Cisco
Unified presence 8.5(1)
Publisher on MCS

UC1052S.UPGRADE.L2.005

PassedVerify whether Installation of
Cisco Unified presence 8.5(1)
Subscriber on MCS successfully

Installation of Cisco
Unified presence 8.5(1)
Subscriber on MCS

UC1052S.UPGRADE.L2.006

PassedVerify the Japanese locale
installed into Unified CM
Publisher successfully.

Install Japanese locale
into Unified CM 8.5(1)
Publisher

UC1052S.UPGRADE.L2.007

PassedVerify the Japanese locale
installed into Unified CM
subscriber successfully.

Install Japanese locale
into Unified CM 8.5(1)
subscriber

UC1052S.UPGRADE.L2.008

PassedVerify the Japanese locale
installed successfully into Cisco
Unity connection 8.5(1) Publisher

Install Japanese locale
into Cisco Unity
connection 8.5(1)
Publisher

UC1052S.UPGRADE.L2.009

PassedVerify the Japanese locale
installed successfully into Cisco
Unified Presence 8.5(1) Publisher

Install Japanese locale
into Cisco Unified
Presence 8.5(1)
Publisher

UC1052S.UPGRADE.L2.011

PassedVerify whether license is applied
on the Unified CM
8.5(1)successfully

Apply license on the
Unified CM 8.5(1)

UC1052S.UPGRADE.L2.013

PassedVerify whether Cisco Unity
Connection 8.5(1) Integration
with Unified CM 8.5(1)
successfully.

Integrate the Cisco
Unity Connection 8.5(1)
with Unified CM 8.5(1)

UC1052S.UPGRADE.L2.016

PassedVerify whether Cisco Unified
Presence 8.5(1) Integration with
Unified CM 8.5(1) successfully.

Integrate the Cisco
Unified Presence 8.5(1)
with Unified CM 8.5(1)

UC1052S.UPGRADE.L2.017

PassedVerify whether the Unified CM
integrating with Active Directory
successfully.

Integrate the Unified
CM with Active
Directory

UC1052S.UPGRADE.L2.018

PassedVerify whether end users can be
created in the unified CM 8.5(1)
successfully

Create end user in the
Unified CM 8.5(1)

UC1052S.UPGRADE.L2.019
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PassedVerify whether SIP Trunk can be
created in the Unified CM 8.5(1)
successfully.

Create SIP Trunk to
Interop site in the
Unified CM 8.5(1)
Publisher

UC1052S.UPGRADE.L2.021

PassedVerify whether MGCP Gateway
can be register in the Unified CM
from 8.5(1) Publisher successfully

Register the MGCP
Gateway in the Unified
CM 8.5(1) Publisher

UC1052S.UPGRADE.L2.024

PassedVerify whether the SRST fallback
is working properly in Unified
CM 8.5(1) once the WAN outage
happens successfully.

SRST fallback should
work properly once the
WAN outage happens.

UC1052S.UPGRADE.L2.025

PassedVerify whether Personal
Directory Service in the Unified
CM 8.5(1) successfully.

Personal Directory
Service in the Unified
CM 8.5(1)

UC1052S.UPGRADE.L2.029

PassedVerify whether voicemail should
work properly in the Cisco Unity
connection 8.5(1) successfully.

Voicemail should work
properly in the Cisco
Unity connection 8.5(1)

UC1052S.UPGRADE.L2.032

PassedVerify whether backup could be
restore in Unified CM 8.5(1)
Publisher on UCS successfully

Restore the backup of
Unified CM 8.5(1)
Publisher on UCS

UC1052S.UPGRADE.L2.056

PassedVerify whether could be restore
in cisco unity connection 8.5(1)
Publisher as well as subscriber
successfully

Restore backup in the
cisco unity connection
8.5(1) Publisher as well
as subscriber

UC1052S.UPGRADE.L2.057

PassedVerify whether the CUCM
Publisher upgrade on UCS
successfully

Upgrade CUCM
Publisher from 8.5(1)
version to 10.5(2) on
UCS

UC1052S.UPGRADE.L2.059

PassedVerify the Gateway Registration
after the Upgrade the Unified CM
from 8.5(1)to 10.5(2) successfully

MGCP Gateway
Registration status after
Upgrade has been done.

UC1052S.UPGRADE.L2.079

PassedVerify whether SIP Trunk
Creation should be replicated in
theUnified CMUpgrade has been
done successfully.

SIP Trunk Creation
should be replicated in
the Unified CM
Upgrade has been done

UC1052S.UPGRADE.L2.080

Upgrade 8.6.1 to 10.5.2
Upgrade 8.6.2 to 10.5.2

Target Release setMigration Release
Set

Intermediate
Release Set 1

Base ReleaseProduct/Component

Test Results for Cisco Unified Communications System Release 10.6 Phase II for Japan    
131

Test Results Summary
Upgrade 8.6.1 to 10.5.2



10.5.2.10000-58.6.1.10000-43(UCS)Nil8.6.1.10000-43(MCS)CUCM

JP-10.5.2.1000-1JP-8.6.1.1000-1NilJP-8.6.1.1000-1CUCM Locale

10.5.2.10000-58.6.1.10000-43(UCS)Nil8.6.1.10000-43(MCS)CUC

JP-10.5.2.1-1JP-8.5.1.1-92NilJP-8.5.1.1-92CUC Locale

10.5.2.10000-98.6.3.10000-20(UCS)8.6.3.10000-20(MCS)8.6.1.10000-34(MCS)CUP

JP-10.5.2.1000-1JP-8.6.3.1000-1JP-8.6.3.1000-1JP-8.6.1.1000-1CUP Locale

10.5.18.68.6SRST

15.4(3)M115.1(4)M115.1(4)M115.1(4)M1Voice Gateway IOS

8.6(1)8.6(1)8.6(1)IP Communicator

8.5(1)/Windows,
7.1(2)/Mac

Personal
Communicator

10.68.1.58.1.58.1.5Jabber for Mac

10.6NILNILNILJabber for iPhone

10.6NILNILNILJabber for iPad

10.6NILNILNILJabber for Android

10.6NILNILNILJabber forWindows

Note: Before upgrading CUCM/CUC from 8.6.1 to 10.5.2, We need to install the COP file
(ciscocm.version3-keys.cop.sgn)

Before upgradingCUP from 8.6.3 to 10.5.2, We need to install the COP file (ciscocm.version3-keys.cop.sgn)

*Cop File Download links and Installation Procedure is given below the Upgrade Paths Table

Defect IDStatusDescriptionTitleLogical ID

PassedVerify whether
Installation of Unified
CM 8.6(1) Publisher on
MCS successfully

Installation of Unified CM
8.6(1) Publisher on MCS

UC1052S.UPGRADE.L2.091

PassedVerify whether
Installation of Unified
CM 8.6(1) Subscriber
on MCS successfully

Installation of Unified CM
8.6(1) Subscriber on MCS

UC1052S.UPGRADE.L2.092

PassedVerify whether
Installation of Cisco
Unity connection 8.6(1)
Publisher on MCS
successfully

Installation of Cisco Unity
connection 8.6(1) Publisher
on MCS

UC1052S.UPGRADE.L2.093
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PassedVerify whether
Installation of Cisco
Unity connection 8.6(1)
Subscriber on MCS
successfully

Installation of Cisco Unity
connection 8.6(1)
Subscriber on MCS

UC1052S.UPGRADE.L2.094

PassedVerify whether
Installation of Cisco
Unified presence 8.6(1)
Publisher on MCS
successfully

Installation of Cisco
Unified presence 8.6(1)
Publisher on MCS

UC1052S.UPGRADE.L2.095

PassedVerify whether
Installation of Cisco
Unified presence 8.6(1)
Subscriber on MCS
successfully

Installation of Cisco
Unified presence 8.6(1)
Subscriber on MCS

UC1052S.UPGRADE.L2.096

PassedVerify the Japanese
locale installed into
Unified CM Publisher
successfully.

Install Japanese locale into
Unified CM 8.6(1)
Publisher

UC1052S.UPGRADE.L2.097

PassedVerify the Japanese
locale installed
successfully into Cisco
Unity connection 8.6(1)
Publisher

Install Japanese locale into
Cisco Unity connection
8.6(1) Publisher

UC1052S.UPGRADE.L2.099

PassedVerify whether license
is applied on the Unified
CM 8.6(1)successfully

Apply license on the
Unified CM 8.6(1)

UC1052S.UPGRADE.L2.103

PassedVerify whether Cisco
Unified Presence 8.6(1)
Integration with Unified
CM 8.6(1) successfully

Integrate the Cisco Unified
Presence 8.6(1) with
Unified CM 8.6(1)

UC1052S.UPGRADE.L2.107

PassedVerify whether the
Unified CM integrating
with Active Directory
successfully

Integrate the Unified CM
with Active Directory

UC1052S.UPGRADE.L2.106

PassedVerify whether ICT
Trunk can be created in
the Unified CM 8.6(1)
successfully

Create ICT Trunk to
Interop site in the Unified
CM 8.6(1) Publisher

UC1052S.UPGRADE.L2.112

PassedVerify whether the
SRST fallback is
working properly in
Unified CM 8.6(1) once
the WAN outage
happens successfully.

SRST fallback should work
properly once the WAN
outage happens.

UC1052S.UPGRADE.L2.115
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PassedVerify whether basic
call can be made
between the IP Phones
in the unified CM 8.6(1)

Basic call can be made in
the unified CM 8.6(1)

UC1052S.UPGRADE.L2.116

PassedVerify whether
interoperability call can
be made in the Unified
CM successfully.

Make an interoperability
call in the Unified CM
8.6(1)

UC1052S.UPGRADE.L2.118

PassedVerify whether Personal
Directory Service in the
Unified CM 8.6(1)
successfully.

Personal Directory Service
in the Unified CM 8.6(1)

UC1052S.UPGRADE.L2.119

PassedVerify that Alerting
name display in called
party when call made to
an Alerting name
configured IP Phone

Alerting name display in
called party when call made
to an Alerting name
configured IP Phone

UC1052S.UPGRADE.L2.121

PassedVerify whether backup
can be taken from the
Unified CMviaDisaster
recovery System
successfully

Backup should be taken
from theUnified CM8.6(1)
Publisher

UC1052S.UPGRADE.L2.125

PassedVerify whether
Installation of Unified
CM 8.6(1) Publisher on
UCS successfully

Installation of Unified CM
8.6(1) Publisher on UCS

UC1052S.UPGRADE.L2.131

PassedVerify the Japanese
locale installed into
Unified CM Publisher
successfully

Install Japanese locale into
Unified CM 8.6(1)
Publisher

UC1052S.UPGRADE.L2.137

PassedVerify whether backup
could be restore in
Unified CM 8.6(1)
Publisher on UCS
successfully

Restore the backup of
Unified CM 8.6(1)
Publisher on UCS

UC1052S.UPGRADE.L2.147

PassedVerify whether could be
restore in cisco unity
connection 8.6(1)
Publisher as well as
subscriber successfully

Restore backup in the cisco
unity connection 8.6(1)
Publisher as well as
subscriber

UC1052S.UPGRADE.L2.148

PassedVerify whether the
CUCM Publisher
upgrade on UCS
successfully

Upgrade CUCM Publisher
from 8.6(1) version to
10.5(2) on UCS

UC1052S.UPGRADE.L2.150
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PassedVerify whether the CUC
Publisher upgrade on
UCS successfully

Upgrade CUC Publisher
from 8.6(1) version to
10.5(2) on UCS

UC1052S.UPGRADE.L2.152

PassedVerify the Japanese
locale installed
successfully into Cisco
Unified Presence
10.5(2) Publisher

Install Japanese locale into
Cisco Unified Presence
10.5(2) Publisher

UC1052S.UPGRADE.L2.160

PassedVerify whether Cisco
Unified Presence
Integration with Unified
CM after the Upgrade
has been done
successfully

Check the Cisco Unified
Presence Integration with
Unified CM after the
Upgrade has been done.

UC1052S.UPGRADE.L2.166

PassedVerify whether LDAP
synchronized user
should be in the Unified
CM after the Upgrade
has been done
successfully

LDAP synchronized user
should be in the Unified
CM after the Upgrade has
been done.

UC1052S.UPGRADE.L2.167

PassedVerify whether SIP
Trunk Creation should
be replicated in the
Unified CM Upgrade
has been done
successfully

SIP Trunk Creation should
be replicated in the Unified
CMUpgrade has been done

UC1052S.UPGRADE.L2.171

PassedVerify whether Voice
mail should work after
upgrade the Cisco Unity
connection from 8.6(1)
to 10.5(2) successfully

Voice mail should work
after upgrade the Cisco
Unity connection from
8.6(1) to 10.5(2)

UC1052S.UPGRADE.L2.176

Upgrade 8.6.2 to 10.5.2
Upgrade 8.6.2 to 10.5.2

Target Release setMigration Release
Set

Intermediate
Release Set 1

Base ReleaseProduct/Component

10.5.2.10000-58.6.2.10000-30(UCS)Nil8.6.2.10000-30(MCS)CUCM

JP-10.5.2.1000-1JP-8.6.2.1000-1NilJP-8.6.2.1000-1CUCM Locale

10.5.2.10000-58.6.2.10000-30(UCS)Nil8.6.2.10000-30(MCS)CUC

JP-10.5.2.1-1JP-8.6.2.4-113NilJP-8.6.2.4-113CUC Locale
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10.5.2.10000-98.6.3.10000-20(UCS)8.6.3.10000-20(MCS)8.6.2.10000-44(MCS)CUP

JP-10.5.2.1000-1JP-8.6.3.1000-1JP-8.6.3.1000-1JP-8.6.1.1000-1CUP Locale

10.5.18.68.6SRST

15.4(3)M115.1(4)M115.1(4)M115.1(4)M1Voice Gateway IOS

8.6(1)8.6(1)8.6(1)IP Communicator

8.5(1)/Windows,
7.1(2)/Mac

Personal
Communicator

10.68.1.58.1.58.1.5Jabber for Mac

10.6NILNILNILJabber for iPhone

10.6NILNILNILJabber for iPad

10.6NILNILNILJabber for Android

10.6NILNilNilJabber forWindows

Note: Before upgrading CUCM/CUC from 8.6.2 to 10.5.2, We need to install the COP file
(ciscocm.version3-keys.cop.sgn)

Before upgradingCUP from 8.6.3 to 10.5.2, We need to install the COP file (ciscocm.version3-keys.cop.sgn)

*Cop File Download links and Installation Procedure is given below the Upgrade Paths Table

Defect IDStatusDescriptionTitleLogical ID

PassedVerify whether Installation
of Unified CM 8.6(2)
Publisher on MCS
successfully

Installation of Unified
CM 8.6(2) Publisher on
MCS

UC1052S.UPGRADE.L2.182

PassedVerify whether Installation
of Unified CM 8.6(2)
Subscriber on MCS
successfully

Installation of Unified
CM8.6(2) Subscriber on
MCS.

UC1052S.UPGRADE.L2.183

PassedVerify whether Installation
of Cisco Unity connection
8.6(2) Publisher on MCS
successfully

Installation of Cisco
Unity connection 8.6(2)
Publisher on MCS

UC1052S.UPGRADE.L2.184

PassedVerify whether Installation
of Cisco Unity connection
8.6(2) Subscriber on MCS
successfully

Installation of Cisco
Unity connection 8.6(2)
Subscriber on MCS

UC1052S.UPGRADE.L2.185

PassedVerify whether Installation
of Cisco Unified presence
8.6(2) Publisher on MCS
successfully

Installation of Cisco
Unified presence 8.6(2)
Publisher on MCS

UC1052S.UPGRADE.L2.186
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PassedVerify whether Installation
of Cisco Unified presence
8.6(2) Subscriber on MCS
successfully

Installation of Cisco
Unified presence 8.6(2)
Subscriber on MCS

UC1052S.UPGRADE.L2.187

PassedVerify the Japanese locale
installed successfully into
Cisco Unified Presence
8.6(2) Publisher

Install Japanese locale
into Cisco Unified
Presence 8.6(2)
Publisher

UC1052S.UPGRADE.L2.191

PassedVerify whether license is
applied on the Cisco Unified
presence 8.6(2) successfully

Apply license on the
Cisco Unified presence
8.6(2)

UC1052S.UPGRADE.L2.195

PassedVerify whether Cisco Unity
Connection 8.6(2) Integration
with Unified CM 8.6(2)
successfully

Integrate the CiscoUnity
Connection 8.6(2) with
Unified CM 8.6(2)

UC1052S.UPGRADE.L2.196

PassedVerify whether end users can
be created in the unified CM
8.6(2) successfully

Create end user in the
Unified CM 8.6(2)

UC1052S.UPGRADE.L2.199

PassedVerify whether SCCP/SIP IP
Phones can be registeredwith
Unified CM 8.6(2)

IP Phones should be
registered with Unified
CM 8.6(2)

UC1052S.UPGRADE.L2.200

PassedVerify whether MGCP
Gateway can be register in
the Unified CM from 8.6(2)
Publisher successfully

Register the MGCP
Gateway in the Unified
CM 8.6(2) Publisher

UC1052S.UPGRADE.L2.204

PassedVerify whether the SRST
fallback is working properly
in Unified CM 8.6(2) once
the WAN outage happens
successfully.

SRST fallback should
work properly once the
WAN outage happens.

UC1052S.UPGRADE.L2.205

PassedVerify whether
interoperability call can be
made in the Unified CM
successfully.

Make an interoperability
call in the Unified CM
8.6(2)

UC1052S.UPGRADE.L2.208

PassedVerify whether Personal
Directory Service in the
Unified CM 8.6(2)
successfully.

Personal Directory
Service in the Unified
CM 8.6(2)

UC1052S.UPGRADE.L2.209

PassedVerify whether voicemail
should work properly in the
Cisco Unity connection
8.6(1) successfully.

Voicemail should work
properly in the Cisco
Unity connection 8.6(2)

UC1052S.UPGRADE.L2.212
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PassedVerify whether backup can
be taken from the Unified
CM via Disaster recovery
System successfully

Backup should be taken
from the Unified CM
8.6(2) Publisher

UC1052S.UPGRADE.L2.215

PassedVerify whether backup could
be restore in Unified CM
8.6(2) Publisher on UCS
successfully

Restore the backup of
Unified CM 8.6(2)
Publisher on UCS

UC1052S.UPGRADE.L2.236

PassedVerify whether could be
restore in cisco unity
connection 8.6(2) Publisher
as well as subscriber
successfully

Restore backup in the
cisco unity connection
8.6(2) Publisher as well
as subscriber

UC1052S.UPGRADE.L2.237

PassedVerify whether the CUCM
Publisher upgrade on UCS
successfully

Upgrade CUCM
Publisher from 8.6(2)
version to 10.5(2) on
UCS

UC1052S.UPGRADE.L2.239

PassedVerify whether the CUP
Publisher upgrade on UCS
successfully

Upgrade CUP Publisher
from 8.6(3) version to
10.5(2) on UCS

UC1052S.UPGRADE.L2.243

PassedVerify whether basic call can
be made between the IP
Phones once the unified CM
Upgrade has been done
successfully.

Basic call can be made
once the unified CM
Upgrade has been done

UC1052S.UPGRADE.L2.263

Related Documentation
Cisco Unified Communications Manager IM and Presence Service

Managed File Transfer (MFT) - Feature Configuration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/im_presence/configAdminGuide/10_5_2/
CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052/CUP0_BK_CEB3E82E_00_
config-admin-guide-imp-1052_chapter_010110.html

Cisco TelePresence Video Communication Server

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/
Cisco-VCS-Release-Note-X8-5-1.pdf

Mobile and Remote Access Deployment Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/
Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-5-1.pdf
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http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/im_presence/configAdminGuide/10_5_2/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052_chapter_010110.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/im_presence/configAdminGuide/10_5_2/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052_chapter_010110.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/im_presence/configAdminGuide/10_5_2/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052/CUP0_BK_CEB3E82E_00_config-admin-guide-imp-1052_chapter_010110.html
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/Cisco-VCS-Release-Note-X8-5-1.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/release_note/Cisco-VCS-Release-Note-X8-5-1.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-5-1.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/Mobile-Remote-Access-via-VCS-Deployment-Guide-X8-5-1.pdf


Configuration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/
Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-5.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/
Cisco-VCS-Virtual-Machine-Install-Guide-X8-5.pdf

Cisco TelePresence Management Suite

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/
Cisco-TMS-Admin-Guide-14-6.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/
Cisco-TMS-install-guide-14-6.pdf

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/
Cisco-TMS-release-notes-14-6-1.pdf

Cisco TelePresence TX9000 Series

Release Notes:

http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/release/notes/tx_sw_6_0_release_notes.html

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/admin/guide/tx_6_0_admin_guide.html

Installation Guide:

http://www.cisco.com/c/en/us/td/docs/telepresence/tx9000/assembly_guide/tx9000_9200_assembly_guide.html

Cisco TelePresence SX80 Codec

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/
sx80-administrator-guide-tc73.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/
sx80-installation-sheet.pdf

Cisco TelePresence SX20 QuickSet

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc6/administration_guide/
sx20-quickset-administrator-guide-tc62.pdf

Release Notes:
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/config_guide/X8-5/Cisco-VCS-Basic-Configuration-Single-VCS-Control-Deployment-Guide-X8-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/Cisco-VCS-Virtual-Machine-Install-Guide-X8-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/vcs/install_guide/Cisco-VCS-Virtual-Machine-Install-Guide-X8-5.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/Cisco-TMS-Admin-Guide-14-6.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/admin_guide/Cisco-TMS-Admin-Guide-14-6.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/Cisco-TMS-install-guide-14-6.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/install_guide/Cisco-TMS-install-guide-14-6.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/Cisco-TMS-release-notes-14-6-1.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/tms/release_note/Cisco-TMS-release-notes-14-6-1.pdf
http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/release/notes/tx_sw_6_0_release_notes.html
http://www.cisco.com/c/en/us/td/docs/telepresence/tx_sw/6_0/admin/guide/tx_6_0_admin_guide.html
http://www.cisco.com/c/en/us/td/docs/telepresence/tx9000/assembly_guide/tx9000_9200_assembly_guide.html
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx80-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx80-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/sx80-installation-sheet.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/installation-guide/sx80-installation-sheet.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc6/administration_guide/sx20-quickset-administrator-guide-tc62.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/quick-set-sx20/tc6/administration_guide/sx20-quickset-administrator-guide-tc62.pdf


http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/
tc-software-release-notes-tc7.pdf

Cisco TelePresence SX10 QuickSet

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx10-administrator-guide-tc71.pdf

User Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/trc6-sx10-user-guide-tc73.pdf

Cisco TelePresence System EX series

EX60 and EX90 - Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/administration-guide/ex-series-administrator-guide-tc73.pdf

EX60 - Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/installation_guide/ex60_installation_sheet_for_web.pdf

EX90 - Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/installation_guide/ex90_installation_sheet_for_web.pdf

EX60 and EX90 - User Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/user-guide/ex60-ex90-user-guide-tc73.pdf

Cisco TelePresence System C/SX/EX/MX/Profile Series

Software Release Notes TC7:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf

Cisco TelePresence System Integrator Package C90

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/
profile-c90-and-codec-c90-administrator-guide-tc73.pdf

User Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/getting-started-guide/
video-systems-getting-started-guide-tc73.pdf

Cisco TelePresence MCU

Install and Upgrade Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/install_guide/Cisco_TelePresence_
MCU_Deployment_guide_1-31.pdf

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/
Cisco-TelePresence-MCU-Software-release-notes-4-5-1-55.pdf
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/administration-guide/sx10-administrator-guide-tc71.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/trc6-sx10-user-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/administration-guide/ex-series-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/installation_guide/ex60_installation_sheet_for_web.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/installation_guide/ex90_installation_sheet_for_web.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/ex-series/tc7/user-guide/ex60-ex90-user-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/profile-c90-and-codec-c90-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/administration-guide/profile-c90-and-codec-c90-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/getting-started-guide/video-systems-getting-started-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/codec-c-series/tc7/getting-started-guide/video-systems-getting-started-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/install_guide/Cisco_TelePresence_MCU_Deployment_guide_1-31.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/install_guide/Cisco_TelePresence_MCU_Deployment_guide_1-31.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/Cisco-TelePresence-MCU-Software-release-notes-4-5-1-55.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/mcu/release_note/Cisco-TelePresence-MCU-Software-release-notes-4-5-1-55.pdf


Cisco TelePresence Conductor

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/
TelePresence-Conductor-Admin-Guide-XC3-0.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/install_guide/
TelePresence-Conductor-Virtual-Machine-Install-Guide-XC3-0.pdf

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/release_note/
TelePresence-Conductor-Release-Notes-XC3-0-2.pdf

Cisco Jabber Guest

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/ag/JABC_BK_J2895C25_00_
jabber-guest-administration-guide.html

Installation Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/icg/JABC_BK_JA306F08_00_
jabber-guest-install-and-configure.html

Cisco TelePresence Server

Configuration Guide:

http://www.cisco.com/en/US/docs/telepresence/infrastructure/ts/deployment_guide/Cisco_TelePresence_
Server_Deployment_Guide.pdf

Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco_TelePresence_
Server_7010_Installation_Guide.pdf

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/
Cisco-TelePresence-Server-on-Virtual-Machine-Install-Guide-4-1-1-79.pdf

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/release_note/
Cisco-TelePresence-Server-Software-Release-Notes-4-1-1-79.pdf

Cisco TelePresence MX300 G2 and MX200 G2

Administration Guide:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/mx-series/tc7/administration-guide/mx200g2-mx300g2-administrator-guide-tc73.pdf

Release Notes:

http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf

Cisco TelePresence Touch

Touch 10 - User Guide:
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/TelePresence-Conductor-Admin-Guide-XC3-0.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/admin_guide/TelePresence-Conductor-Admin-Guide-XC3-0.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/install_guide/TelePresence-Conductor-Virtual-Machine-Install-Guide-XC3-0.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/install_guide/TelePresence-Conductor-Virtual-Machine-Install-Guide-XC3-0.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/release_note/TelePresence-Conductor-Release-Notes-XC3-0-2.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/conductor/release_note/TelePresence-Conductor-Release-Notes-XC3-0-2.pdf
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/ag/JABC_BK_J2895C25_00_jabber-guest-administration-guide.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/ag/JABC_BK_J2895C25_00_jabber-guest-administration-guide.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/icg/JABC_BK_JA306F08_00_jabber-guest-install-and-configure.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/jabber/Guest/10_5/icg/JABC_BK_JA306F08_00_jabber-guest-install-and-configure.html
http://www.cisco.com/en/US/docs/telepresence/infrastructure/ts/deployment_guide/Cisco_TelePresence_Server_Deployment_Guide.pdf
http://www.cisco.com/en/US/docs/telepresence/infrastructure/ts/deployment_guide/Cisco_TelePresence_Server_Deployment_Guide.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco_TelePresence_Server_7010_Installation_Guide.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco_TelePresence_Server_7010_Installation_Guide.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco-TelePresence-Server-on-Virtual-Machine-Install-Guide-4-1-1-79.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/install_guide/Cisco-TelePresence-Server-on-Virtual-Machine-Install-Guide-4-1-1-79.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/release_note/Cisco-TelePresence-Server-Software-Release-Notes-4-1-1-79.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/infrastructure/ts/release_note/Cisco-TelePresence-Server-Software-Release-Notes-4-1-1-79.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/mx-series/tc7/administration-guide/mx200g2-mx300g2-administrator-guide-tc73.pdf
http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/software/tc7/release_notes/tc-software-release-notes-tc7.pdf


http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/touch10-user-guide-tc73.pdf

Cisco DX70 and DX80

Administration Guide:

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/dx/series/admin/1022/DX00_BK_C9FCBAE4_00_cisco-dx-series-ag1022.pdf

User Guide:

http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/dx/dx70/user/1022/en/dx70-dx80-user-guide-1022.pdf

DX80 - Installation Guide:

http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/dx/dx80/install/dx80-installation-guide-web-version.pdf

Cisco Prime Collaboration Provisioning

User Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/provisioning/Cisco_Prime_
Collaboration_Provisioning_Guide_10_6.pdf

Quick Start Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_
Collaboration_Quick_Start_Guide_10_6.pdf

Upgrade Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_
Collaboration_Upgrade_Guide_10_6.pdf

Release Notes:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_
Collaboration_Release_Notes_10_6.pdf

Cisco Prime Collaboration Assurance

User Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/assurance/advanced/guide/Cisco_
Prime_Collaboration_Assurance_Guide_Advanced_10_6.pdf

Quick Start Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_
Collaboration_Quick_Start_Guide_10_6.pdf

Upgrade Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_
Collaboration_Upgrade_Guide_10_6.pdf

Release Notes:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_
Collaboration_Release_Notes_10_6.pdf

Cisco Prime Collaboration Analytics

User Guide:
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http://www.cisco.com/c/dam/en/us/td/docs/telepresence/endpoint/sx-series/tc7/user-guide/touch10-user-guide-tc73.pdf
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/dx/series/admin/1022/DX00_BK_C9FCBAE4_00_cisco-dx-series-ag1022.pdf
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/dx/dx70/user/1022/en/dx70-dx80-user-guide-1022.pdf
http://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/dx/dx80/install/dx80-installation-guide-web-version.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/provisioning/Cisco_Prime_Collaboration_Provisioning_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/provisioning/Cisco_Prime_Collaboration_Provisioning_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/assurance/advanced/guide/Cisco_Prime_Collaboration_Assurance_Guide_Advanced_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/assurance/advanced/guide/Cisco_Prime_Collaboration_Assurance_Guide_Advanced_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf


http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/analytics/guide/Cisco_Prime_
Collaboration_Analytics_Guide_10-6.pdf

Quick Start Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_
Collaboration_Quick_Start_Guide_10_6.pdf

Upgrade Guide:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_
Collaboration_Upgrade_Guide_10_6.pdf

Release Notes:

http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_
Collaboration_Release_Notes_10_6.pdf

Upgrade / Migration

Release Notes for Cisco Unified Communications Manager Release 10.5(2)

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_
cucm-release-notes-1052.html

Important Notes about Upgrades

http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/
CUCM_BK_C6A7E384_00_cucm-release-notes-1052/CUCM_BK_C6A7E384_00_cucm-release-notes-1052_
chapter_01.html
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http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/analytics/guide/Cisco_Prime_Collaboration_Analytics_Guide_10-6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/quick/start/guide/Cisco_Prime_Collaboration_Quick_Start_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/upg_mig/guide/Cisco_Prime_Collaboration_Upgrade_Guide_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/net_mgmt/prime/collaboration/10-6/release/notes/Cisco_Prime_Collaboration_Release_Notes_10_6.pdf
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_cucm-release-notes-1052.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_cucm-release-notes-1052.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_cucm-release-notes-1052/CUCM_BK_C6A7E384_00_cucm-release-notes-1052_chapter_01.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_cucm-release-notes-1052/CUCM_BK_C6A7E384_00_cucm-release-notes-1052_chapter_01.html
http://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/rel_notes/10_5_2/CUCM_BK_C6A7E384_00_cucm-release-notes-1052/CUCM_BK_C6A7E384_00_cucm-release-notes-1052_chapter_01.html
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